
Every effort has been made to ensure that the data given in this document is accurate.  The information, figures, tables, specifications, and schematics contained herein are subject to 

change without notice.  Bruker Fluorescence Microscopy makes no warranty or representation, either expressed or implied, with respect to this document.  In no event will Prairie 

Technologies, Inc. be liable for any direct, indirect, special, incidental, or consequential damages resulting from any defects in its documentation.

Congratulations on your purchase of a Bruker Fluorescence Microscopy System.  This manual is intended to provide the information necessary to operate Prairie View software for image 

collection, scanner control, and synchronizing imaging with electrophysiological or photostimulation events.

Prairie View is the software that controls all scanning, image collection, photostimulation, voltage output, voltage recording, and synchronization functions of Bruker Fluorescence 

Microscopy systems.  Several operational modes are available to control various system configurations, including Galvo, Spiral, Resonant, AOD, FLIM, SFC, and Camera modes.  In addition 

to the controls described here, many hardware settings are configured in the Prairie Configuration Utility, which is accessed via its own icon on the desktop or within the Prairie directory.  

Consult Bruker Fluorescence Microscopy support personnel before making any changes to the configuration utility settings, as those changes may cause the system to malfunction.

When referring to a specific button, icon, or checkbox a bolded font is used:

Press Single Scan to collect an image.

Specific key strokes are denoted with bolded font within angle brackets:

Press <Enter> to continue.

Menu strings will be denoted with angle brackets to define each submenu:

Go to File>Preferences>ZSeries to edit these options.

When describing a specific action that the user is to take, particularly as a part of a sequence of actions, numbers are used to delineate the steps:

1.   Press ROI

2.   Click and release the mouse once at one corner location of the ROI.

3.   …

When discussing acquisitions that involve more than one active channel, each channel's data is referred to as an “image” and the set of images for all active channels for a given time point 

is referred to as a “frame”.

The computer on the imaging system is an integrated part of the imaging workstation, which consists of many components.  Bruker Fluorescence Microscopy manufactures and sells 

computers that are designed to fully support the laser scanning instruments and many other devices from Bruker Fluorescence Microscopy and other hardware vendors.  In addition to 

having the correct hardware capabilities, each computer from Bruker Fluorescence Microscopy comes configured with the correct operating system, drivers, and support applications 

needed to run Prairie View software.

It is important that the user back up the Prairie software directory (C:\Program Files\Prairie\) and configuration directory (C:\Documents and Settings\All Users\Application Data\Prairie 

Technologies, Inc\Prairie View) regularly in addition to backing up any data that has been acquired.  In the event of a catastrophic computer failure, an uptodate backup of the Prairie 

software directory and configuration folders will allow the user to resume operation of the system in the shortest amount of time.  Many systems have complex hardware configurations 

that change over time and if the software configuration is lost it may take hours of support to reconfigure the system to a fully operational state.

These are short guides to getting started with some common tasks in Prairie View.  For more information, refer to the relevant sections of the manual.

Note that hardware referenced in these quickstart guides is for the Ultima In Vivo system or the Ultima BX51/BX61 system.  Steps may differ for other platforms, including Ultima FN1 and 

Ultima Examiner systems.

1.    Turn on all electronics, including the camera, laser(s), control boxes, and microscope, and start the computer

2.    Doubleclick the desktop icon to start Prairie View; a dialog box will appear and report progress as the software loads and establishes connections with various components

3.    Turn on the ultrafast laser and open the laser cavity shutter; depending on laser manufacturer and system configuration, this may be done manually or via Prairie View or other 

software

4.    Find your sample using transmitted or epifluorescence light and the eyepieces (these steps may vary based on the microscope body design)

a.    Select the light path and/or optical port that directs light to the eyepieces; for In Vivo systems, push the trinoc plunger in to the “Bi” position

b.    Move the epidichroic (or reflector turret) filter wheel position to a cube that allows the desired transmitted or epifluorescence excitation wavelengths to reach the 

sample

c.    Put a sample on the stage and focus through the eyepieces

5.    Configure the system for laser scanning

a.    Turn off the transmitted or epifluorescence light. Make sure the epifluorescence mercury lamp is completely shuttered or off if present on the system.  The shutter 

mechanism provided on the front of the epidichroic turret is NOT an adequate shutter, as it leaks light from the lamp house that will flood the PMTs and introduce noise 

into the image.

b.    Pull the trinoc plunger out to the “LSM” position

c.    Move the epidichroic (or reflector turret) filter wheel to position 1 to put the Primary Dichroic in the light path
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d.    Close the light box door

e.    Turn off the room lights

f.     Tune the laser to the desired wavelength; depending on laser manufacturer and system configuration, this may be done manually or via Prairie View or other software

6.    Select the objective lens you are currently using in the list of calibrated objectives in the Prairie View main control window; this list does not change the objective, but rather tells 

Prairie View which objective you are using

7.    In the Image window, click the channel names along the left side of the window to activate the display channel(s) corresponding to the PMT(s) you will use to acquire your image. 

Multiple channels can be displayed in a single window or in separate windows; click the New Window button to open additional Image windows. A typical configuration with dual 

upper detectors utilizes a filter cube to direct red light to Channel 1 and green light to Channel 2; some system configurations may differ from this arrangement.

8.    Click the Live Scan button located in the upper right region of the Prairie View main control window

9.    In the Laser, PMT, DAQ tab, adjust the HV slider of the desired PMT channel(s) to an appropriate level.  Sideon multialkali PMTs do well around 700, while GaAsP detectors 

perform better above 800; adjust accordingly for your sample.

10.  In the Laser,PMT,DAQ tab, adjust the Pockels laser power slider until your image appears; the hard shutter will not open until the laser slider value is greater than zero

11.  Continue to adjust the laser power and PMT voltage sliders along with the image size, focus (zlevel), optical zoom, pan, scan rotation, etc, to get the desired image. Optionally, 

adjust image display settings (click the LUT button on the Image window to access controls).

12.  Click the Stop Scan button located in the upper right region of the Prairie View main control window

1.    Turn on all electronics, including the camera, laser(s), control boxes, and microscope, and start the computer

2.    Key on the laser launch and toggle the shutter switch to the open position

3.    Doubleclick the desktop icon to start Prairie View; a dialog box will appear and report progress as the software loads and establishes connections with various components

4.    Find your sample using transmitted or epifluorescence light and the eyepieces (these steps may vary based on the microscope body design)

a.    Select the light path and/or optical port that directs light to the eyepieces; for In Vivo systems, push the trinoc plunger in to the “Bi” position

b.    Move the epidichroic (or reflector turret) filter wheel position to a cube that allows the desired transmitted or epifluorescence excitation wavelengths to reach the 

sample

c.    Put a sample on the stage and focus through the eyepieces

5.    Configure the system for laser scanning

a.    Turn off the transmitted or epifluorescence light. Make sure the epifluorescence mercury lamp is completely shuttered or off if present on the system.  The shutter 

mechanism provided on the front of the epidichroic turret is NOT an adequate shutter, as it leaks light from the lamp house that will flood the PMTs and introduce noise 

into the image.

b.    Pull the trinoc plunger out to the “LSM” position

c.    Move the epidichroic (or reflector turret) filter wheel to an open position (often position 2)

d.    Close the light box door

e.    Turn off the room lights

6.    Select the objective lens you are currently using in the list of calibrated objectives in the Prairie View main control window; this list does not change the objective, but rather tells 

Prairie View which objective you are using

7.    Configure the confocal detectors

a.    In the Laser, PMT, DAQ tab, click the green bar to the left of the Lasers panel to reveal the Confocal panel

b.    Choose a pinhole size from the dropdown menu

c.    Choose the dichroic mirrors and band pass filters from the dropdown menus for each position in the confocal detection path

8.    In the Image window, click the channel names along the left side of the window to activate the display channel(s) corresponding to the PMT(s) you will use to acquire your image. 

Multiple channels can be displayed in a single window or in separate windows; click the New Window button to open additional Image windows.

9.    Click the Live Scan button located in the upper right region of the Prairie View main control window

10.  In the Prairie View Laser, PMT, DAQ tab, adjust the HV slider of the desired PMT channel(s) to an appropriate level.  Sideon multialkali PMTs do well around 700, while GaAsP 

detectors perform better above 800; adjust accordingly for your sample.

11.  In the Prairie View Laser,PMT,DAQ tab, adjust the laser power slider to slowly increase power on the desired laser line(s) until your image appears; the hard shutter will not open 

until the laser slider value is greater than zero

12.  Continue to adjust the laser power and PMT voltage sliders along with the image size, focus (zlevel), optical zoom, pan, scan rotation, etc, to get the desired image. Optionally, 

adjust image display settings (click the LUT button on the Image window to access controls).

13.  Click the Stop Scan button located in the upper right region of the Prairie View main control window

A ZSeries is defined by four parameters: a start position, a stop position, a step size, and a number of slices.  Defining any three of these parameters allows the fourth to be calculated. 

Click the Calculate radio button in the ZSeries tab next to the one parameter to have calculated. The following steps describe setting the start and stop positions of the image stack and 

choosing the step size.

3-Channel Confocal Imaging

Collecting a Z-Series
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1.    Get in image of your sample using the steps defined in the Multiphoton or 3Channel Confocal QuickStart Guide

2.    Use Live Scan and/or Single Scan (see the Scanning Controls section of this manual) to locate the sample

3.    Use the up/down software buttons to navigate to the top or bottom of the desired ZSeries

4.    Set the current position as the start of the ZSeries by clicking the Set Start button in the Start Position area of the ZSeries tab, or by clicking the  button in the Stage Control 

section of the main control window

5.    Use the up/down software buttons to navigate to the desired stop position of the ZSeries

6.    Set the current position as the stop of the ZSeries by clicking the Set Stop button in the Stop Position area of the ZSeries tab, or by clicking the  button in the Stage Control 

section of the main control window

7.    Enter the desired step size into the Step Size field in the ZSeries tab

8.    Confirm that the Save Path and file name point to the intended location of the images

9.    Click the Start Z-Series button

The user can move to a previously set or calculated Start, Middle, or End position by clicking the corresponding Goto button in the ZSeries tab.

Photoactivation masks allow the user to define custom areas of the field of view to be scanned. The scans are performed by the imaging galvanometers using one or more lasers on the 

imaging path.  Scan settings (Image Size, Dwell Time, etc.) are defined in the main control window, and laser settings are defined in the Photoactivation dialog.

1.    Get in image of your sample using the steps defined in the Multiphoton or 3Channel Confocal QuickStart Guide

2.    Click the  button on the Image window to open the Photoactivation dialog

3.    Click to choose a laser palette; use the Edit button to change the laser power(s) associated with the palette.  If using lasers at current settings, use the laser slider(s) in the main 

control window to set laser power

4.    Choose a brush, ellipse, rectangle, or polygon shape and draw a mask on the Image window where laser power should be applied

5.    Click Save Mask and name your mask

6.    Close the Photoactivation dialog

7.    Define a TSeries to apply the mask in the TSeries tab

a.    Click Image Sequence and define images to be acquired before the mask is applied

b.    Click Photoactivation and choose the saved mask

c.    Click Image Sequence and define images to be acquired after the mask is applied

8.    Click the Start T-Series button to begin the photoactivation and acquisition

9.    After the TSeries is complete, click the arrow buttons in the Playback dialog to watch a playback of the experiment

Alternatively, the mask can be applied to Single Scans without using a TSeries.  Masks can also be applied in three dimensions to ZSeries.  More information is available in the 

Photoactivation section of the Prairie View manual.

All alignment and calibration must be done before performing this procedure; details are provided in the Prairie View manual.  Point Photoactivation/Uncaging is carried out with the Mark 

Points feature of Prairie View software.

1.    Configure the system with glass to allow light from the photoactivation laser to the sample.  This configuration varies from system to system, and will be described during initial 

installation and training by Prairie Technologies personnel.  

2.    Collect an image of your sample, as described in the Multiphoton or 3Channel Confocal QuickStart Guide

3.    Mark points in the Image window

a.    Open the Mark Points Controller window by selecting Mark Points from the Applications menu or by clicking the Mark Points button on the Image window

b.    Right click in the Image window to drop points on the image and/or use the buttons in the Mark Points Controller window to move points and add points, lines, and grids of 

points to the image.  Adjust the point density for each line and grid using the + and - buttons in this panel.

4.    Choose a calibration file by clicking the … button in the Mark Points Controller window or by choosing Load Uncaging Calibration from the File menu

5.    Configure the stimulation in the Mark Points Controller window

a.    Below the Mark Point Series table, click Clear All Rows to remove previouslydefined experiments

b.    Click Add New Row to add a cycle to the Mark Point Series table

c.    Choose a point, line, grid, or group of points for the cycle

d.    Define the Initial and Inter Point delay times, Duration of laser stimulation, number of Repetitions of the cycle, Uncaging Laser and Uncaging Laser Power to use for the 

cycle

e.    Optionally, define start triggers and synchronization with Voltage Recording and Voltage Output modules; these are described in other parts of the Prairie View manual

6.    Click Run Mark Points at the bottom of the Mark Points Controller window

Photoactivation Masks

Basic Point Photoactivation
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7.    Use Live Scan or Single Scan to collect an image of the sample after the experiment

*Alternatively, the Mark Points experiment can be embedded in a Tseries.  More information about this option is available in the Mark Points section of the Prairie View manual.

1.    Begin imaging with the steps described in the Multiphoton or 3Channel Confocal QuickStart Guide

2.    Images can be made from a single frame or by averaging frames in one of two ways:

a.    Average during a Live Scan: Check the box next to Running Frame Average and choose from the dropdown menu a number of frames to average

b.    Average during a Single Scan: In the dropdown menu next to Average Every N Frames, choose a number of frames to average

3.    Stop the live scan by clicking Stop Scan; from here you can work with the most recent images still in the Image windows, or click Single Scan to collect another image

4.    Adjust the Look Up Table for each channel by clicking the LUT button on the Image window and adjusting the graphs in the new window that appears; right clicking on this button 

will bring up options to reset or automatically adjust the look up table

1.    Define a save path in the “Misc” tab of the Prairie View main control window

a.    Click … to navigate to the desired folder (this path is also used to save TSeries and ZSeries files)

b.    Type a name for your images in the file name field.  The default name references the date and time the software was started, followed by a counter that automatically 

increases by one after each file is saved.  If you change the default BaseDirectory name and want that new name to be the default setting, go to Preferences > Preserve 

UserModified File Names

c.    Check the disk box next to Single scan if you want every Single Scan to be saved; this prevents loss of data but fills disk space quickly

d.    Check the disk box next to Live scan if you want the last frame of every Live Scan to be saved

2.    To save an image currently displayed in the Image window (from a live scan or a single scan), click on the Snap (camera) button on the left side of the Image window; this saves the 

current image as a 16bit data file to the save path defined in the main form.  If any overlays are present on the image, the exact displayed view (including display zoom) and 

overlays will be saved as an 8bit TIFF file.

1.    Go to File > Load Image(s)

2.    Navigate to the directory and folder for the image you want

3.    Open the XML file for the image

Most of the controls of Prairie View are accessed through the Main Control Window.  Some sections may have extra controls accessible through a green bar located to the left of the 

section.  Selected buttons are shaded green.  The controls present in this window depend on system configuration.  The example shown below is from an Ultima (point scanning) system.

Acquire an Image

Save an Image

Load

Main Control Window Overview

Menus contain many options and features

Scan and stage controls are always visible

Tabs contain many controls for specific features
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Tear-Off	Panels

Certain panels may be "torn off" and placed on the user's desktop.

To tear off a tab, click on the diagonal arrow button located on the right side of the tab label. Prairie View will remember these selections and return the tearoff panels to their last 

location when Prairie View is restarted.  To return a tearoff panel to its original location, click the "X" in the upperright corner.

Current scan parameters and motor positions

Status messages about hardware and acquisitions
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Color	Control

The title bar of individual panels can be changed.  A color wheel will appear in the left corner of the title bar when the mouse cursor is hovered over the title bar.  Click on the color wheel 

and select a new color for the title bar.  

Slider	Control

Slider controls in the software are configured for both small and large changes.  To make a small change in the value, click the arrow at the end of the slider.  To make a large change, click 

in the empty space in the slider between the current position and the arrow.  After clicking on a slider, it can also be moved by rotating the mouse wheel.
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Image size is a definition of how collected data is acquired and displayed.  In the case of a 512 x 512 acquisition, data is acquired at 512 bins in x by 512 bins in y, with each bin sampled 

according to the userspecified dwell time.

The information section at the bottom of the Main Control Window lists the image size in pixels and microns, based on the currently selected Image Size and Objective Lens.

Grid buttons to the right of the predefined options will increase or decrease the image size (changing the number of pixels in the scan) by a factor of 2 in both the x and y dimensions.

Note: Clicking the preset image size buttons while inside a Region Of Interest (ROI) will cause the software to exit the ROI and return to the full, square scan.

Clicking the green bar to the left of the Image Size controls reveals custom control of the Pixels Per Line (x) and Lines Per Frame (y).  Use the sliders, preset buttons, or text box to enter a 

custom image size; while making changes, refer to the information section at the bottom of the Main Control Window for the pixel size.  The text box to the left of the Pixels Per Line slider 

displays the minimum number of pixels per line allowed for the current scan settings.  When imaging in a Region Of Interest (ROI), the Pixels Per Line and Lines Per Frame text boxes will 

display the dimensions of the current ROI.

Note: Be aware that it is possible to choose configurations in which the pixels are not square. This may affect how the images are displayed by thirdparty software.

Image Size controls are not available in Camera or SFC modes.

Image	Window	Size

New opens a new Image Window.

Smaller decreases the displayed image by ~10%. The image can continue to be reduced by clicking Smaller repeatedly.

Fit is the default and the image display is resized to 512 pixels in width, regardless of the Image Size settings for the acquisition. If the image window is increased or decreased in size, the 

display will be scaled to fit proportionally to fit in the new window.

1:1 shows the image at its actual size as defined by the number of pixels in the current Image Size. 

Larger increases the displayed image size by ~10%. The image can continue to be increased by clicking Larger repeatedly.

Changes made with these buttons are applied to all active Image Windows.  Adjusting the Image Window Size alters the display, but does not change scan parameters.

This slider allows the user to control the time that the imaging laser beam is scanning over each pixel location in the image.  The minimum value allowed is displayed below and to the left 

of the slider.  Changing pixels per line, optical zoom, and scan rotation may change the minimum allowed dwell time.  The current dwell time is shown in the field below the middle of the 

slider.

When imaging in Galvo or Spiral mode, the underlying sampling rate is 1 sample per 0.4µs.  This means that when scanning with a dwell time of 2.0µs, each pixel value is made up of 5 

samples. The button on the right side allows the user to choose whether the recorded intensity value is obtained by Averaging or Summing those samples.

Dwell Time control properties are based on scan mode.  When imaging in AOD mode, the underlying sampling rate is 0.1µs.  When imaging in Resonant mode, the dwell time is determined 

by the hardware and is not userdefinable.

Dwell Time controls are not available in Resonant, Camera, or SFC modes.

In Camera and SFC modes, systems configured with a pointscanning system (Ultima, Single Galvo System, or Photoactivation/FRAP module) will replace the Dwell Time Per Pixel slider with 

a Photoactivation Time Per Pixel slider to control the dwell time of the photoactivation laser(s).

Image Size and Image Window Size

Dwell Time Per Pixel

Optical Zoom
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This slider controls the size of the area of the specimen that is being scanned by changing the amplitude of the galvanometer movements.  An optical zoom of 2 will cause the microscope 

to scan an area that is ½ the width and ½ the height of a scan at a zoom of 1.  Optical Zoom does not affect the number of pixels in the image, but instead changes the size of those pixels.  

It is possible to increase the true optical resolution of the system by using this function.  Selecting Reset will cause the zoom to return to the default value of 1.  The minimum value 

allowed is displayed below and to the left of the slider.  The current selected zoom is shown to the right of the minimum.

Clicking the green bar to the right of the slider reveals buttons for preset zoom factors.

It is not possible to set the optical zoom to less than 1.

Optical Zoom control is not available in Camera or SFC modes.

When working at an Optical Zoom of greater than one, Pan Control allows the user to change the position of the scanned area on the sample.  On the left is a graphic that shows the 

relative position and orientation of the scanned area.  A red and yellow box indicates the scanned area; the yellow side is by definition the “top” side of the scan.  This box will change its 

size as a result of the Optical Zoom function. Similar changes will be displayed when the image is panned, or shifted laterally, and when the scan is rotated.

The image may be panned left, right, up, or down. To do so, click on the arrow button indicating the direction to pan the image. Clicking 0 causes the pan to reset to the middle of the field 

of view.

Click the Coarse/Medium/Fine button to change the resolution of the pan arrow buttons.

Pan Control is not available in Camera or SFC modes.

The entire scan can be rotated.  Click and/or drag the slider or type a value (in degrees) to change the scan rotation.  Rotation is possible from 180° to +180°.  Use the Reset button to set 

the angle of rotation back to zero.  Use the Coarse/Medium/Fine button to change the resolution of the slider.

Rotating the scan while in Galvo mode can increase frame rate by more evenly distributing the work of the X and Y galvanometers.

Scan Rotation controls are not available in Resonant, Camera, or SFC modes.

The upper right portion of the Prairie View main control window contains the scanning controls:

Live	Scan

Live Scan causes the system to start scanning.  During a live scan, this button changes to read Stop Scan.  Clicking it a second time causes the scan to stop and the laser beam to be 

shuttered so that it no longer scans across the specimen.  If the disk check box next to the Live Scan button is checked, then the last frame of every Live Scan is numbered and saved.   To 

save the currently displayed image from a live scan, click the Snap button (camera icon) on the left side of the Image window.  If Running Average is checked, the selected number of the 

most recent frames acquired will be averaged together to create the displayed image.

Frame	Averaging

The Running Frame Average affects the Live Scan imaging. When this option is checked, the software will average the specified number of the most recent frames acquired during Live 

Scan and update the Image Window accordingly. This is useful for samples with little fluorescence or when using low laser power.

Average Every N Frames is designed to work with the Single Scan command, as well as ZSeries and TSeries acquisitions. When set to a number greater than one, it will average the 

selected number of frames to create each image.

Note that for most acquisition modes, the End of Frame trigger is only generated on the last of the averaged frames making up each image.  Thus, if the number of frames to average is set 

to 4, the End of Frame trigger will be generated at the end of every 4th frame.  The frequency of the End of Frame trigger in SFC mode depends on the firmware in the SFC control box.  

Pan Control

Scan Rotation

Scanning Controls
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More information about frame triggers is provided here.

Single	Scan

When Single Scan is selected, one frame is acquired, with the result displayed in the Image window(s).  The hard shutter is closed following collection of the image and the image is saved 

as a temporary file.  If the disk check box next to the Single Scan button is checked, then  every Single Scan is numbered and saved.  If this option is not checked, the frame is stored only 

temporarily unless the Snap button (camera icon) on an Image window is used to preserve it.  If Average Every N Frames is set to a number greater than one, the selected number of 

frames will be acquired and averaged to create one image.

Save	Path

Each acquisition is saved in its own folder.  The location of the folder is determined by the Save Path, which can be viewed or changed by clicking the  button next to the Save Path box.  

The name of the folder is the name displayed in the text box next to the  button, followed by the number displayed in the iteration counter text box.

The default folder name includes the type of acquisition and the date and time code for the last time the software was loaded.  The user can type a custom name in this field for the 

current session.  The folder name will revert back to the default typedatetimecounter format each time Prairie View is started.  To retain the custom folder between sessions, check the 

Preserve UserModified File Names option in the Preferences menu.  Note that using the same folder name in multiple tabs (ZSeries, TSeries, etc.) can cause data to be overwritten if 

counter values are the same on multiple tabs.

By default, Live Scans and Single Scans continuously overwrite the data in the folder specified by the Save Path in the Misc tab.  When the Auto Save option for Single Scan is checked, a 

disk icon appears in the Single Scan button.  The file counter will be incremented automatically after a Single Scan so that it will not be overwritten by the next Single Scan or Live Scan.  

Likewise, when the Auto Save option for Live Scan is checked, a disk icon appears in the Live Scan button and the file counter is incremented automatically after a Live Scan so that it will 

not be overwritten by the next Single Scan or Live Scan.  Note that for Live scan Auto Save, the file saved will be the last frame collected by the Live Scan, as displayed in the Image window 

when the scan was stopped.  The user can change the counter value by typing in the box or using the + and – buttons.  Note that decreasing the counter value can result in overwriting 

data.  To manually save a particular single scan after acquisition, use the snap tool button   on the Image window.

Shutter	Control

Shutters are automatically opened and closed during imaging.  When an acquisition is started, the shutter(s) will open for any laser(s) for which the laser power slider is set to a value 

greater than zero.  If all laser sliders are set to zero, no shutters will open.  

The Hard and Soft shutter buttons allow the user to manually open and close the shutters. Hard Shutters are physical shutters placed in the beam path (on the table or inside a laser 

launch). Soft Shutters are gates on signals sent to a Pockels cell or AOTF.  Although software controlled for routine imaging, it is possible to manually open and close the hard shutter for 

access to the beam during alignment.  A user may also choose to manually open the hard shutter before starting an experiment to avoid any vibration introduced by the mechanical 

movement.  It is also possible to manually open and close the Soft Shutter.

On SFC systems with the Photoactivation/FRAP module, the Hard and Soft shutter buttons allow the user to manually turn on the laser(s) used on the Photoactivation/FRAP module for 

troubleshooting and alignment purposes.  On systems configured with an Ultima for single or multiphoton imaging, or a Single Galvo Scanner used for mulitphoton imaging, the Soft 

Shutter and Hard Shutter buttons will operate as if Prairie View were running in Galvo Mode.  In any configuration, the shutters will open automatically during photoactivation 

experiments.

Acquisition	Modes

The Acquisition Mode dropdown menu allows the user to switch between scan modes available on the current system configuration.  Some scan controls are only available in particular 

modes.  All Ultima systems offer Galvo and Spiral modes; additional modes are available based on current hardware configurations.  Some settings, including laser power and PMT 

voltages, are recalled individually for each Acquisition Mode.  For example, a user is working in Galvo mode with the laser slider set to 100 and the PMT voltages set to 700.  When the user 

switches to Resonant mode for the first time in that session, the laser slider and PMT voltages will be set to 0.  The user then sets the laser slider and PMT voltages to values needed to see 

the sample while scanning in Resonant mode.  If the user returns to Galvo mode, the laser slider and PMT voltage settings will be returned to the 100 and 700 values last used in Galvo 

mode.

Galvo mode is the default mode for scanning with traditional galvanometers.  The image is generated from left to right, top to bottom, with lasers blanked during the galvanometer retrace 

at the end of each line and the bottom of each frame.  Unless otherwise noted, all software features described in this manual are available in Galvo mode.

Spiral mode allows faster scanning with the traditional galvanometers.  This is accomplished by driving the galvanometers in a continuous pattern and constructing the image from the 

outside in.  The resulting scan is a circular area inside the traditional Galvo scan area.  Very large image sizes are disabled in Spiral mode.  Spiral scans at high speeds can cause the center of 

the image to appear distorted.  This can be minimized by adjusting the scan parameters to move the galvanometers more slowly, or by changing the Spiral Scan Duty Cycle.

The Spiral Scan Duty Cycle determines the proportion of the scannable area that will be imaged. The parameter is set in the Scan Settings dialog.  A duty cycle of 1.0 will scan the entire 

circular area, while smaller duty cycles (for example, 0.95 or 0.90) will leave an unscanned area in the center of the image, generating a “donut scan” area.  Lowering the duty cycle can 

help to reduce the appearance of distortions at the center of the image.  It also protects the center of the sample from photodamage, which can occur because the spiral scan pattern 

scans the center pixel multiple times when generating a single image.  Contact Prairie Technologies personnel for assistance with this setting.

Certain combinations of Dwell Time and Image Size require some pixels in the scan to be interpolated; in these cases, a warning message will appear at the bottom of the Main Control 

Window.  It is also possible to drive the galvanometers past their limits during a Spiral scan.  This will result in the image taking on a “smeared” appearance and the amber warning lights on 

the Galvanometer Control Box to illuminate.  If this occurs, slow down the galvanometers by increasing Dwell Time or Image Size.

Resonant mode generates images at high speeds using a resonant galvanometer for the X dimension and the traditional Y galvanometer for the Y dimension of the image.  Frame rate is 

dependent solely on the number of scan lines in the image.  In this mode, dwell time varies across the image and is determined automatically.  Because the frame rate in Resonant mode is 

so much faster than in Galvo mode, image quality can be improved by averaging frames while still collecting images at high speeds.  Two scan controls, Resonant Phase Offset and Sampling 

Method, are unique to Resonant mode and are described later in this manual.  Some features are not enabled when imaging in Resonant mode, including Photoactivation Masks and 

freehand Line Scans.

AOD mode uses the AcoustoOptic Deflector to generate images at high speeds.  A plunger on the AOD module allows the user to choose which of four lenses is placed in the beam path, 

which in turn determines the combinations of scan settings allowed for imaging.  In AOD mode, the Optical Zoom, Image Size, and Dwell Time settings are limited to particular 

combinations. Default AOD settings are 512 x 512 Image Size, 0.1µs Dwell Time, 1.0 Optical Zoom, resulting in a frame rate of approximately 25fps.  Changes in any one of these three 

settings will cause Prairie View to automatically compensate by changing the others, to keep the AOD imaging properly. To select one parameter to keep constant, click the checkbox next 

to the parameter to freeze its value.  Prairie View will not change that setting unless the user unchecks the box or restarts Prairie View.  If the user changes one of the other two 

parameters, the software will attempt to automatically adjust the third parameter to provide a proper image.  In order to prevent getting lost in settings that do not produce images, keep 

one of the freeze parameter boxes checked whenever making changes to another parameter.  When restarting the software, Prairie View will detect the physical plunger position and 
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restore all parameter settings to defaults for that position.

Frame rate is calculated automatically based on the Image Size, Dwell Time, and Optical Zoom settings.  For faster frame rates, lower the settings for those parameters.  Image Size is the 

number of pixels in the scan area; higher values produce cleaner images, while lower values allow faster frame rates.  Optical Zoom determines the size of the scanned field of view; default 

settings have the Optical Zoom match the AOD plunger position, but this can be changed to alter the frame rate.  Dwell Time is the amount of time spent at each pixel, with a minimum 

value of 0.1µs; lower values can help reduce photobleaching.  Each 0.1µs change in Dwell Time changes the Optical Zoom by 1.0 or the Image Size by a factor of 2.  Setting the lens plunger 

to position 4 allows the greatest range of scan parameter combinations.

Increase image resolution by increasing either image size (total number of pixels) or dwell time (amount of time spent imaging each pixel). Note that changing either of these settings will 

cause the optical zoom and frame rate to change accordingly. 

Improve image quality with the Average Every N Frames feature. Because AOD mode scans so quickly, it can average frames much faster than Galvo mode.

FLIM mode enables features to monitor fluorescence lifetime data.  This option is only available on systems configured with hardware for lifetime imaging.  These features are discussed in 

more detail elsewhere in this manual.

SFC mode is used to collect images with a SweptField Confocal scanner.  Due to fundamental differences in scanning hardware, there are many software properties unique to SFC mode. 

These are discussed in more detail in the SweptField Confocal section of this manual.

Camera mode is used to collect images with a camera mounted on the system.  This can be used to collect transmitted light or widefield fluorescence images.  Many scan controls are not 

applicable to Camera mode, but there are cameraspecific parameters available in this mode. These parameters become part of the Laser, PMT, DAQ tab, described later in this manual.

Label	Selection

The Label Select dropdown menu allows the user to select previously defined and saved settings. These settings include dwell time, laser power, PMT voltages, etc.  If any label other than 

“Current Settings” is selected in this menu, then changes to the scan settings will be automatically written to the selected label.  Labels are discussed further in the Labels Tab section of 

this manual. 

Objective	Lens

The Objective Lens dropdown menu allows the user to select a previously calibrated objective setting for an objective lens used on the system.  Proper objection selection is important as 

it is used in determining pixel size.  Failure to select or use a properly calibrated objective will result in invalid measurements and motor movements.  The procedure for calibrating 

objective lenses can be found in the Calibrate Objective Lens section of this manual.  Note that the selection made in this menu will NOT move the objective turret on a microscope with a 

motorized nosepiece; that must be done in the microscope control window.    

Stage Control allows the user to move the stage in the x and y direction and the objective in the z direction. It also allows the user to recall saved locations, which can be modified on the 

XYStage Tab described later in this manual.

The XY stage controls allow the user to scan through the x and y axes of an image in userdefine step sizes.  Use the arrow buttons to move the stage by the number of microns indicated in 

the XY Step Size field. To change the step size, click in the field and replace the number with the desired step size, or choose a percentage of the field of view from the dropdown menu.  

Field of view measurements are based on the currently selected objective lens calibration.

Use the home feature to store an XY location to come back to at a later time.  Selecting Set stores the current XY location as Home and pressing the  button will return to that position.

Select  to leave the stage where it is and set the current position to be zero.  The saved home position will be offset to maintain the same location in the sample.

The Position dropdown menu allows the user to select from a list of previously saved stage positions.  Storing and using these positions is described in the XYStage Tab section of this 

manual.

The zmotor controls allow the user to scan through the zaxis of an image in userdefined step sizes.

Use the up and down arrow buttons to move the zmotor by the number of microns indicated in the Z Step field. To change the step size, click in the field and replace the number with the 

desired step size.

Use the home feature to store a Z location to come back to at a later time. Selecting Set stores the current Z location as home and pressing  will return to that position.

Select  to leave the motor where it is and set the current position to be zero.  The saved home position will be offset to maintain the same location in the sample.

If there is more than one z device available on the system, such as a highprecision piezo controller, the Z Device dropdown menu will be active to select which device will be moved by the 

software control buttons.  More information about using multiple z devices can be found in the ZSeries Tab section of this manual.

Some systems are configured with two X,Y moving platforms.  For example, a Moving In Vivo microscope may be accompanied by a Specimen Stage.  Prairie View software controls only 

Stage Control
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one X,Y platform, configured as the primary X and Y axes in the Prairie Configuration Utility.  The secondary X and Y axes (the other platform) can be controlled by the 3axis knob 

controller, but will not be taken into account when saving X,Y positions in Prairie View software or using the Stage Control section on the main control window.

Orbital	Nosepiece

On systems configured with an Orbital Nosepiece to adjust the angle of the objective, the X, Y, and Z motors can move in concert to move the perceived X, Y, and Z directions of the image. 

This is done by checking the box in the Orbital box and entering the yaw and pitch angles of the Orbital Nosepiece.  Entering these values allows the software Stage Control buttons to 

perform coarse movements accounting for all three axes of movement (X, Y, Z).  Uncheck the Orbital box to restore independent control of the three axes, as one would have for 

controlling a micromanipulator.  Depending on the firmware version of the motor controller, the 3axis knob controls may also respond to the state of the check box.  

Resonant Phase Offset control is available only in Resonant acquisition mode.  This feature uses algorithms to measure the offset of alternating lines in images collected with the resonant 

galvanometer, and provides a corrective offset as feedback to the galvanometer control hardware to adjust its timing.  The Auto Correct option should be checked during acquisitions. If a 

situation arises where the scan lines are not aligned properly in the image, the user can uncheck the Auto Correct option and use the slider to adjust the offset, and then reenable auto 

correction.  Based on settings in the ZSeries Preferences dialog, correction can be automatically disabled during acquisition of a ZSeries to minimize artifacts due to the changing features 

of the image during the acquisition.

The Reset button is used to reset the alignment and correction feedback algorithm, and is rarely needed by users.

Sampling Method control is available only in Resonant acquisition mode.  When the Enable Multisampling option is checked, the system collects as many samples as possible at each pixel. 

This number is indicated in the Samples/Pixel field and is based on the size and number of pixels in the image.  The Averaging/Summing button allows the user to specify whether the 

recorded value for each pixel is the average or sum of these samples.  When the multisampling is not enabled, the system will collect only one sample to determine the intensity of each 

pixel.

The Enable Multisampling option should remain checked unless the user has a specific reason for reducing the number of samples collected; there are almost no applications in which it is 

beneficial to reduce the number of samples.

At the bottom of the Prairie View Main Window, status bars to show basic information about the scan being performed.

The first line displays the Scanline Period, Frame Period, and Framerate.

� The scanline period is the number of milliseconds required to scan across one line in the frame.  This includes acquisition time and retrace time for the galvanometers.  To calculate the 

retrace time, use the following formula:

Retrace time = scanline period – (dwell time * number of pixels per line)

� The frame period is the number of milliseconds it takes to create one frame.  This could also be arrived at by multiplying the scanline period by the number of lines per frame.  When 

acquiring frames using a Label Group, the frame period will change as the individual labels are applied.

� The frame rate is the number of frames scanned per second.

The second line displays the Field of View (in pixels and microns) and Pixel Size. The field of view measurement and pixel size in microns are dependent upon the calibration of the objective 

lens selected.

The third line displays the X, Y, and Z motor positions.

Resonant Phase Offset

Sampling Method

Scan Information
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The large window is used to display informational messages at start up and update status during an acquisition.

At the very bottom of the window, information is displayed by particular operations in the software.  This information includes warnings about data integrity and scan settings, and frame 

counts when acquiring images of averaged frames.

The Laser, PMT, DAQ tab is separated into multiple sections.  The sections vary based on system configuration and the current acquisition mode.  Green bars on the left edge and the 

center of the tab allow the user to flip between stacked sections.  Individual sections can also be torn out into separate windows via the arrow button on the upper right corner of the 

section.

Laser	Controls

This section allows the user to control the laser power for all lasers configured in the system. Typically, lasers on the imaging light path are listed first, followed by lasers on the uncaging 

light path.  For each laser, the user can drag the slider to change laser power, or enter the desired setting in the field to the right of the slider.  Clicking the Zero/Prev button will return 

laser slider to 0 or the previous value, respectively.  During a scan, the shutter will open only if one or more lasers associate with that shutter have slider values of greater than zero.

The default system setup has laser power sliders in arbitrary units from 0 to 100 or 0 to 1000, which do not correspond to linear changes in the laser power delivered to the sample. The 

utility of the laser slider for 2p lasers can be extended to additional modes using the Laser Power Calibration feature, described here.  Additional laser slider modes are Attenuation and 

Calibrated modes.  In Attenuation mode, the slider values become percentages of maximum power at the given wavelength.  When a full Calibration File has been created for a given set of 

operating parameters, the laser slider will reflect laser power in milliwatts.

Interlaced	Scan	Pattern

Interlaced scanning allows the user to scan each line of the image multiple times, using a specific set of lasers and laser powers each time.  This feature provides a means to scan with 

multiple laser lines while reducing cross talk between excitation channels and preserving temporal resolution.

The checkbox at the bottom of the Laser control section allows the user to enable Interlaced Scanning.  Check the box and click the Setup button to open the configuration window.  The 

window contains instructions for setting up the interlaced scan.

Laser, PMT, DAQ Tab
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Interlaced scan patterns allow acquisition of frames using up to four different independent laser settings alternating each line for higher temporal resolution than is possible with using 

labels to alternate settings each frame. One line of each track is scanned to acquire one line of the final image.

While this feature is available for systems with only a single laser, its usefulness with a single laser setup is limited. This feature is primarily useful when a system has more than one laser.

For example, if a system has two imaging lasers, one tuned to 800 nm and one tuned to 900 nm, this feature allows the operator to scan a 512x512 image alternating wavelength with each 

line. The data for track one will be saved as the channel one data and the track two data will be saved as channel two.

Whenever the Interlaced scan pattern check box is checked, the defined interlaced settings will be used. This applies to Live Scan, Single Scan, TSeries, ZSeries, etc.

Laser Selection specifies one of the lasers currently configured on the system as well as a power setting. The laser and power here can be added directly to an active track. By default the 

Current power check box is checked which indicates that the laser slider power setting should be used even as the current value changes in the main control window.  When the box is 

unchecked, a static power value can be specified using the slider in the setup window.

A Track is a sequence of laser lines and powers to control. Up to four different tracks may be defined, and multiple lasers can be defined in each track.  Enable a track by checking the box 

on the left side of its title bar.  Once enabled it is possible to add the selected laser and power to it using the +  button. The same button can be used to update the power setting from a 

laser already added to the track.  To remove a laser from a track, select the desired line and press the X button.  Any lasers not included in an active track will be left at zero power for 

scans.  Each track enabled will reduce the frame rate of the acquisition, whether or not the track is mapped to a display channel.

Channel Mapping allows the user to choose the display channel to which each PMT and Track are mapped.  An acquisition can generate up to 16 data sources (four source channels times 

four tracks).  Up to four of these combinations can be acquired as image data.  Choose a Source Channel (detector) and a Source Track for each Display Channel.  In the example above, 

Display Channel 1 contains data acquired by Source Channel (PMT) 1 during Track 1 (561nm laser), Display Channel 2 contains data acquired by Source Channel (PMT) 2 during Track 2 

(488nm laser), and Display Channel 3 contains data acquired by Source Channel (PMT) 1 during Track 3 (643nm laser).  Note that the combination of Source Channel and Display Channel 

used here means that the data stored in Display Channel 3 memory came from Source Channel 1.

Laser	Controls	in	SFC	Mode

While operating in SFC mode, the Laser tab differs slightly.  
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Lasers used by a secondary scanning unit operate as described in the previous section.  Lasers routed through the SFC scanner have additional controls, described below.

The Blanked button can be used to turn on (unblank) an imaging laser when not scanning.  This can be useful when performing power measurements or when troubleshooting to make 

sure no system optics are blocking the light path to the sample.

Each imaging laser can be mapped to one or more acquisition channels by activating the Ch1 through Ch4 buttons below the slider.  Each laser can be assigned (mapped) to one or more 

channels, or can be left unassigned.  Conversely, a given channel can have more than one laser assigned to it.  Depending on the experiment, this may lead to detection of multiple 

fluorophores in one channel, which cannot be separated for measurement.  Lasers are mapped to channels by clicking the channel buttons below each laser slider.  In the example above, 

the 405nm, 488nm, and 561nm lasers are mapped to channels 1, 2, and 3, respectively.  This means that for each scan, three exposures will be acquired  one with the 405nm laser, the 

second with the 488nm laser, and the third with the 561nm laser.

For a channel to be acquired, it must also be activated in an Image window.  To do this, click one or more of the channel buttons on the left side of the Image window.  In the example 

below, channel 1 is active in Image window 1, and is pseudocolored green.  The pseudocolor is chosen by clicking the narrow vertical bar to the right of the channel button.  An Image 

window may have more than one active channel, and the same channel may be activated in multiple Image windows.

The mapping of lasers to channels and the combination of active channels can differ between Labels (see further discussion in the Labels Tab section of this manual).

Each frame acquisition is made up of scans for all the active channels.  Thus, an acquisition with three active channels will have a lower frame rate than an acquisition with one active 

channel.

PMT	Controls

The PMT sliders control the voltage which amplifies the photonelectron signaltocurrent pulse for each detector. Increasing the voltage will increase the output current pulse and thus 

increase the brightness of image.  Multialkali PMTs run at voltages up to 1250V, while GaAsP detectors have a maximum voltage of 900V.

To adjust individual PMT voltage, drag or click the slider bar or arrows or type in the text field to the right of the slider.  Clicking Zero/Prev at the end of a PMT slider sets that PMT to zero 

or the previous value, respectively.

To reset all PMT voltages to zero, click Zero next to PMT Master at the top of the section.  The button will then change to read Previous; clicking Previous will restore each PMT slider to its 

position when the master Zero button was clicked. 

DAQ	and	Preamplifier	Controls

The DAQs and Preamplifier sections of the tab are stacked behind the PMT controls section; click the green bar to the right of the PMT control section to reveal the DAQs and Preamplifier 

controls.  This section is not relevant to Camera and SFC acquisition modes.

Emission photons from the sample are detected by the PMTs, which send current to the preamplifier.  The preamplifier integrates and scales the input current, and sends voltage signals to 

the acquisition card in the GPIO box or computer.

When used together with the PMT voltage and laser power settings, the controls in this section allow the user to maximize the range of data collection for the sample.

Page 14 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm



The DAQs section allows the user to control the range of the data acquisition board.  Systems equipped with a resonant scanner use a General Standards card for data acquisition.  The 

maximum input voltage of the card is directly selected from a dropdown menu; options are 0.625V, 1.25V, and 2.5V.  Systems without a resonant scanner use a National Instruments 6110 

card for acquisition (or 6115 for AOD systems).  On the NI cards, the user can select a different input range for each of the 4 input channels.  This table shows the input voltages realized by 

each DAQ Gain setting:

The Preamplifier controls allow the user to choose additional settings to adjust the signals coming out of the preamplifier, with is read by the acquisition card.  A lowpass filter is applied to 

the signal and affects the collection rate of the channel.  This filter is selected from a dropdown menu to the right of each preamplifier channel.  In the example above, the filter is 

0.75MHz.  All channels must use the same filter; changing the filter for one channel will apply that filter to all channels.  Each channel also has a Gain/Filter slider and an Offset slider to 

scale and translate the voltage signals coming to the acquisition card.  While scanning a sample in Range Check display mode (described later in this manual), adjust the Offset slider until 

just a few blue pixels appear; this translates the incoming voltages so that few or none have zero or negative voltage values.  Adjust the Gain/Filter slider so that just a few red pixels 

appear; this scales the signal to use the full range of the acquisition card (based on the DAQ Gain selected for that channel), with few or no saturated pixels.

Confocal	Controls

For systems configured with a 3channel descanned confocal module, this section allows the user to select the dichroic mirrors, band pass filters, and confocal pinhole in the 

emission/detection light path.  The controls are located behind the Laser control section of the Laser, PMT, DAQ tab; click the green bar on the right side of the Laser control section to 

reveal Confocal controls.  Filter positions and names are configured by Prairie Technologies personnel while building and installing the system.  Pinhole positions are set during installation 

and can be updated by the user in a dialog accessed via Tools > Calibration/Alignment/1P Pinhole Alignment; more information is provided laser in this manual.  The red, blue, and green 

lines are for general illustration only, and do not update based on the filter combinations selected.

In the example above, all light passing through the 120um pinhole will be reflected toward the Channel 2/3 Dichroic.  The 495 long pass dichroic in that position will transmit light above 

495nm toward the Channel 2 band pass filter, which will allow light between 500 and 550nm to reach the PMT.  Wavelengths shorter than 495nm will be reflected toward the Channel 3 

band pass filter, which will block all that light, as the filter transmits only wavelengths between 500nm and 550nm.  Thus, only Channel 2 will detect useful emissions in this example.

DAQ Gain Input Voltage Range (Volts)

0.2 0 – 42

0.5 0 – 20

1 0 – 10

2 0 – 5

5 0 – 2

10 0 – 1.0

20 0 – 0.5 

50 0 – 0.2

Position Function Examples (differing from diagram)

1/2&3 

Dichroic

Transmit light toward Channel 1

Reflect light toward Channels 2 

& 3

565LP transmits red light toward Ch1 and shorter 

wavelengths toward Ch2/Ch3

Channel 1 

Filter

Band pass filter to set bounds on 

Channel 1
605/70 transmits 570640nm to Ch1
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Camera	Controls

When operating in the Camera acquisition mode, the Camera controls panel becomes active. Note that control of a camera while operating in SFC mode is handled in the SFC settings 

window, not the Laser, PMT, DAQ tab.

The parameters and values available in Camera controls vary based on the camera that has been configured in the Prairie Configuration Utility.

Exposure time is the amount of time the camera will collect photons from the sample, entered in milliseconds.

The Binning menu allows the user to combine charge from adjacent camera pixels.  Increasing the binning factor will increase speed and signaltonose, but will decrease spatial resolution.

Many cameras supported by Prairie View have two types of gain control, which amplify signal after it is acquired by the camera.  Options in the first Gain slider or menu determine the way 

signal is digitized – they describe the number of photoelectrons that make up one unit of digital signal.  The second gain control slider or menu allows the user to set the multiplication gain 

that is applied on the camera’s chip; this is called Mult. Factor or EM Gain.

The Port or Readout Mode menu offers choices for the speed at which the camera transmits data to the computer, with or without multiplication gain, denoted by “(M)”.  Faster readout 

rates allow faster frame rates, but may affect the dynamic range and read noise of the signal.

The Mode describes the communication between the computer and the camera.  In Timed mode, the exposure time specified in Prairie View software is used by the camera to generate 

frames.  In Bulb mode, each of the camera’s exposures is controlled by a signal from an external source; unless the user connects and sends a trigger to end each frame, the camera will 

not read out data to the computer.  In general, Timed mode is the preferred mode of operation, but some camera models may require the use of Bulb mode for certain acquisitions.

Temperature displays the temperature of the camera’s internal sensor, if supported by the camera.

Use Splitting Optics is an option available on systems configured with splitting optics for simultaneous collection of multiple channels of data using a single CCD or CMOS image sensor. 

When the box is checked to enable this option, the software will separate a single camera image into multiple channels of data (either 2 or 4, depending on the splitting hardware).  More 

information is available in the Image Splitting Optics section of this manual.

Use the ZSeries controls to define, save, and recall ZSeries definitions, and to acquire image stacks.  The top portion of the window is a table displaying the z device positions defined in 

the current ZSeries.  Controls in the window vary based on system configuration.

2/3 Dichroic
Transmit light toward Channel 2

Reflect light toward Channel 3

495LP transmits green light toward Ch2 and reflects blue 

light toward Ch3

Channel 2 

Filter

Band pass filter to set bounds on 

Channel 2
525/50 transmits 500550nm to Ch2

Channel 3 

Filter

Band pass filter to set bounds on 

Channel 3
460/50 transmits 410510nm to Ch 3

Z-Series Tab
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Position	Controls

The Set Start and Set Stop buttons set the current z device position as the start or stop of the ZSeries, respectively.  Use the + and – buttons to increase/decrease the set position by the 

amount displayed in the Step Size field.  Use the Goto buttons to move the motor to the start, middle, or stop position.

The user may also enter z device positions by typing in the Start Position and Stop Position text boxes.  Note that the Set Start and Set Stop buttons always use the current motor positions, 

so the user should not click these buttons after typing values into the text boxes, unless the user wants to overwrite the value typed previously.

Defining	and	acquiring	a	basic	Z-Series

A ZSeries is defined by four parameters: a start position, a stop position, a step size, and a number of slices.  Defining any three of these parameters allows the fourth to be calculated. 

Click the Calculate radio button (next to the calculator icon) in the ZSeries tab next to the one parameter to have calculated.  The following steps describe setting the start and stop 

positions of the image stack and choosing the step size.

1.    Use Live Scan and/or Single Scan (see the Scanning Controls section of this manual) to locate the sample

2.    Use the up/down software buttons to navigate to the top or bottom of the desired ZSeries

3.    Set the current position as the start of the ZSeries by clicking the Set Start button in the ZSeries tab, or by clicking the  button in the Stage Control section of the main 

control window; the + and – buttons will increment the start position by the value displayed in the Step Size field

4.    Use the up/down software buttons to navigate to the desired stop position of the ZSeries

5.    Set the current position as the stop of the ZSeries by clicking the Set Stop button in the ZSeries tab, or by clicking the  button in the Stage Control section of the main control 

window; the + and – buttons will increment the stop position by the value displayed in the Step Size field

6.    Enter the desired step size into the Step Size field in the ZSeries tab; the + and – buttons will increment the step size by 0.1µm

7.    Confirm that the Save Path and file name point to the intended location of the images

8.    Click the Start ZSeries button

The user can move to a previously set or calculated Start, Middle, or End position by clicking the corresponding Goto button in the ZSeries tab.

To change the Start or Stop position after defining a ZSeries, either type the new position into the text box or use the + and – buttons to increment the position by the amount specified in 

the Step Size field.

Note that Prairie View will not allow a ZSeries definition of greater than 1000 slices.  If the user attempts to define a stack of more than 1000 slices, the Step Size and Number of Slices will 

be adjusted to cover the range between the Start and Stop location without exceeding 1000 slices.

Saving	Z-Series	Images

Each ZSeries acquisition is saved in its own folder.  The location of the folder is determined by the Save Path, which can be viewed or changed by clicking the  button next to the Save 

Path box.  The name of the folder is the name displayed in the text box next to the  button, followed by the number displayed in the iteration counter text box.

The default folder name includes the type of acquisition and the date and time code for the last time the software was loaded.  The user can type a custom name in this field for the 

current session.  The folder name will revert back to the default typedatetimecounter format each time Prairie View is started.  To retain the custom folder between sessions, check the 

Preserve UserModified File Names option in the Preferences menu.  Note that using the same folder name in multiple tabs (ZSeries, TSeries, etc.) can cause data to be overwritten if 

counter values are the same on multiple tabs.

The counter is automatically increased by 1 after each acquisition.  The user can change the counter value by typing in the box or using the + and – buttons.  Note that decreasing the 

counter value can result in overwriting data.

Laser	and	PMT	Power	Gradient

It is sometimes desirable to change laser and/or PMT power during a ZSeries, as signal intensity is often a function of depth in thick samples.  When the Adjust PMT & Laser checkbox is 

checked, the laser power slider setting and PMT voltages are recorded along with the Z device position when the start and stop positions of a ZSeries are set.  These settings are displayed 

in the table at the top of the ZSeries tab.

PMT voltages between the Start and Stop position are incremented in a linear fashion.

The Laser Power Gradient control affects the way imaging laser power is controlled throughout a ZSeries.  When Adjust PMT & Laser is checked, the Laser power Gradient control is 

active. When more than one imaging laser is present, the user can choose the laser(s) to which gradients are applied via a pull down menu and checkbox. The settings are retained for each 

ZSeries definition and each saved ZSeries can have a different gradient setting.  There is also a checkbox to allow the settings to be applied to all imaging lasers.

The user can choose the equation applied to the laser power by selecting Default, Custom, or Manual control.  When using a Manual gradient, the user can type laser power values into the 

table at the top of the ZSeries tab.  The Default laser power gradient is a slight parabola defined by Prairie View.  Custom allows the user to enter a gradient line for the acquisition.  The 

user can enter a number in the field to the right of Custom or click the graph icon button.

If the graph is selected, a dialog will appear for viewing the Custom gradient versus the Default. There may be additional lines for other imaging lasers.  The xaxis (horizontal) represents 

the Z position of the current ZSeries, and the yaxis (vertical) indicates the laser power setting as a function of the Z position.  The Default curve shows the relationship of laser power to Z 

position if the user selects the Default laser power gradient option (radio button).  The second curve shows the relationship of laser power to Z position as the Adjust Gradient control is 

adjusted. As the Adjust Gradient slider is adjusted, the graph will automatically update with the new relationship between the laser power and Z position.  In addition, the operator may 

type in a Gradient value in the text box located below the Adjust Gradient slider.  If more than one imaging laser is present, then the operator may click on the Show All Laser checkbox to 

display the graphs of all laser powers as a function of Z position for the current ZSeries definition.  If the user clicks the Cancel button, the dialog will be dismissed and the gradient setting 

will revert to the value when the dialog was first opened.  If the user hits the Accept button, then the new gradient setting will be applied to the selected laser line(s).

Note that keeping the Adjust PMT & Laser box checked will implement the laser and PMT power gradients defined when setting the Start and Stop positions, even when the user does not 

change those values between slices.  Thus, having the box checked will override laser and PMT powers changed in the Laser, PMT, DAQ tab, as well as laser powers defined for 

Photoactivation Masks (described later in this manual).

Hard	Shutter	Control

The Leave Shutter Open option allows the user to determine the behavior of the hard shutter during acquisition of a ZSeries.  When checked, the hard shutter opens at the start of the Z

Series and remains open until acquisition is complete.  When unchecked, the hard shutter closes between slices of the ZSeries.  The option is not available when performing a ZSeries in 
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Fastest Acquisition mode.

Bidirectional	ZSeries	in	a	TSeries

When multiple repetitions of a ZSeries will be performed as a TSeries cycle, the user can choose to perform the ZSeries bidirectionally.  If the Bidirectional in TSeries option is enabled as 

part of the ZSeries definition, consecutive ZSeries repetitions will be acquired in opposite directions, eliminating the time needed to move back to the start position between each 

repetition.  The first ZSeries will go from the Start position and go towards the Stop position and the second ZSeries will go from the Stop position towards the Start position.  Playback 

controls will adjust for the opposing orientations of consecutive ZSeries.  Note that this bidirectional acquisition applies only in the TSeries tab.

Multiple	X,Y	Stage	Locations

A ZSeries can be performed at multiple predefined X,Y stage locations (see XYStage Tab) by checking the At all XY stage locations checkbox in the ZSeries tab.  The saved X,Y stage 

locations include coordinates for the X and Y axes as well as the position of the Z device (focal plane).  A setting in the ZSeries Preferences dialog (Preferences > ZSeries) allows the user to 

choose whether the saved stage location becomes the center or the start of the ZSeries.

Automatically	Truncating	a	ZSeries

The Until intensity drops __% feature allows the user to set up a large ZSeries, but to end the acquisition before the Stop position if the image intensity drops below a userdefined level.  

This is useful when defining a ZSeries that will be used at multiple time points for a sample that may move or shrink during the experiment.  Acquisition will begin at the Start position and 

will continue until the overall intensity of the image drops below the some fraction of the overall intensity of the previous image; the user determines the fraction by entering the value in 

the % field.  If the image does not reach that intensity cutoff during the ZSeries, the acquisition will continue until the originally defined Stop position is reached.

If a ZSeries with this option enabled is being executed from within a TSeries, BOT data can not be collected simultaneously and the BOT check box will be disabled.

Fastest	Acquisition	Mode

Fastest Acquisition mode is available when using a Zpiezo device, or when using the Prairie MAMC in a triggered or pulsed mode to move the Z motor.  The Zpiezo or MAMC must be 

cabled to receive a frame trigger from Prairie View software (usually an End of Frame trigger). ZSeries can be performed in Fastest Acquisition mode by checking the associated box in the 

ZSeries tab.  In this mode, the scanner does not wait for the Z device to finish moving before beginning to acquire the next frame.  Instead, the Z device moves on receipt of a frame trigger 

signal, and the next scan begins immediately.  When using a fast Z device in Galvo scan mode (for example, with an Ultima system), the user can define a wait time to add additional time 

between frames to give the Z device time to move and any defined changes in PMT and Laser power to occur before the next frame is acquired.  This wait time is not implemented in SFC 

mode.  

Zpiezo	devices

If Prairie View is configured to control a Zpiezo device, additional options and controls are present in the ZSeries tab.  Capabilities of Fastest Acquisition Mode are described above.

If the Zpiezo is a Prairie Technologies device (rather than a device manufactured by a third party), the Software Control checkbox allows the user to dictate whether the device is 

controlled by Prairie View software or by the manual knobs on the Piezo Amplifier/Driver box.

If the piezo is a Prairie Technologies piezo device (rather than a thirdparty device), the range of the piezo is reported in the ZSeries tab.  Range and drive voltage can vary based on 

parameters such as the mass of the objective in use.  The Calibrate Piezo button will drive the piezo through the currently defined ZSeries and use a feedback algorithm to improve 

positioning accuracy during the acquisition.  If any parameters have changed since the previous calibrated acquisition, the software will automatically calibrate the piezo before acquiring 

the next ZSeries.

Using	multiple	Z	devices

Many systems are equipped with more than one Z device that can be controlled by Prairie View software.  For example, a system may have a focus device on the microscope’s objective 

nosepiece as well as a Zpiezo.  

The active Z device is chosen from the dropdown menu in the Stage Control section of the Prairie View main control window; this is the device that will move when the user clicks the 

software’s up and down buttons for Z position.

A second dropdown menu for choosing the Z device can be found in the ZSeries tab; this is the Z device that will be moved during acquisition of the Zseries.  

Ensure that the Z device used when defining the top and bottom of the ZSeries is the device used when acquiring the ZSeries.  If the top and bottom of the stack is set using the nosepiece 

focus device but the acquisition device is the piezo, neither Z device will move during the acquisition.  

Users may choose to link these two dropdown menus by choosing Z Device controls linked in the ZSeries Preferences dialog (Preferences > ZSeries).  If the option set to not link the 

controls, the user may independently select which Z device to be used with the ZSeries definition and which to be used with the Stage Control panel Up/Down arrows.  If the option is set 

to link the controls, selecting a Z device with one of these dropdown menus will cause the other selection to automatically change to match.

Additionally, an option in the Display menu allows the user to choose whether the focus position information displayed in the lower portion of the Prairie View main control window is the 

position of the currently active device, all positions separated by commas, or the sum of the positions of all devices.

Triggered	ZSeries

A ZSeries can be started on its own, or set to respond to input triggers from other equipment. Triggering options are selected via a dropdown menu in the ZSeries tab.

If No Input Trigger for ZSeries is selected, then the ZSeries will start immediately when the Start ZSeries button is pressed.

If Start ZSeries with Input Trigger is selected, then after Start ZSeries is pressed, the z device will move to the position of the first slice/frame, the Laser and PMT settings will be set, the 

hard shutter will open, and the software will wait for the arrival of an external input trigger before acquiring the first slice/frame.  All subsequent slices/frames are acquired automatically.

If Use Input Trigger for each Image is selected, then after Start ZSeries is pressed, the z device will move to the position of the first slice/frame, the Laser and PMT settings will be set, the 

hard shutter will open, and the software will wait for the arrival of an external input trigger before acquiring the first slice/frame. This process is then repeated for each subsequent 

slice/frame in the ZSeries.

These controls only affect ZSeries executed as standalone experiments. They do not affect a ZSeries executed as a cycle in a TSeries.

Triggers sent to the Prairie system should be 5V TTLstyle signals on a BNC cable.  If the system is configured with a GPIO box, input triggers are received by the Trig 1 In through Trig 8 In 

connections in the middle row on the front on that box.  Input triggers can also be received by configuring one of the numbered Aux connections on the SFC electronics box.  These 

connections are described in the SFC section of this manual.  If an SFC Aux line is configured to receive incoming triggers, then Prairie View software will look to that line for signals (rather 

than to the GPIO box).

Saving	ZSeries	Definitions
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Multiple ZSeries definitions can be set up and saved for use during a Prairie View session; definitions are not preserved when Prairie View is closed.  To save a ZSeries definition that has 

just been set up, click the  button next to the list of Saved ZSeries.  Give a custom name to the definition by clicking once on the name of the ZSeries in the list and typing a new name.  

To delete a definition from the list, select it and click the  button.  These definitions can be recalled to run as individual ZSeries in this tab, or referenced within a TSeries (as described 

in the TSeries Tab section of this manual).  Note that the ZSeries definition includes all options selected in the ZSeries tab, including the state of the Bidirectional in TSeries checkbox.

The TSeries tab gives users the ability to generate a series of images and data using different labels, regions of interest (ROIs), XY stage locations, ZSeries, Photoactivation masks, external 

triggers, etc.  The variety of options allows the user to optimize a complex set of experimental parameters to the acquisition of key data.  

The TSeries Cycles table displays cycles in the current TSeries and allows the user to specify characteristics of each cycle.  The selected TSeries cycle is denoted by a triangle on that line 

to the left of the Cycle Type column.

The Remove Selected button deletes the currently selected cycle (row) of the TSeries table. Clear All removes all cycles.  Buttons in the center of the TSeries tab allow the user to add 

various types of cycles to the TSeries.  The Add and Insert radio buttons indicate whether the new cycle will be placed at the end of the series or inserted previous to the selected line, 

respectively.

When changing acquisition modes, the contents of the TSeries Cycles table may change.  The types of cycles available for various modes may differ slightly, so some modes maintain their 

own TSeries settings from the last time that mode was in use.  For example, if the user defines a TSeries in Galvo mode and then switches to SFC mode, the contents of the TSeries Cycles 

table will change to reflect the last set of cycles defined in SFC mode.

Columns	in	the	TSeries	Cycles	Table

The left section of the TSeries Cycles Table is made up of columns to define parameters.  Some columns/parameters apply to only a subset of cycle types (described below), and are 

therefore unavailable in some rows.

� Cycle Type describes the function performed in the cycle

� # Reps shows the number of times the cycle is to be repeated

� The user can set the Period as the amount of time between the start of consecutive repetitions.  This time does not include motor movements in a ZSeries.  When Max Speed is 

checked, the period is automatically set to the minimum time needed to complete one repetition of the cycle.

� When Max Speed is checked, images are acquired continuously.  Max Speed is available for Zseries only when piezo control is available. The TSeries Preferences dialog (Preferences > 

TSeries) contains an option to Update display during max speed acquisitions; unchecking the box for this option will allow the user to decrease the amount of computer resources 

used to update the display.

� Duration is the minimum amount of time necessary to acquire the image(s) in all repetitions of the cycle as calculated by Prairie View.  The actual time required may increase based on 

a number of factors, including motor movements in a ZSeries, readout and transfer time of a camera image, etc.

� The Resource Selection column is enabled for cycles requiring the user to choose a previouslydefined definition (ZSeries, ROI, Label, Script, etc.)

� An imaging cycle can be configured to use a previouslydefined Photoactivation Mask via the Photoactivation column.  Only masks valid for the current scan settings (image size and 

dimensions) will appear in the list of saved masks.  More information can be found in the Photoactivation section of this manual.

� Check the box in the BOT column to perform a previouslydefined brightnessovertime measurement during an imaging cycle.  More information about BOT features is provided in the 

BOT section of this manual.  Note that a BOT cannot be performed while collecting a Zseries using the Until intensity drops ___% feature.

� The External Trigger column allows the user to trigger acquisitions within a cycle.  More information is provided in the Triggering Acquisitions within a TSeries section of this page.

T-Series Tab
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 The remaining columns are described later in this section of the manual.

Types	of	TSeries	Cycles

Buttons in the center of the TSeries tab allow the user to add various types of cycles to the TSeries.  The Add and Insert radio buttons indicate whether the new cycle will be placed at the 

end of the series or inserted previous to the selected line, respectively.

� Image Sequence performs the current single image scan, including applying the current ROI, frame averaging, and Label settings.

� ZSeries performs a ZSeries; select the Current or saved ZSeries definition in the Resource Selection column.  The current ROI, frame averaging, and Label settings are used.  When 

performing multiple repetitions of a ZSeries in one cycle, the state of the checking the Bidirectional in TSeries option on the ZSeries tab will apply.  More information is available in 

the discussion of the ZSeries tab.

� Photoactivation or PA applies a previouslydefined Photoactivation mask to a single Image Sequence; select the desired mask from the Photoactivation column dropdown menu.  Only 

masks valid for the current scan settings (image size and dimensions) will appear in the list of saved masks.  To apply a 3D Photoactivation mask to a ZSeries, add a ZSeries cycle and 

select the desired mask in the Photoactivation column.  The current ROI, frame averaging, and Label settings are used.  Photoactivation masks are described elsewhere in this manual.

� BOT performs the currently defined Brightness Over Time acquisition within the TSeries. The current ROI, frame averaging, and Label settings are used.  More information about BOT

features is provided elsewhere in this manual.

� XZ/YZ Image performs an XZ/YZ scan; select the Current or saved XZ/YZ scan definition in the Resource Selection column.  The current ROI, frame averaging, and Label settings are 

used.  When performing multiple repetitions of an XZ/YZ scan in one cycle, the state of the checking the Bidirectional option in the XZ/YZ Scan Definition dialog will apply.  More 

information is available in the discussion of the XZ/YZ Scanning dialog.

� Region of Interest is a modifier cycle that will apply to all subsequent lines in the TSeries. Select the previouslysaved ROI from the Resource Selection dropdown list.  No scans are 

performed in this cycle; follow it with an Image Sequence or other cycle to acquire images. See more information discussed with Regions of Interest section of this manual.

� Label is a modifier cycle that will apply to all subsequent lines in the TSeries.  Select the previouslydefined Label from the Resource Selection dropdown list; the settings of that Label 

will be applied.  No scans are performed in this cycle; follow it with an Image Sequence or other cycle to acquire images.  See more information discussed with Labels Tab section of this 

manual.

� Script allows the user to execute a previously written script within the TSeries.  More information is provided in the Scripts section of this manual.

� Wait allows the user to specify a delay before the next cycle.  Enter the number of seconds to wait in the Period column.  If the very last cycle to be executed in a TSeries is a Wait 

cycle, that cycle will not be executed; this avoids unnecessary delay at the end of the TSeries.

� Mark Points inserts a cycle which executes an experiment defined in the Mark Points dialog. Choose the Current or saved definition from the dropdown list in the Resource Selection 

column.  The Mark Points experiment is run to completion before the TSeries moves to the next cycle.  Note that if the first point of the first repetition of the first line of the Mark 

Points experiment is configured to start on receipt of an input trigger, that first trigger will be provided by the TSeries.  Subsequent triggers within Mark Points must be provided by the 

user to avoid locking up the TSeries; this is especially problematic if the Mark Points experiment is waiting for PFI0 or PFI8 triggers, which are not being generated while the TSeries is 

waiting for the Mark Points experiment to finish.  Mark Points experiments are described elsewhere in this manual.

� Voltage Output inserts a cycle which executes an experiment defined in the Voltage Ouputs dialog.  Choose the Current or saved definition from the dropdown list in the Resource 

Selection column. The Voltage Ouputs experiment is run to completion before the TSeries moves to the next cycle.  Note that if the Voltage Output experiment was configured to start 

on receipt of an input trigger, the TSeries will provide that trigger and the Voltage Output cycle will being as soon as it is reached within the TSeries.  Voltage Output experiments are 

described elsewhere in this manual.

� Voltage Recording inserts a cycle which executes an experiment defined in the Voltage Recording dialog.  Choose the Current or saved definition from the dropdown list in the 

Resource Selection column. The Voltage Recording experiment is run to completion before the TSeries moves to the next cycle.  Note that if the Voltage Recording experiment was 

configured to start on receipt of an input trigger, the TSeries will provide that trigger and the Voltage Recording cycle will being as soon as it is reached within the TSeries.  Voltage 

Recording experiments are described elsewhere in this manual.

� Stage Position is a modifier cycle that will move the XY stage and/or Z device(s) to previouslysaved coordinates.  Select the previouslysaved position from the Resource Selection 

dropdown list.  No scans are performed in this cycle; follow it with an Image Sequence or other cycle to acquire images.  See more information discussed with XYStage Tab section of 

this manual.

Note that the TSeries will start with the current scan settings, including the currently applied ROIs and Labels (see further description of ROIs and Labels in other sections of this manual).  

If multiple ROIs and Labels have been applied in the current Prairie View session, the user must ensure that all settings have been returned to the desired settings of the first TSeries cycle 

before starting the TSeries.  One way to do this is to include a TSeries cycle to select a saved ROI (including “No ROI”) and/or the desired Label.  Also, frame averaging defined in the main 

form Average Every __ Frames setting will be applied to each imaging in the TSeries.

If the TSeries definition includes any positions for the XY or Z devices, and the user changes the position of a device manually while the TSeries is running, the system will attempt to move 

the device(s) back to the position defined in the TSeries.  If the TSeries definition does not include any XY or Z device positions, the user can move the devices without interfering with or 

being overridden by the TSeries.

The Leave Shutter Open option allows the user to determine the behavior of the hard shutter(s) during acquisition of a TSeries.  When checked, the hard shutters for all lasers used during 

the TSeries open at the start of the TSeries and remain open until acquisition is complete.  When unchecked, the hard shutters close between cycles of the TSeries.

Synchronizing	Functions	Within	a	TSeries	Cycle

There are many ways to include Voltage Recording, Mark Points, and Voltage Output experiments within a TSeries.  These options fall into two general categories: an experiment run as a 

separate cycle (described above and summarized below), and an experiment embedded within a cycle (described below).

Summary	of	Experiments	Run	as	Separate	Cycles

The Voltage Recording, Mark Points, or Voltage Output experiment can be run as its own cycle, as described in the Types of TSeries Cycles section of this manual.  Add the desired cycle 

type to the TSeries and choose the Current or saved experiment definition from the Resource Selection dropdown menu.  The entire cycle will be run to completion before the TSeries 

moves to the next cycle.

Embedding	Experiments	Within	a	Cycle

The Voltage Recording, Mark Points, and/or Voltage Output experiment can be embedded within some other types of cycles, synchronized with each other and/or with imaging 

sequences.  This is done using columns in the right side of the TSeries Cycles table.  
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The user can choose from the Current or saved definitions for Voltage Recording, Mark Points, and/or Voltage Output via dropdown menus for each type of experiment.

Synchronizing	with	Frame	Triggers

If the number in the Triggers Before Starting column is 0, the embedded experiments will start at the beginning of the cycle.  By entering a nonzero value in the Triggers Before Starting

column, the user can determine a number of frame triggers to count before starting the embedded experiment(s).  For example, the user can create an Images cycle with 100 repetitions, 

set  Triggers Before Starting to 10, and synchronize with a Mark Points experiment. This allows the user to collect a few images as a baseline before starting the Mark Points experiment.

Frame triggers can be generated at the start of frame or end of frame.  In the Preferences menu > Output Trigger Type, select either “Start of Frame Trigger” or “End of Frame Trigger”.  In 

order for the Triggers Before Starting feature to be used, the Trigger Mode must be set to “Generate Start of Frame OR End of Frame Trigger OR Neither”, and one of the two frame 

triggers must be selected.  More information about frame trigger generation is provided here.

Frame triggers are received on the PFI8 line of the National Instruments 6052E card, via connections inside the GPIO box.  Some system configurations, including those with Resonant 

Scanner, SFC, and some Camera configurations, require frame triggers to be routed through external connections on the GPIO box.  These connections will be made and described during 

system installation.  Contact Bruker Fluorescence Microscopy personnel with questions about these systems.

Including	Multiple	Synchronized	Experiments	Within	a	T-Series

It is recommended that a user make a global decision on where to configure Voltage Recording and Voltage Output experiments for a given TSeries.  It is possible to configure a Mark 

Points experiment that calls a Voltage Recording or Voltage Output experiment from inside the Mark Points configuration.  If using this option, it is not advised to also call Voltage 

Recording or Voltage Output from the same cycle within the TSeries Cycles table.  For example, do not configure the cycle shown below if the current Mark Points experiment also 

contains Voltage Output experiments:

It is not possible to start a Mark Points, Voltage Recording, and/or Voltage Output experiment while another Mark Points, Voltage Recording, and/or Voltage Output experiment is running. 

Consider the example shown below.  A Voltage Output is embedded in an Images cycle.  The Images in this cycle make up the 4.26 second Duration.  The length of the Voltage Output 

experiment is not displayed.  The second cycle is a single repetition of a ZSeries, and the third cycle is a Voltage Recording.  The Voltage Recording cycle cannot begin until the Voltage 

Output experiment is completed.  If the Voltage Output lasted only 4 seconds, it would be finished during the Images cycle; the Voltage Recording cycle would start immediately when it is 

reached in the TSeries Cycles list.  However, if the Voltage Output experiment lasted 60 seconds and was still running after the ZSeries cycle finished, the system would wait for the 

Voltage Output to finish before starting the Voltage Recording cycle.

Imaging	With	Simultaneous	Mark	Points	Requires	Two	Scanners

In order to embed a Mark Points experiment in a cycle which scans the sample (Image Sequence, ZSeries, Photoactivation, BOT), an Ultima system must have two sets of galvanometers.  

Systems with only Imaging galvanometers can perform Mark Points experiments as separate cycles between images (using the single set of galvanometers for both functions); the imaging 

and Mark Points components are performed sequentially.  Simultaneous imaging with Mark Points requires two scanners with independent lasers.  SFC systems configured with an Ultima 

or Photoactivation/FRAP module can carry out Mark Points with the Ultima or Photoactivation/FRAP module while simultaneously imaging with the SFC.

Embedded	Experiments	Using	Start	Triggers

Embedded Voltage Recording and Voltage Output experiments will start as defined in the TSeries Cycles table and not wait for any trigger defined in the Voltage Recording or Voltage 

Output windows.  Embedded Mark Points experiments will override a trigger on the very first point of the experiment (first point of first repetition of first line), if defined, but will respect 

all other triggers defined in the Mark Points Series.

More information about Mark Points, Voltage Recording, and Voltage Output can be found in other sections of this manual.

Iterations	of	a	T-Series

The user can specify a number of times to perform the entire TSeries by increasing the value in the Iterations field.  A period between the start of consecutive iterations can be defined in 

the Period field below the Iterations field.  If the user enters a period that is shorter than the amount of time needed for one iteration to take place, the next iteration will begin 

immediately after conclusion of the preceding iteration.

Time

Total Images displays the total number of images in the current TSeries definition.

The Total Duration is the total scanning time for all images defined in the TSeries, as well as any Mark Points, Voltage Recording, and Voltage Output experiment configured as its own 

cycle. Embedded Mark Points, Voltage Recording, and Voltage Output experiments are not included in the reported time, though they may influence the duration of the experiment.  

Motor movement times are also not included.  Note that time estimates are not valid when any cycle is waiting for a trigger, so the Total Duration field will display N/A.

The Estimated Time Left is designed to include time that the system is not scanning.  This value will update during the experiment as the system gets more information about intercycle 

and interimage timing.

Waiting For displays a countdown when the TSeries is waiting for a Wait cycle or predefined period between acquisitions.

Saving	T-Series	Images

Each TSeries acquisition is saved in its own folder.  The location of the folder is determined by the Save Path, which can be viewed or changed by clicking the  button next to the Save 

Path box.  The name of the folder is the name displayed in the text box next to the  button, followed by the number displayed in the iteration counter text box.

The default folder name includes the type of acquisition and the date and time code for the last time the software was loaded.  The user can type a custom name in this field for the 

current session.  The folder name will revert back to the default typedatetimecounter format each time Prairie View is started.  To retain the custom folder between sessions, check the 

Preserve User-Modified File Names option in the Preferences menu.  Note that using the same folder name in multiple tabs (ZSeries, TSeries, etc.) can cause data to be overwritten if 

counter values are the same on multiple tabs.
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The counter is automatically increased by 1 after each acquisition.  The user can change the counter value by typing in the box or using the + and – buttons.  Note that decreasing the 

counter value can result in overwriting data.

Triggering	Acquisitions	within	a	T-Series

There are several options available for triggering acquisitions in a TSeries.  Triggers sent to the Prairie system should be 5V TTLstyle signals on a BNC cable.  If the system is configured 

with a GPIO box, input triggers are received by the Trig 1 In through Trig 8 In connections in the middle row on the front on that box.  Input triggers can also be received by configuring one 

of the numbered Aux connections on the SFC electronics box.  These connections are described in the SFC Triggers section of this manual.  If an SFC Aux line is configured to receive 

incoming triggers, then Prairie View software will look to that line for signals (rather than to the GPIO box).

� When Trigger First Repetition is selected from the External Trigger column for a given TSeries cycle, Prairie View will wait for an input trigger before processing the selected line.

� When Trigger Every Repetition is selected from the External Trigger column for a given TSeries cycle, Prairie View will wait for a trigger before acquiring each repetition in the selected 

cycle.

� When the Start with input trigger option at the bottom of the TSeries tab is checked, Prairie View will wait for an input trigger before beginning the entire TSeries.  Click Start T

Series and the system will prepare the acquisition, but will not actually begin collecting data until a trigger is received.

Collecting	a	Basic	T-Series

A Basic Tseries is one in which an image or Zseries is collected at a desired interval.

This example shows how to set up a TSeries to take 10 repetitions of a ZSeries, with 120 seconds between the start of consecutive stacks.

1.    Click ZSeries.  A row with default settings will be created.

2.     To select the number of images or Zseries to acquire, click on the # Reps field, type “10”, and press <Enter>.  

3.    Click on the Period field, type “120”, and press <Enter>.

4.    Select a Zseries from the Resource Selection drop down menu. This will cause the Zseries to be collected as defined on the ZSeries Tab.

5.    Verify the Save Path.

6.    Press Start TSeries.

Collecting	a	Multi-Cycle	T-Series

A more complex Tseries is one in which numerous steps defining different operations are strung together into a single experiment. It is possible to collect a Zseries at a set interval or to 

collect individual images and Zseries alternately.

This example shows a TSeries in which there are three steps; 1) collection of 10 images with 30 seconds between each image, 2) a waiting period of 4 minutes, and 3) the collection of a Z

series:

1.    Click Image Sequence.  A row with default settings will be created.

2.    To select the number of images or acquire, click on the # Reps field, type "10", and press <Enter>.

3.    Click on the Period field and type "30", the total time for the system to wait between start of one repetition and the start of the next repetition.  Press <Enter>.

4.    Click Wait. A second line appears.

5.    Click on the Period field and type "240", the total time for the system to wait between the preceding and following acquisitions.  Press <Enter>.

6.    Click ZSeries. A third line appears.

7.    Select a ZSeries from the Resource Selection drop down menu. This will cause the Zseries to be collected as defined on the ZSeries Tab.

8.    Verify the Save Path.

9.    Press Start TSeries.

Saving	and	Loading	T-Series	Settings

A TSeries setup can be saved for later use via the File Menu > Save TSeries Settings.  It can then be recalled via File > Load TSeries Settings.  Note that when a saved TSeries definition is 

loaded, any cycles calling saved components (ROIs, Photoactivation Masks, Voltage Recording experiments, etc.) will be set back to default selections; new selections must be made by the 

user for these resources.

T-Series	Execution	Order

In cases where the number of TSeries Iterations is greater than 1 AND the Run at all XYZ stage locations box is checked, the order of operations in a TSeries can be chosen by the user.  

The TSeries Preferences dialog (Preferences > Tseries) contains graphical representations of the TSeries Execution Order.  The Iteration Period designation in the execution order options 

indicates at which layer of operations the Period for iterations is applied.
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Consider as an example a TSeries which contains 5 cycles totaling 3 minutes, 2 iterations, the Run at all XYZ stage locations box is checked, 4 stage locations are saved, and the Period is 

set to 3600 seconds.  The option selected in the screen shot above is “For each Iteration, At Each Stage Location, Run TSeries Cycles”, with “Wait for Iteration Period” at the Iteration 

level.  This means that the 5 cycles would be performed at the first stage location, then the second stage location, etc, and then the system would drive back to the first stage location.  The 

3600 second period would be applied at the iteration level, so after a total of 3600 seconds (including acquisition time), the whole cycles/stage locations acquisition would be repeated as 

the second iteration.  

If the user had chosen the upper left order instead (“At Each Stage Location, For Each Iteration, Run TSeries Cycles”, with “Wait for Iteration Period” at the Stage Location level), all 5 

cycles would be performed twice (1,2,3,4,5,1,2,3,4,5) at the first stage location, then the system would move to the second stage location and wait, then all 5 cycles would be performed 

twice at that location, and then again at the third and fourth stage locations.  The first image at location 2 would occur 3600 seconds after the first image at location 1, because the period 

was applied at the level of the stage location. 

Additional	Preferences

Additional selections in the Preferences menu and the TSeries Preferences dialog pertain to TSeries acquisitions.

The user can choose whether or not data is automatically written to TIFFs after a TSeries with the Preferences menu options to Automatically Convert Raw Files.  If images are not 

automatically converted, there is less processing overhead at the end of the TSeries before another image can be acquired.  The images can be converted later using the standalone 

ImageBlock Ripping Utility.  Users of systems with solid state drives (SSDs) are advised to have their Save Path set to the drive letter of the solid state drive (typically the E: drive) and to 

have the automatic conversion turned off.  The data should be moved onto the system (C:) drive and then converted to TIFF images there using the ImageBlock Ripping Utility.  This 

reduces the amount of data being written to the SSD, prolonging its useful lifetime.

When files are automatically converted after a TSeries, the user can also choose whether to review TSeries data immediately after conversion.  This is accomplished using the 

Automatically Start Playback After Acquisition option in the Preferences menu.

The 2P Laser tab provides option for the control of up to four ultrafast pulsed laser(s) used by the system.  Prairie View can control up to four 2P lasers.  This tab is visible only when the 

system has been configured for Prairie View software control of one or more ultrafasted pulsed lasers.  Note that when a laser is shared between multiple systems, it is common to disable 

Prairie View control of the laser.

Wavelength	Series

The left portion of the tab allows the user to define a Wavelength Series to perform a sequence of images using different excitation wavelengths.  The table displays one line for each 

image in the defined series, and the wavelength used for each slice.  Define the acquisition with the controls below the table.  There are four variables that must be set; three by the user 

and one to be calculated by the software.  Click the calculator radio button next to the parameter to be calculated.  Then enter the desired values for the remaining parameters.  To set the 

current wavelength as the start or stop of the Wavelength Series, click the Set Start or Set Stop button. Otherwise, type an integer wavelength value into the appropriate text field or use 

the + and – buttons to change the current value by the number of nanometers defined in the Step Size field. Step Size is the number of nanometers between consecutive images in the 

series.  Number of Steps is the number of images in the acquisition.  The Leave shutter open checkbox allows the user to determine whether the hard shutter will be closed or left open 

between images (while the laser is tuning to the next wavelength).  Once the variables have been entered, the experiment can be started by pressing Start WSeries.  At the end of the 

acquisition, the laser will return to the wavelength in use before the WSeries was started.

Each WSeries acquisition is saved in its own folder.  The location of the folder is determined by the Save Path, which can be viewed or changed by clicking the  button next to the Save 

Path box.  The name of the folder is the name displayed in the text box next to the  button, followed by the number displayed in the iteration counter text box.

The default folder name includes the type of acquisition and the date and time code for the last time the software was loaded.  The user can type a custom name in this field for the 

2-P Laser Tab
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current session.  The folder name will revert back to the default typedatetimecounter format each time Prairie View is started.  To retain the custom folder between sessions, check the 

Preserve UserModified File Names option in the Preferences menu.  Note that using the same folder name in multiple tabs (ZSeries, TSeries, etc.) can cause data to be overwritten if 

counter values are the same on multiple tabs.

The counter is automatically increased by 1 after each acquisition.  The user can change the counter value by typing in the box or using the + and – buttons.  Note that decreasing the 

counter value can result in overwriting data.

2-P	Laser	Control

The right section of the tab contains controls for the ultrafast laser(s) controlled by the software.  If there are multiple lasers controlled through Prairie View, each can be adjusted 

separately by choosing the desired laser from the Laser Selection pulldown menu in the middle of the section. Laser names are set during installation in the Prairie Configuration Utility; 

contact Prairie Technologies personnel before making any changes in the Prairie Configuration Utility.

The Main Power On/Off button displays the current status of the laser’s main power control. Depending on the laser manufacturer, the button may allow the user to control the power; 

some lasers must be turned on/off via a key on the laser itself.  The Shutter On/Off button displays the status of the laser cavity shutter and, depending on laser manufacturer, may be 

used to open and close the laser cavity shutter.

Change the laser wavelength by clicking one of the preset wavelength buttons or typing in the text box below the Wavelength Adjust slider.  The text field to the left of the slider displays 

the minimum allowed wavelength for the laser, while the text field to the right of the slider displays the maximum allowed wavelength for the laser.  These limits are properties of the laser 

and are defined in the Prairie Configuration Utility; contact Prairie Technologies personnel before making any changes in the Prairie Configuration Utility.  The wavelengths included in the 

preset buttons are also configured in the Prairie Configuration Utility.  After selecting a new wavelength, there will be a delay for the tuning to take place and for communication between 

the software and the laser’s control unit.  The user can also adjust the wavelength by clicking in the slider or on the arrows at the end of the slider.  However, due to the delay mentioned 

above, the slider may have a sluggish feel. 

The status of up to four lasers is shown in a table at the bottom of the section.  Note that the power displayed in this table is the power reported by the laser’s internal sensors.  Table 

optics on most systems send only a portion of this power to the microscope.

Some ultrafast lasers configured with a wavelengthextending OPO include an option to bypass the OPO and operate as a traditional ultrafast laser.  For systems configured with these 

lasers, an additional checkbox appears in the 2P Laser Control section to Bypass OPO.  Checking this option will stop the OPO output and pass through 100% of the driving laser’s output; 

when the option is not checked, 80% of the driving laser’s power is sent to the OPO and 20% is used as a traditional Ti:Sapphire laser output.

2-P	Laser	Status

By clicking on the green bar in the center of the tab, the righthand side of the tab will be replaced with the 2P Laser Status section.

This section displays a text readout of the commands and information received from the laser itself.  It is useful for diagnosing errors and checking the status.  The Update button will query 

the laser for the most recent information.

The information displayed in the window can be sent to a text file for printing by clicking Write Laser Status to File.

The XYStage tab allows the user to select and save specific coordinates in the x, y, and z dimensions. This makes it possible to return to locations of interest in the sample and is especially 

useful in setting up complex experiments.

Some systems are configured with two X,Y moving platforms.  For example, a Moving In Vivo microscope may be accompanied by a Specimen Stage.  Prairie View software controls only 

one X,Y platform, configured as the primary X and Y axes in the Prairie Configuration Utility.  The secondary X and Y axes (the other platform) can be controlled by the 3axis knob 

controller, but will not be taken into account when saving X,Y positions in Prairie View software or using the Stage Control section on the main control window.

XY-Stage Tab
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Saved positions appear in the list in the upper portion in this tab and are also available from the dropdown menu in the Scan Control section of the Prairie View main control window.  The 

selected location is indicated by a small arrow in the left column.

Add Current Location adds the current stage and focus position to the list of locations in the table.  Positions can also be added in the Image window by activating the Mark Stage button 

and using the right mouse button to click at the position the user wants to add to the list.

Remove Location erases the currently selected location from the table.

Remove All Locations clears the entire table.

The Goto Selected/Next/Previous Location buttons move the stage to the selected, next, or previous location in the saved locations list, respectively.

Shift Selected Location updates the selected stage location based on the current stage location. When clicked, the selected stage location will be modified to have its coordinates match 

the current position of the stage and Z device(s).

Shift All Locations updates the selected stage location based on current stage location, as described above.  In additions, it updates all other saved stage locations by the difference 

between the old and new position for the current stage location.

The Record Optical Zoom option allows the user to record the current Optical Zoom value at the time when the stage location is added to the table.  The user can then employ different 

Optical Zooms for different locations.  When an XYStage location that includes an Optical Zoom value is referenced (in a TSeries, ZSeries, etc.), the Optical Zoom will be set accordingly.  If 

a stage location does not include the Optical Zoom value, then the Optical Zoom will not change. Record Optical Zoom does not apply to Camera or SFC imaging modes.

Import Locations loads a previously saved list of stage locations; this can also be accomplished via File > Load XY Stage Locations.

Export Locations saves the current list of XY stage locations for later use; this can also be accomplished via File > Save XY Stage Locations

The checkboxes for Invert X and Invert Y allow the user to change the direction moved in X or Y when using the Mark Stage button and mouse clicks on the Image window to move the 

stage. When the Mark Stage button is active, clicking with the left mouse button will move the stage to put the clicked position in the center of the scan.  If the stage moves in the wrong 

direction for one or both axes, change the checked/unchecked status for that axis.  See further description in the discussion of the Mark Stage button in this manual.

Options in the Point Display section allow the user to determine whether and how saved locations are marked in the Image window.  When the overlay is enabled, a marker will appear in 

the image when the user has navigated to a field of view which includes a saved stage location.

The ZSeries and TSeries tabs have checkboxes to perform the given Z or TSeries at all saved XYZ locations.  See more information about these options on in the discussions of the Z

Series and TSeries tabs in this manual.

Grid	Definition

Grid Definition allows the user to define an array of stage positions by setting diagonal corners of the array and defining the overlap of neighboring images.  These positions can be added 

to an existing list of stage locations or used to replace the current list of locations.  The list of locations can then be used to acquire an array of overlapping images to be stitched together 

later into larger mosaic images; this is accomplished using a variety of other software programs.

1.    Set the position of one corner by driving to that location and clicking the Start Position Set button.  The current location will be displayed.

2.    Set the position of the diagonally opposite corner by driving to that location and clicking the Stop Position Set button.  The current location will be displayed.

3.    Define the amount of overlap of adjacent images by typing in the Overlap text box or using the + and – buttons.  The required amount of overlap may vary based on the software 

package used for stitching the images after acquisition.

4.   Use the Add to Stage Locations button to add the plate definition to the existing list of stage locations, or the Replace Stage Locations button to delete the currently saved locations 

and replace the list with the plate definition.
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If the grid of locations will be used to collect a 3dimensional montage, it is suggested that the user set the start and stop positions of the grid using the same Z position.  A ZSeries can be 

defined based on the thickest part of the sample, and the ZSeries can be executed at all saved stage locations from the ZSeries or TSeries tab.  When setting stage locations, keep in mind 

the ZSeries preference to align the saved stage locations to the start or the center of the ZSeries definition.  For example, if stage locations are defined in the center focal plane of the 

sample, set the ZSeries preference to align the saved locations to the center of the ZSeries definition. ZSeries preferences are described elsewhere in this manual.

After a grid has been defined, the Grid Location Display… button becomes active.  When clicked, this button opens a dialog to allow the user to navigate to positions in the defined grid.

Note that the locations and movements calculated by the Grid Definition depend on the currently selected objective and the accuracy of its calibration.  If the currently selected objective 

lens is not calibrated, the Add to Stage Locations and Replace Stage Locations buttons will be disabled.  Also, regardless of the state of the Record Optical Zoom checkbox, the Optical 

Zoom will be recorded when the Add to Stage Locations or Replace Stage Locations button in the Grid Definition controls is pressed.  This is necessary because changing the optical zoom 

after defining the grid locations would invalidate the grid definition with regards to image overlap.

Plate	Definition

By clicking the vertical green bar next to the Grid Definition section, the user reveals the Plate Definition setup pane.  These controls allow the user to generate a list of stage positions that 

correspond to the wells of a multiwell plate.

Set the position of one corner well by driving to that location and clicking the Corner Location Set button.  The current location will be displayed.

1.    Move to the next well along the horizontal axis and click the X (Horiz.) Offset Set button. This move can include a shift in Y and Z, if needed.  The current location will be displayed.

2.    Move back to the Corner Location by clicking the Corner Location Goto button.

3.    Move to the center of the adjacent well along the vertical axis and click the Y (Vert.) Offset Set button.  This move can include a shift in X and Z, if needed.  The current location will 

be displayed.

4.    Define the number of locations in the X and Y directions using the X Positions and Y Positions text boxes or + and – buttons.  For example, a 96well plat would have 12 X Positions 

and 8 Y Positions.

5.   Use the Add to Stage Locations button to add the plate definition to the existing list of stage locations, or the Replace Stage Locations button to delete the currently saved 

locations and replace the list with the plate definition.

If the user can mount the sample plate on the stage so that it is consistently oriented, then it may only be necessary to define the plate locations once.  The definition can then be saved to 

a file and reloaded when needed.  This requires that the stage can be reliably set to a defined position for the corner location.  When initially setting the Corner Location for the plate 

definition, before clicking the Set button, click the 0 button in the Stage Control section of the main control window.  Define the X and Y offsets and positions as above, and replace the list 

of stage locations with the plate definition.  Then export the list of locations to a file.  To perform an experiment on the same type of plate in the future, first place the plate on the stage 

and then position the stage in the same corner that was used when defining the saved plate definition.  Then press the 0 button in the Stage Control section of the main control window. 

Finally, import the saved plate definition.

The Labels tab gives the user the flexibility to define and save a set of operational parameters for imaging control including laser power, PMT settings, channels, and pixel dwell time; 

available parameters vary based on system configuration and acquisition mode.  Each Label is essentially a snapshot of the acquisition parameters, which the user can recall at a later time.  

It is also possible to set up Label Groups for more complicated or multilaser applications.

Labels Tab
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The values for each label created are displayed in the Labels chart.  Each label can have a customized Name for easy identification.  The status of each Channel in a label is shown as True 

for on or False for off.  Additional columns display PMT or camera settings, emission filters, laser slider settings, etc.

Buttons below the Labels chart allow the user to add, update, and delete labels.

Creating	a	Label

1.    Adjust all channel, PMT/camera, laser, and other settings to those intended to be saved in the label definition

2.    Press Add Label; a row named “Label001” with the current settings will be created

3.    To change the name of the label, doubleclick in the “Label001” box and type the desired name

Using	a	Label

To apply the settings of a label, select it from the Label Select dropdown menu in the Scanning section of the Prairie View main control window.  Any subsequent changes to scan settings 

will be automatically applied to the label selected in this menu.  The preferred method for loading a label without saving subsequent changes is to select the desired label from the Label 

Select dropdown menu and then immediately select “CurrentSettings” from the same menu.

To use a label during a TSeries, use the Label button in the TSeries tab to add a Label cycle to the TSeries.  Select the desired label from the dropdown menu in the Resource Selection 

column.  The chosen label will be used for all subsequent cycles, until a new Label cycle is defined.

If the user wishes to change only one or a small number of parameters during a TSeries, a Script may be a more efficient way to make the change.  More information about Scripts is 

available elsewhere in this manual.

Updating	or	Changing	a	Label

Any changes to settings will be automatically applied to the label displayed in the Label Select dropdown menu in the Scanning section of the Prairie View main control window.  Thus, one 

way to make changes to an existing label is to select it from that menu and then make the desired changes to settings.

To change the settings of a current label without selecting it from the dropdown menu, do the following:

1.    Adjust the setting in the appropriate place (for example, an increase in laser power would be done in the Laser,PMT,DAQ tab) 

2.    Click on the label to be updated in the Labels chart, so that the small black arrow appears to the left of the name of that label

3.    Click the Update Label Values button

Label	Groups

Label Groups allow the user to sequentially apply two or more labels during an acquisition.  They are defined in the Label Groups table of the Labels tab.

To create a label group, click the Add Label Group button at the bottom of the Labels tab.  Dropdown menus allow the user to assign existing labels to be labels 1 through 4 within the 

group. Additional buttons below this table allow the user to add and delete label groups.

Once created, a label group will appear in the Label Select dropdown menu of the main control window and will also be available when adding a Label cycle to a TSeries.  When using a 

label group, each acquisition (Single Scan, ZSeries, TSeries repetition, etc.) will be performed sequentially with all the labels in the group.  For example, in a ZSeries with a label group, the 

first slice will be acquired with all labels in the group, followed by the second slice for all labels in the group, etc., until the last slice is completed.  A label group is not used in the following 

acquisitions: Live Scan, a TSeries in which the Max Speed option is enabled, a ZSeries in which the Adjust PMT & Laser option is enabled.

The Misc tab contains controls for several different features of the Prairie View software. Many of the controls are used to control optional features or components of the system.  This 

screen may contain fewer modules depending on the configuration of the system.

Misc Tab
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Photoactivation	Mask

The Photoactivation Mask dropdown menu allows the user to choose a previouslydefined Photoactivation mask to be applied to all Live Scans, Single Scans, ZSeries, and WSeries.  Only 

masks valid for the current scan settings (image size and dimensions) will appear in the list of saved masks.  Photoactivation masks are discussed elsewhere in this manual.  The selection 

does not apply in SFC, Resonant, or AOD mode.

Background	Image

A Background Image can be saved to use as a subtraction mask from the signal generated in a scan. The intensities of the background image will be subtracted from the intensities of any 

new images when enabled.  A background image is stored by pressing the Record Background Image button and will be used until replaced or the program terminates.  To use background 

subtraction, check the Subtract box and specify the percentage of the background image to subtract.

Actions	to	Perform

Actions previously defined in the Actions dialog can be selected for use as before scan, after frame, and after scan events.  For information about defining Actions, refer to the Actions

section of this manual.

Utility	Buttons

Utility Buttons can be configured in the Misc tab of the Prairie Configuration Utility and determine the state of up to 8 digital output switches within the GPIO box.  The states of these 

switches can be sensed by external equipment.  The name of the button and the text that appears when the button is on or off can be defined in the Prairie Configuration Utility.  Only 

those utility buttons which have been enabled in the Prairie Configuration Utility will be displayed.  Additionally, cabling must be present inside the GPIO box to route these signals out to 

the user.

Dodt	Detector

The Dodt Detector section controls the Dodt gradient contrast detector, if one is configured. When the Dodt mirror is In, the lamp house will automatically turn off to protect the Dodt 

PMT from being saturated.  Filters can be placed before the mirror to filter light being sent to the PMT.  There are two filter positions.  The Dodt detector has no acquisition capabilities in 

SFC mode, but the controls remain active in this mode to allow the user to move the mirror and filters out of the way when using the transmitted light lamp house.

Secondary	Laser	Beam	Routing

The Secondary Laser Beam Route feature is a TTL level signal that is intended to drive a switch for systems that have two 2P lasers, where the second laser can be used as an imaging laser 

or as an uncaging laser.  This feature is enabled/disabled and configured during installation within the Prairie Configuration Utility.  This signal may be configured to use a digital output line 

from any of the National Instruments DAQ boards.  This parameter is part of a Label definition, allowing the operator to create labels that use either just one laser or potentially both 

lasers. This also allows the operator to control the routing of the second laser for use in Imaging/Photoactivation masks and Mark Points experiments (e.g. First image using both lasers, 

then via a label, change the routing of the second laser, then use Mark Points, and so on).

Custom	Outputs

The Custom Outputs section specifies custom waveforms which will be synchronized with each line of an acquisition.  When enabled, outputs are applied during all scans.

To be available in Prairie View software, Custom Outputs must be enabled in the Prairie Configuration Utility.  Additional cabling must be put inside the GPIO box.  Contact Bruker 

Fluorescence Microscopy support personnel for assistance with this feature.  Depending on hardware and system configuration, up to eight custom outputs can be defined.

Once enabled, a Custom Output will appear in the Prairie View Misc tab.  Turn on the Custom Output by checking the box next to its name.

To define a waveform for a Custom Output, select it by clicking the name of the output in the list, and click Edit Selected Waveform... to open the Custom Output Waveform editor dialog.
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Fill in the table on the right side of the window to define the output.  Entries in the Value column are scaled based on the parameters defined in the Prairie Configuration Utility.  Buttons to 

the right of the table allow the user to move a selected row up or down in the table, delete the row, and delete all rows.  

The custom outputs are synchronized with each acquisition and are adapted to the current line period.  Waveforms are defined as a value for a certain percentage of the line period.  A 

waveform defined as 100% of the line period would occur once every line.  One defined as 50% would occur twice every line, while one defined as 200% would occur once every two lines. 

Limitations are put on the total percent such that it divides evenly into 100 or is a multiple of 100 so that all custom outputs can share a common clock.  Therefore, it is not possible to 

define a waveform that occupies 75% of the line period, but it is possible to define a waveform that occupies 300% of the line period and simply repeats the 75% waveform four times.

Note that the scanline period (on which the custom output is based) includes the retrace time of the galvanometers, when the move from the end of one line to the start of the next line.  

This means that an output defined to use 50% of the scan line at one value and 50% of the scan line at another value will not change states in the center of the image, but instead will 

change closer to the left side of the image.  Retrace time can be calculated by multiplying the number of pixels per line by the dwell time per pixel, and subtracting that value from the 

scanline period; the retrace time occurs at the start of the line, before the scan reaches the first pixel of the line.

The Save As… and Load… buttons below the table allow the user to save and load waveform definitions.  Click Accept to accept the current definition and close the dialog, or Cancel to 

close the dialog without saving changes.

The Synchronize with Linescans checkbox is used to automatically program a custom output for use with the 3D Linescan feature.  This feature is described in the Line Scan section of this 

manual. 

Custom outputs can also share the same physical output line as a laser. In such cases when the custom output is enabled it overrides the laser control. Disabling the custom output will 

return control to the laser slider.

It is also possible to configure a Custom Output to produce a waveform based on a drive signal from a BOT (Brightness Over Time) region, to turn intensity data into an analog signal.  This 

is option is set up in the Prairie Configuration Utility.

In Spiral acquisition mode, the entire frame is acquired in one line.  Thus, the line period is the same as the frame period, and Custom Output definitions are based on a percentage of that 

period.  Custom outputs are not applicable in SFC mode.

Helios	ND	Filters

On systems configured with a Helios Laser Launch, a dropdown menu allows the user to choose a neutral density filter inside the launch.  These filters reduce the amount of laser power 

from the launch and allow finer control of power using the laser power sliders in the Laser, PMT, DAQ tab.  Use the Configure button to open a dialog which allows the user to define a 

name for the launch.

Images acquired are displayed in Prairie View Image Windows.  Up to 8 Image windows may be open at one time.  Each Image Window is identified by a label in the banner section with a 

number e.g., “Image Window – 1”. All open windows will be updated when Live Image or Single Scan is clicked.

Some consideration should be given to the number and size of active Image Windows, as the system may become sluggish when attempting to update too many windows simultaneously.

Located on the left and right sides of the Image Window are buttons for many controls and applications, described in detail in subsequent sections of this manual (note that not all controls 

are available in all acquisition modes).  Additional applications and controls can be accessed via the Applications menu.

� Ch1/Ch2/Ch3/Ch4:  The channel buttons indicate which input channel is being used to collect data for that Image window; button names may be configured differently on some 

systems

� BOT (Brightness Over Time):  Used for measurement of average pixel intensity of userdefined regions to be monitored over multiple images

� Line Scan:  Used for definition and acquisition of a Line Scan

Image Window Overview

Page 29 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm



� Point Scan:  Used for definition and acquisition of one or more Point Scans

� PA (PhotoActivation):  Used to define masks to limit laser exposure to certain areas

� Mark Points:  Opens a dialog to set up a Mark Points experiment

� Spiral PA (Spiral PhotoActivation): Opens a dialog to set up a Spiral Activation experiment

� MIP (Maximum Intensity Projection) :  Displays the maximum intensity profile for a stack of images; the button is only active when playing back a ZSeries

� Mark Stage: Allows the user to add stage locations (x,y,z coordinates) to the list of saved positions

� Plane Scanning: Define and scan a cutplane from a ZSeries

� XZ/YZ: Scan in a plane or curtain vertically through the sample

� LUT (Look Up Table):  Used to adjust the display intensity scale for an image

� ROI (Region of Interest): Used to define a region of interest to acquire a portion of the full field of view

�  (Snap): Saves the image currently displayed in the image window

�  (Line Profile):  Used to display intensity values and distance measurements over a line

� Ratio: Displays an image as the ratio of intensities between a pair of channels

Additional buttons on the right side of the Image window allow the user to adjust the displayed image.  Zoom buttons scale the contents of the window and to open additional Image 

windows. Unlike the buttons in the Image Window Size section of the main control window, scaling changes applied in an Image Window do not affect the display in other Image Windows.

� Zoom In increases the image size by ~10%; the image can continue to be increased by clicking the button repeatedly

� Zoom Out decreases the image by ~10%; the image can continue to be reduced by clicking the button repeatedly

� Zoom Fit is resizes the image to 512 pixels in width; if the image window is increased or decreased in size, the display will be scaled proportionally to fit in the new window

� Zoom 1:1 shows the image at its actual size as defined by the acquisition settings

� New Window opens an additional Image window

� Freeze Window freezes the current contents of that Image window.  When activated, the background of the button will change from grey to green.  Data acquisition continues, but 

new images are not displayed in the frozen window.  All channels in all other Image windows will continue to be updated and displayed.  To unfreeze the window, click again on 

the Freeze Window button to deactivate it.

� Overlay controls allow the user to adjust any overlays drawn on the image window. These include scale bars, masks, lines, and other objects.  Use the Show/Hide button to make 

all overlays appear or disappear.  Adjust the transparency of all overlays using the vertical slider.  Clicking the colored rectangle and/or Font buttons below the slider allows the 

user to change the font and color used in overlays.

Along the bottom of the Image Window are descriptions of the image being shown.  From left to right, these are:

� The pixel position of the cursor within the frame

� The intensity value (grey level) of the pixel in each of the four acquisition channels 

� A description of the interpolation method used

� The length of the last line drawn with the Line Profile tool

The top four buttons on the lefthand side of the Image Window indicate which input channels are to be displayed in that window.  Up to four input channels are available at one time.  To 

activate a channel, click on the corresponding channel button.  The background of the button will change from grey to green.

For most systems, these channels generally correspond to PMTs.  By convention, Ch 1 represents PMT 1 on the Prairie View main control window, Ch 2 represents PMT 2, etc. Substage 

PMTs may share an acquisition channel with the upper PMT corresponding to the same detection color.  In SFC mode, these channels correspond to the channels to which lasers are 

assigned in the Laser,PMT,DAQ tab of the Prairie View main control window.

Channel	Display	Color

To select a display color for a channel, click the color label to the right of the channel button and a dialog with color choices will appear.  Multiple channels can be displayed in the same 

image window with different colors.  The Pseudocolor option applies colors based on pixel intensity. The Range Check option displays the image in grayscale, with any saturated pixels in 

red and any pixels of less than or equal to zero intensity in blue.

Input Channel Buttons
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Channel	Menu

Right clicking on a channel button will bring up a context menu with several options specific to that channel.

� Set Channel Color brings up the Channel Colors dialog described above.

� Freeze Channel stops update on that channel in all Image windows.  When a channel is frozen a snowflake icon appears on the channel button and the channel will no longer be 

updated in any Image windows during any acquisitions.  The frozen channel data will continue to be displayed.  To unfreeze a channel, simply right click on the frozen channel and 

select Unfreeze Channel.  

� Automatically Adjust Lookup Table Levels adjusts the display parameters for the channel to maximize the contrast of the current image in the display.  This is not a continuous 

adjustment, but rather an instantaneous one using the current frame’s channel data.

� Reset LookUp Table Levels moves the display cutoffs back their minimum and maximum values.

� Set Channel Source allows the user to choose the source of data for the channel on systems configured with more than 4 input channels.  These systems have multiple 

Preamplifiers.

� Cancel closes the context menu without making a selection. 

BOT is used to measure image areas for pixel intensity over time. This feature can be used on active image collections and previously collected datasets in Playback Mode.

Brightness Over Time
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Graph	Options

Along the right hand side of the graph window are controls for the graph display. There are separate controls for both the horizontal (x) and vertical (y) axes.  Both axes can either be scaled 

as Best Fit (an automatic scale) or Fixed.  Best Fit will adjust the visible values as necessary according to the data set, while Fixed will be limited to the values entered in the Maximum and 

Minimum fields for each axis.

For the horizontal scale units, the operator may select from Seconds or Frames. The vertical axis is set to display intensity values.

Located below the horizontal and vertical scale controls, Show Average For allows the operator to choose how many frames to average for each data point.

Save Graph will save a TIFF of the current graph.

Region	Options
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There are four different shapes that can be used to create BOT regions: Ellipse, Rectangle, Polygon and Brush.  Using the mouse, the operator can sequentially add regions for analysis.  To 

add a region, choose the desired shape and use the mouse to draw the region on the Image window.  To finish a polygon, use the right mouse button to connect the clicked coordinate to 

the first segment of the polygon.   If there is more than one channel active on the image window when a region is created, an identical region is created for each active channel.

The Brush option offers six different sizes for freehand region creation: Tiny, Small, Medium, Large, Huge and Custom.  When Custom is selected, the user can define the size of the 

brush .  

Once a region is created, there are several options for manipulating the position:

When Move All is selected, all of the regions will be shown in the selected highlight color of cyan.  Place the cursor over any region number in the Image window so the hand cursor is 

shown, click and hold the left mouse button, and move the mouse to move all of the regions. Release the left mouse button to fix the regions in the desired locations.  As soon as the 

mouse is released, Move All is turned off.

Right Click To offers three different manipulations.  The user can choose to Resize, Rotate or Clone a region by selecting the desired change, hovering over the desired region, and right

clicking.  For Resize and Rotate, the user must rightclick and hold down the mouse button until the region is the desired size or orientation. If Clone is selected, then by rightclicking on a 

region number, an exact copy of the region can be made, including size, location, and associated channel.

A single region can be moved only when Move All is off (not highlighted).  The cursor will automatically turn into a hand cursor when hovered over a region number.  This indicates that 

particular region can be selected.  Click and hold the left mouse button to select the region and move it to the desired location.

Brightness	Over	Time	Regions

Each region created on the Image is described in a table below the graph. There are several columns of information specific to each region:

���� Display?: The user can choose which region's information to show on the graph by checking or unchecking the box to the left of the region number.  Each region number is shown 

with a background color representative of the graph line created for that region. This option can be toggled both before and after data is acquired.

���� Channel:  Denotes the channel to which the region pertains

���� Measurement:  Allows the user to choose whether the mean or standard deviation of pixel values is collected for each region

���� Position:  This number is representative of the top lefthand corner of the region.  For ellipses, polygons and brush shapes, this is the top left location of the bounding box that 

would encompass the shape.

���� Width:  The x value of the rectangle or bounding box

���� Height:  The y value of the rectangle or bounding box

���� Area:  The complete area covered by the shape (not the bounding box)

���� Rotation:  If a region has been rotated, the degrees of rotation from the original position will be noted

� Shape:  Denotes the shape tool used to create the region

In the righthand corner of the table, the operator can choose to display the size measurement values for the regions in either pixels or um (microns).  When um is chosen, the 

computations are based on the currently selected objective lens.

Basic	Region	Math

If the operator clicks the right mouse button over any of the defined regions in the region table, a popup menu will appear that will allow the operator to very quickly set up some basic 

region math to modify the analyzed shape. This could be simply specifying that region 2 should be subtracted from region 1, or possibly subtract region 2 from all other regions.

When a mathematical relationship is defined via the popup menu, the region name will indicate the relationship. If the relationship is defined as subtracting region 2 from region 1, the 

label in region 1 would change from '1' to '12'.

If Region Alone is selected in the popup menu, then any defined mathematical relationship for that region will be removed.

All Alone will remove all previously defined mathematical relationships.
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Other	Ways	of	Generating	Regions

The Import Regions and Export Regions buttons below the table of regions allow the operator to save a set of region definitions to a file for recalling later. This could be useful if the 

operator wishes to use consistently sized regions over multiple data sets.  The user could save a set of regions using the Export Regions button and then when a new data set is loaded, use 

the Import Regions button to load the regions. The region locations could then be manually set where desired.

The Import From PA button brings up a dialog to allow the user to import masks drawn as Photoactivation masks for use as BOT regions.

The Generate button allows the user to call previously saved Actions to autodraw regions.  For more information about actions, see the Actions subsection in the Tools section in this 

document.

The Remove Region button deletes the selected region from the table, whereas Clear Regions will clear all regions from the table.

Region	Groups

To create a Region Group, first create the regions in the Image window via the Create Regions As panel.  Next, place a check in the box next to the region number in the Display? column 

for each region to be included in the region group.  Uncheck any regions to be excluded from the group.  Now press the Create Group button and a group will be created that consists of 

the specified regions.

To change a group definition, first check/uncheck the desired regions in the region table.  Then select the desired group by left clicking on the group to highlight it.  Press the Update Group

button and the group definition will be changed accordingly.

Remove Groups and Clear Groups will delete selected or all groups, respectively.

By clicking on the checkbox next to the group number, the user can alter what region graphs are displayed.

Region	Functions

Located below the Region Groups is a set of controls for Regions Functions.  This section allows the user to create graphs that are mathematical manipulations of the data from one or 

more defined region.  This is in addition to the predefined mathematical options presented by right clicking the mouse over a region definition as outlined above.  Region Functions will 

display as new graph data.

To create a Region Function, click on the Create Function button; the button will turn green to indicate that this mode is activated.  To exit this mode without actually entering a formula or 

equation, simply click on the Create Function button again.

Activating the Create Function button will activate a control below the buttons that allows the user to select from a list of predefined mathematical functions (e.g. f/f0).  Also activated is a 

control below the list of functions that allows the user to modify the predefined equation, or to enter a custom equation.

Located just below the control/field where the equation is shown is a string shown in blue that reads 'Need help with function syntax?'.  Clicking on this string causes a help dialog to 

appear with additional information about the proper syntax for the mathematical functions.

Some sample equations are as follows:

Instead of looking at the average intensity of a region over time (standard graph of a region), the user may want to see the relative change in the region intensity information over time.  

That is, the user wants to look at the difference between the intensity values from one frame to the next.  If the region of interest was region 2, the equation would be {2}  {2:1}.

Many standard mathematical functions are available by using the following syntax: Math.Log(), Math.Min(), etc.  For example, to compute the logarithm for the data in region 3, the syntax 

would be Math.Log({3}).  To generate the absolute value of subtracting the value of region 1 from region 2, the syntax would be Math.Abs({2}  {1}).

Saving	BOT	Data

Each BOT acquisition is saved in its own folder.  The location of the folder is determined by the Save Path, which can be viewed or changed by clicking the ... button next to the Save Path

box. The name of the folder is the name displayed in the text box next to the ... button, followed by the number displayed in the iteration counter text box.

The default folder name includes the type of acquisition and the date and time code for the last time the software was loaded.  The user can type a custom name in this field for the 

current session.  The folder name will revert back to the default typedatetimecounter format each time Prairie View is started.  To retain the custom folder between sessions, check the 

Preserve UserModified File Names option in the Preferences menu.  Note that using the same folder name in multiple tabs (ZSeries, TSeries, Misc, etc.) can cause data to be over

written if counter values are the same on multiple tabs.

The counter is automatically increased by 1 after each acquisition.  The user can change the counter value by typing in the box or using the + and – buttons.  Note that decreasing the 

counter value can result in overwriting data.

When viewing or performing a BOT measurement of a previously acquired data set in Playback Mode, additional buttons appear for saving data.  Save Changes will save the current 

regions, definitions and data in place of the original data set.  Save Changes As will create a new set of files with the current regions, definitions, data, and a screenshot of the current 

image window in the same directory as the original file.  This includes creating a new .xml file that is associated with the defined regions so different sets of regions, definitions, and data 

can be recalled for the same data set.

Acquisition	/	Analysis

Press Start to begin collecting BOT data on a new acquisition.  BOT measurements can also be performed on previously saved data by performing the BOT while in Playback Mode.  To 

update the graph when in playback mode, create/edit the regions and press Start.  The program will cycle through the current data set and generate the graph of data.

By checking Start with Input Trigger, the user can set up a BOT measurement to begin when a TTL trigger is received from external equipment.

BOT Experiments can be synchronized to run alongside a Voltage Output, Voltage Recording, and Mark Points experiment by selecting the appropriate experiment from the drop down 

menus to the left of the Start button.  For more information on these experiments, see their respective sections in this document.

BOT	within	a	T-Series

A Brightness Over Time experiment can be embedded in a TSeries by checking the BOT box in the desired cycle.  See the TSeries Tab section of this manual for more information about T

Series experiments.

Files	Created	by	the	BOT	Experiment

Running a BOT experiment creates a directory in the location specified by the file path in the BOT window.  In this directory are the files that contain the definition of the experiment along 

with the results from the experiment.  First and foremost, the directory contains a configuration file, which has a name ending in Config.cfg, that lists every microscope setting and its value 

at the beginning of the BOT experiment.  Additionally, within the References subdirectory, an image is saved that contains anything that was in the image window at the beginning of the 

BOT experiment, including the image itself, along with any overlays, such as the BOT regions.  Next, there is a Brightness Over Time XML file which defines the BOT experiment.  Here you 

will find the definitions of any regions, groups, and functions, along with imaging parameters and timestamps. In addition, an image of each frame in each channel that was part of the BOT 

experiment is saved in the directory.  Finally, a commaseparatedvalue file is saved containing the timestamp of each frame along with the region measurement at that frame.  Optionally, 

if Voltage Recording, Mark Points, or Voltage Output was synchronized with the BOT experiment, their corresponding files will be present in this directory.  See the appropriate sections in 
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this manual for information on these files.

The Linescan Control dialog opens when the user clicks the Line Scan button on an Image window.  This window is used to define a onedimensional acquisition along a userdefined line.

The Linescan Control window is divided into three main sections.  The top section contains controls for the user to define the acquisition.  The middle section of the window allows the user 

to define profiles to display intensity data in a graphical format; reveal this section by clicking the Profiles button in the upper control section.  The bottom section of the window displays 

the acquired data as an image.  These sections are described in detail below.

Defining	a	Line	Scan

Parameters	of	the	Definition

The user can choose to define the Number of Lines or the Acquisition Time for the scan; the other value is calculated automatically by the software.  Use the Define and Calculate radio 

buttons to select which parameter text box to activate.

Line Period is based on the line defined by the user and the current scan settings defined in the main control window.

The Pixels/Line field displays the number of pixels scanned in the current definition.

During a line scan, the system will repeatedly scan the defined line.  If the user wants to collect intensity data less frequently, a number of Lines to Skip can be defined.  This number must 

be an integer.  Scanning continues during these skipped lines, but laser power is set to minimum levels.  For example, if the user sets the Number of Lines to 200 and the Lines to Skip to 1, 

the system will scan the line 400 times but only apply laser power and collect data every other line. The Line Period field will update to show the time from the start of one acquired line to 

the start of the next acquired line (taking into account the time for skipped lines).

The user can define a number of Repetitions for the experiment, and define a Period for those repetitions.  For example, 3 repetitions with a period of 10 seconds would perform the 

defined number of lines 3 times, with 10 seconds between the start of the first repetition and the start of the second repetition.  Leave shutter open determines whether the hard shutter 

will be closed between repetitions (if not checked), or left open until the entire acquisition is complete (if checked).  The Total Acquisition Time field will update to display the amount of 

time acquiring data and waiting between acquisitions for the defined period.

For some line types (described below), the user can check the box to enable the Scan continuously option.  The line will be scanned in both directions; essentially, the defined pattern will 

be mirrored back on itself.  For example, if the user draws a Freehand line 500 pixels long and checks Scan continuously, the scanned line will be 1000 pixels long, where the scan will go 

from start to end to start as one line.  If the user selects a Sprial line, the scan will go from the outside to the center and then back from the center to the outside.  The Line Period and 

Acquisition Time fields will be updated to reflect the new scan parameters.  Note that Line Period does not double when checking Scan continuously, as there is no retrace time in a 

continuous scan.  This option is automatically checked for Circle and Lissajous modes, and is not available for Line mode.

Line	Type

The Line Type dropdown menu allows the user to choose the type of line to be scanned.

� Straight Line defines a horizontal line across the image.  The two vertical bars define the portion of the line that is acquired.  Reposition the line vertically on the image by dragging 

either of the outer boxes on the Image window.  Change the lateral range of the acquisition by dragging the two inner vertical bars.  This is the only type available when using the 

Resonant Scanner or AOD to scan the sample.  Use the Scan Rotation controls in Galvo mode to change the orientation of the sample relative to the horizontal line on the Image 

window.

� Circle defines a continuous circular scan pattern.  In the Image window, left click and drag in the square markers to change the size and position of the circle.  The first pixel of the 

Line Scan
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circle is indicated by an arrow head marker, which also indicates the direction of the scan.

� Freehand allows the user to define a custom line.  Click and drag the left mouse button in the Image window to draw the line; hold shift to make straight segments.  A green box 

marks the start of the line, and a red box marks the end.  Click the left mouse button in either of these boxes and drag to extend the line.  Click the right mouse button in either of 

these boxes to move the line.

� The speed and accuracy of a Freehand line is limited by the response of the galvanometers scanning the line.  Tight corners will be followed more closely at slower dwell 

times and higher pixel densities.  To prevent overdriving the galvanometers, a Minimum Freehand Dwell Time parameter is defined in the Scan Settings.  This parameter is 

defined at a 512x512 image size and scaled accordingly for other image sizes.  The Line Period and other fields account for this minimum during setup.  Additionally, if the 

user defines a Freehand line with a dwell time below the minimum time, a message will appear in the information box on the right side of the window to indicate that the 

dwell time was temporarily increased.  The parameter is set during installation; contact Bruker Fluorescence Microscopy support personnel for assistance or to request 

changes to the setting on the system.

� Action(s) allows the user to import Freehand line definitions from external software programs, such as MatLab.  See more information about Actions elsewhere in this manual, and 

contact Bruker Fluorescence Microscopy support personnel for more assistance.

� Spiral defines a spiral pattern over the image.  Two additional controls allow the user to define the spiral.  The Shape slider adjusts the shape of the pattern, with 1.0 being a 

circular spiral and smaller values making the scan more of a square shape.  The Spirals slider adjusts the number of spirals, affecting the length of the line and the density of the 

scan.  The Minimum Freehand Dwell Time parameter (described above) also applies to Spiral line scans.

� Lissajous is another continuous pattern.  The Freq slider adjusts the density of the pattern.

Click the Save… button to save the defined line, which can be recalled again later by clicking the Load… button.

Collecting	the	Line	Scan

Click Start Linescan(s) to start the acquisition.  The message box in the upper right corner of the window will update to show the status of the acquisition.

Each Linescan acquisition is saved in its own folder.  The location of the folder is determined by the Save Path, which can be viewed or changed by clicking the ... button next to the Save 

Path box.  The name of the folder is the name displayed in the text box next to the ... button, followed by the number displayed in the iteration counter text box.

The default folder name includes the type of acquisition and the date and time code for the last time the software was loaded.  The user can type a custom name in this field for the 

current session.  The folder name will revert back to the default typedatetimecounter format each time Prairie View is started.  To retain the custom folder between sessions, check the 

Preserve UserModified File Names option in the Preferences menu.  Note that using the same folder name in multiple tabs (ZSeries, TSeries, Misc, etc.) can cause data to be over

written if counter values are the same on multiple tabs.

The counter is automatically increased by 1 after each acquisition.  The user can change the counter value by typing in the box or using the + and  buttons.  Note that decreasing the 

counter value can result in overwriting data.

A reference image is saved along with the line scan acquisition.  The reference image is a TIFF image of the contents of the Image windows, with any overlays (including the defined line) 

currently displayed on the image.  The channels active in each Image window will be listed in the name of the corresponding reference images.

Each defined Repetition will be saved as a separate file in the folder for the current line scan data set.

The Append Linescan(s) button starts the defined acquisition but does not start a new dataset. Instead, the acquisition is treated as one or more additional repetitions in the previous 

acquisition, reflected in the acquisition count messages in the message box in the upper right corner of the window.

When the Update display box is checked, newly acquired intensity data will be displayed in the bottom section of the Linescan Control window.

When the Open in playback mode box is checked, newly acquired intensity data will be displayed in the Image window(s) at the end of the acquisition.  Some features of Linescan Profiles 

(described below) are available only in playback mode.

Triggered	Line	Scans

A Line Scan can be started on its own as described above, or set to respond to input triggers from other equipment.  Triggering options are selected via a dropdown menu in the Linescan 

Control window.

If No Input Trigger is selected, then the acquisition will start immediately when the Start Linescan(s) or Append Linescan(s) button is pressed.

If Trigger First Rep. is selected, then after Start or Append Linescan(s) is pressed, the Laser and PMT settings will be set, the hard shutter will open, and the software will wait for the arrival 

of an external input trigger before acquiring the first repetition.  All subsequent repetitions are acquired automatically.

If Trigger Each Rep. is selected, then after Start or Append Linescan(s) is pressed, the Laser and PMT settings will be set, the hard shutter will open, and the software will wait for the arrival 

of an external input trigger before acquiring the first repetition. This process is then repeated for each subsequent repetition in the defined acquisition.

Triggers sent to the Prairie system should be 5V TTLstyle signals on a BNC cable.  If the system is configured with a GPIO box, input triggers are received by the Trig 1 In through Trig 8 In 

connections in the middle row on the front on that box.

Synchronizing	Functions	With	Linescan

It is possible to synchronize Voltage Recording, Mark Points, and Voltage Output experiments with a line scan acquisition.  The Voltage Recording, Mark Points, and Voltage Output

experiments are configured in their own control windows; more information is provided elsewhere in this manual.  The synchronization with the line scan is defined in the Synchronize with 

Options Below section of the Linescan Control window.

The dropdown menu next to Synchronize with Options Below allows the user to choose when the synchronized experiments run:

� Don't Synchronize means that no Voltage Recording, Mark Points, or Voltage Output experiments will be called from the Linescan Control window

� Once at Start means that the synchronized experiment(s) will be started along with the first repetition of the line scan

� Each Repetition means that the synchronized experiment(s) will be started at the start of every repetition of the defined line scan acquisition

After a synchronization option is chosen, the experiment selection options become active.  Use the dropdown menus to select the Current or previously saved experiment for Voltage 

Recording, Mark Points, and/or Voltage Output.

Checking the Adjust Voltage Recording Time changes the acquisition time of the selected Voltage Recording experiment to match the time required for the line scan and synchronized 

Voltage Output and/or Mark Points experiments. 

The Total Acquisition Time field will be updated to reflect the duration of the line scan including the synchronized experiment(s).
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It is recommended that a user make a global decision on where to configure Voltage Recording and Voltage Output experiments for a given line scan acquisition.  It is possible to configure 

a Mark Points experiment that calls a Voltage Recording or Voltage Output experiment from inside the Mark Points configuration.  If using this option, it is not advised to also call Voltage 

Recording or Voltage Output from the Linescan Control window.

Synchronized Voltage Recording and Voltage Output experiments will start as defined in the Linescan Control window and not wait for any trigger defined in the Voltage Recording or 

Voltage Output windows.  Mark Points experiments will override a trigger on the very first point of the experiment (first point of first repetition of first line), if defined, but will respect all 

other triggers defined in the Mark Points Series. 

More information about Mark Points, Voltage Recording, and Voltage Output can be found in other sections of this manual.

Z	&	Laser(s)	Control

The controls in this section allow the user to drive a Zpiezo device during a line scan acquisition. The goal is to collect intensity data from a volume in the sample at higher speeds than are 

possible when performing a ZSeries with traditional raster imaging.  Alternatively, highspeed volume imaging can be carried out using the ZSeries feature with a Zpiezo and Resonant 

Scanner or AOD.

This feature requires specific hardware and software configurations which must be implemented by Bruker Fluorescence Microscopy personnel.  Additionally, analysis and reconstruction 

of position and intensity data must be carried out using thirdparty software tools.  Contact Bruker Fluorescence Microscopy support personnel for more information about this feature.

In this mode, the galvanometers are driven along a userdefined path defined as a Freehand, Spiral, or Lissajous line, while the Zpiezo device is driving in a sinusoidal pattern by analog 

signal control.  Laser power can also be adjusted as a function of depth.

The intended data acquisition method for this type of scan is to record position and intensity signals on analog inputs in the Voltage Recording window, for reconstruction and analysis later 

in other software packages.  Positional information is obtained by recording feedback signals from the X and Y galvanometers and the Zpiezo device.  Intensity data is acquired by routing 

the Preamplifier output signals to Voltage Recording inputs (rather than to the typical Preamplifier inputs used for other imaging).

A Custom Output must be defined for the Zpiezo drive signal, and an additional Custom Output must be defined for each laser to be synchronized with the acquisition.

Define a Voltage Recording experiment to collect analog signals routed from the X and Y galvanometer feedback, Zpiezo feedback, and Preamplifier signal(s) for the channel(s) from which 

intensity data will be acquired.  Choose a sampling frequency (Samples/Second) appropriate for the data resolution needed in the analysis.

Define the Z range and laser power gradient by defining a ZSeries in the ZSeries tab.

In the Z & Laser(s) control section of the Linescan Control window, configure the synchronization of Z and XY control with the following parameters:

Check the Synchronize Z & Laser(s) box.  Lines to Skip parameter of the line scan definition will be automatically set to zero.

Save Linescan Images can be checked if the user wishes to save the image segments generated in Prairie View software during the 3D acquisition.  Intended operation will leave this option 

unchecked, as Prairie View does not reconstruct the 3dimenstional data acquired, and both the intensity and positional information must be recorded through Voltage Recording and 

reconstructed using other software packages.  Thus, saving the images takes up disk space with files which will not be used.

Lines per Z Period is the number of XY line scan traces that should be executed for each Z period.  One Z period is movement of the Zpiezo device from its start to stop position and back 

to its start postion.

Piezo Lag Time allows the user to define the time difference between the application of the drive voltage to the piezo and the piezo achieving the intended location.  The parameter is 

associated with and saved as part of the calibration for the currently selected Objective Lens.

Synchronize the Voltage Recording experiment to run with the line scan acquisition, and check the box to Adjust Voltage Recording Time.

Start the acquisition by clicking Start Linescan(s) or Append Linescan(s).

Profiles

Line Scan Profiles allow the user to define regions of the line from which to plot intensity data in a graph during acquisition.  Intensity data from these plots is saved as a CSV file in the 

directory containing the line scan data.  Click the Profiles button in the Linescan Control window to reveal the profile definition section of the window.

To define a profile, check the box for one or more channels and click the Create button.  One definition will be created for each channel whose check box was activated.  Then drag the 

Position and Width sliders to adjust the definition of the profile.  The profile definition(s) will be displayed in the list box below the definition controls.  The name of the profile reflects the 

channel, position, and width information for the profile, and a colored rectangle indicates the color of the trace and the overlay used to display the profile.  The profile definitions are 

displayed along the line on the Image window and overlaid on the data displayed at the bottom of the Linescan Control window.

Within the list of profiles, the currently selected definition will be displayed with a green background behind the text.  Any changes to the Position and Width sliders will be applied to the 

currently selected definition.

A dropdown menu allows the user to define whether the intensity information recorded is the average or sum of the pixels encompassed by the profile definition.  Buttons in the interface 

allow the user to Remove the selected profile or Clear All profile definitions. 

During acquisition, intensity information for each profile is plotted in the graph within the Linescan Control window.  Clicking the green bar above the graph reveals controls for zooming 

and panning within the graph display.

Profiles can be moved by clicking and dragging the position of the colored markers in the Image window or in the data display at the bottom of the Linescan Control window.  The rectangle 

marking the profile definition will move to the new location defined by the user.  Dashed lines in the same color will mark the original position of the profile, corresponding to the trace still 

visible in the Profiles section of the window.

If the user is viewing the line scan data in Playback mode, moving a profile definition will cause the intensity graph to be recalculated.  The user can save the new intensity plot data by 

clicking the Save CSV button.  If the user is not viewing the data in Playback mode, the intensity graph will not be recalculated, but the new profile position will still be used in subsequent 

acquisitions.

Profile data can also be displayed in the Voltage Recording window.  Defined profiles will appear as buttons next to each Voltage Recording plot.  This allows users to overlay intensity data 

with electrical recordings that were synchronized with the collection of the line scan.  Note that the Previous, Average, and History display options will be applied to line scan profiles 

acquired with a Voltage Recording, but not to standalone line scan acquisitions. 

Data	Display

Intensity data for each channel is displayed as an image in the bottom section of the Linescan Control window.  The horizontal axis is the position along the acquired line.  The vertical axis 

is the line number, which can be interpreted as time.  Each channel active during the acquisition is displayed.  A scroll bar on the right side of the window allows the user to view more of 

the data without expanding the window.
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The user can get information about a particular pixel in the displayed data by hovering the mouse over that pixel.  Information boxes at the bottom of the Line Scan window display the 

position of that pixel along the line (X) and the start time (T) for that trace of the line, as well as the intensity of that pixel in each channel.

Click the left mouse button on the displayed data to display a vertical yellow cursor.  A yellow box will appear on the Image window showing the position of this pixel on the reference 

image. These yellow markers can be used to correlate locations along the defined line scan with intensity information from the acquisition.  The user can reposition the yellow markers by 

clicking elsewhere in the data display or dragging the yellow box in the Image window.

The position and width of any defined profiles are displayed on the image(s) as colored rectangles corresponding to the color used in that profile's definition and trace.  To move a profile 

to a new location for the next acquisition, click and drag the rectangle in the data display at the bottom of the Linescan Control window.  The rectangle marking the profile definition will 

move to the new location defined by the user.  Dashed lines in the same color will mark the original position of the profile, corresponding to the trace still visible in the Profiles section of 

the window.

Long acquisitions are broken into multiple files during acquisition and reconstructed at the end of the scan.  In these cases, only the last portion of the acquisition will be displayed in the 

Linescan Control window.  To see the entire data set in the Image window, open the file in Playback Mode.  This will happen automatically after any acquisition where the Open in 

playback mode option is checked; otherwise, load the data set from the File menu.

The point scan feature of Prairie View allows the user to plot the intensity of multiple pixels in the image as a function of time. By selecting points in the image and setting some of the 

parameters accessible via the point scan window, the response of these points to stimuli can be plotted in real time.

Simple	Point	Scan	- Scan	at	Crosshairs

The simplest type of point scan is controlled using the point scan window's “Scan at Crosshair” panel on the right hand side of the window. This point scan can run both an imaging point 

intensity recording and a point uncaging experiment simultaneously in parallel. This way, by carefully choosing the timing options for the uncaging and imaging panels, an experiment can 

be defined in which recording is performed in conjunction with uncaging. To run this experiment, follow the steps below:

1.    Ensure that the Hide Crosshair Overlay checkbox is not checked.

Point Scan
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2.    Position the Imaging crosshair over the pixel for which intensity is to be recorded.

3.    If uncaging is desired, position the Uncaging  crosshair (denoted with a U) over the point in the image which will be uncaged.

4.     In the “Use Imaging Galvos” panel, set the desired Initial Delay in ms. This is the time to wait from when the experiment is started to when intensity recording should begin.

5.    In the same panel, set the Duration to the length of time for which the intensity is to be recorded, in ms.

6.    In the same panel, set the Inter Point Delay to the amount of time that should be elapsed between the end of one repetition and the beginning of the next, or set the Interval to 

the amount of time that should elapse between the start of one repetition and the start of the next.  These fields will be ignored if there is only one repetition.

7.    In the same panel, set the Dwell Time to the time desired between recording samples, in us.

8.    In the same panel, set the Binning Mode to either averaging or summing, depending on which behavior is desired. This controls whether the samples acquired from one pixel are 

averaged or summed throughout the dwell time.

9.    If uncaging is desired, ensure that the checkbox on the right side of the label of the “Use Uncaging Galvos” is checked. If uncaging is not desired, skip to step 15.

10.  In the “Use Uncaging Galvos” panel, set the desired Initial Delay in ms. This is the time to wait from when the experiment is started to when uncaging should begin.

11.  In the same panel, set the Duration to the length of time for which the uncaging laser is powered, in ms.

12.  In the same panel, set the Inter Point Delay to the amount of time that should be elapsed between the end of one repetition and the beginning of the next, or set the Interval to 

the amount of time that should elapse between the start of one repetition and the start of the next.  These fields will be ignored if there is only one repetition.

13.  In the same panel, set the Uncaging Laser to the laser that will be used for uncaging.

14.  In the same panel, set the Uncaging Laser Power to the desired value representing the power of the laser used for uncaging.

15. If it is desired to run a voltage output and/or recording simultaneously with this experiment, choose either First Repetition or Every Repetition in the Synchronize with Options 

Below drop down menu, depending on whether the voltage output or recording is desired to run once at the start of the experiment, or with every repetition of the point scan. 

Additionally, choose the voltage output and/or recording experiment which is to be run simultaneously using the Voltage Recording Experiment and Voltage Output Experiment.  

More information about these features can be found in the Voltage Output and Voltage Recording sections of this manual.

16.  If the beginning of the point scan experiment should be started by another stimulus, choose the appropriate selection in the Wait for Trigger drop down menu.

17.  Choose the number of times the experiment should run by changing the value in the Repetitions control.

18.  Choose the Save Path using the control at the bottom left of the point scan window.

19.  Press the Start Point Scan button to begin the experiment.

If, instead of running the point scan experiment a set number of times, the experiment should run indefinitely until a stop button is pressed, check the Scan Until Stopped checkbox prior 

to pressing the Start Point Scan button. In this case, the Start Point Scan button will change to become Abort Point Scan. Press this button to finish the experiment. This type of 

experiment will run the procedure defined by the values entered in the textboxes once, then continually record the intensity at the imaging crosshairs until the Abort Point Scan button is 

pressed. Once the Abort Point Scan button is pressed, acquisition is stopped, and the data is saved to the appropriate file.

If it is desired to monitor the intensity of the imaging crosshair pixel in real time, the Live Scan feature can be used. In this case, the Live Scan Period should be chosen to match the 

amount of time for which previously acquired data should be displayed, then press the Live Scan button. For example, if the Live Scan Period is chosen to be 2 seconds, the graph will 

display the most recent 2 seconds of intensity values recorded. 

Choosing	Points	to	be	Scanned

Defining	Point	Locations
The first step in running a more complex point scan experiment is to choose the points which will be scanned. This can be achieved using one of three methods, two of which are chosen on 

the left side of the point scan window under the 'Left Click Action' heading. To perform any of these methods, both the Image window and the Point Scan window should be open. The first 

of these methods is to simply right click on an image window at the desired location of a new point and it will be added. Additionally, if a point has been placed, and it is then determined 

that the point needs to be moved, a leftclick and drag on the point will allow the point to be repositioned in the image. The second method accessed under the 'Left Click Action' heading 

mentioned earlier, Add Grid of Points, allows for a grid to be defined initially by leftclicking at the top left corner of the grid, and dragging to the bottom right corner. When the mouse 

button is released, a 3x3 grid of points will be created over the desired area. Near the middle of the point scan window is a section entitled Point Density, which allows for a more densely 
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defined grid. By changing the density in the X and/or Y directions, the resolution of the grid can be changed to include more or fewer points than the original 3x3 layout. The third and final 

method, Add Line of Points, allows for the points to be defined along a line created by leftclicking and dragging arbitrarily over the image. By default, the line created is not restricted to 

be a straight line, but will follow any path the mouse takes. Conversely, by holding the <Shift> key while drawing the line, the line is coerced to be a straight line with the endpoints defined 

by the beginning and end of the drag operation. Once this line is created, it will by default have three points. The number of points can be increased or decreased by changing the X Point 

Density near the middle of the Point Scan window.

Point	Representation
In addition to these methods for defining the location of the points, their representation can be chosen using the “Image Window Options” box on the left hand side of the point scan 

window. The first drop down menu allows for selection of the representation of these points between a crosshair, a dot, and no representation (i.e. the points are not shown on the 

image). Immediately beneath this drop down menu is another which allows for the color of the point representations to be chosen. Finally, underneath the two drop down menus is a 

checkbox which enables or disables display of the point indices alongside the point representations in the image.

Point	Organization	/	Grouping
Immediately to the right of the “Image Window Options” panel is a table which lists the Name, Index, and Type of each point defined in the window. This table can be used to create 

groups of points or remove individual points from the image. To create a group of points, controlclick on individual points or shiftclick on the endpoints of a contiguous list of the points 

which are desired to be grouped together. Then, click the Create Group button to the right of the table. Points which should be grouped together can also be chosen using their 

representation in the image window. Using the mouse, it is possible to leftclick and drag to create a box which surrounds multiple points. This will select all of the points encompassed by 

the box. Alternatively, controlclicking individual points will select multiple points. With the desired points selected, the Create Group button can be pressed to group the points together. 

Intragroup	Scanning	Order
Any group of points, including a defined grid or line, will by default number the points in ascending order in which the points were drawn. If this behavior is not desired, the order of points 

can be changed using the Point Order control to the right of the point table. The options presented here are forward, which is the default behavior, reverse, which puts the points in the 

opposite order of the default behavior, nonneighbor, which maximizes the distance between successive points, and custom, which allows the order of the points to be defined using the 

point names in the table. If the custom option is chosen, the textbox underneath it becomes active, and the order of points can be entered. In this scenario, use the number given in the 

point name to define a point. Continuous lists of points can be entered using the hyphen, such as 26 to represent points 2, 3, 4, 5, and 6. Otherwise, separate entries using a comma 

followed by a space.

Once the points and their order are defined, one or multiple points can be selected in the table, and the Add to Point Series button pressed to add a line to the point scan series table near 

the bottom of the point scan window. Additionally, the Clear All button will remove all points currently defined in the image. Finally, the Import button allows for points to be imported 

from the current line scan, or from an external application using the Tools>Actions dialog.

Running	a	Series	of	Point	Scans

When multiple points are defined, a series of point scans can be run using the point scan series table near the bottom of the point scan window. Each step of the series is defined using one 

row of the table. These rows can be initialized by pressing the Add Row button below the point scan series table, or by choosing a point or a group of points in the point table and pressing 

the Add to Point Series button. Each row can define one imaging experiment and one uncaging experiment, each of which can operate on a single point or a group of points. The imaging 

and uncaging experiments run simultaneously in parallel such that uncaging and imaging can be synchronized by carefully choosing the time parameters in the row of the table. In addition, 

each row can be run multiple times using the #Reps column in the table. In this scenario, the experiment will wait for both the imaging and uncaging portions of the experiment to finish 

before repeating the row. When a row is added, follow these steps to set the associated parameters for the point scan:

1.    In the Imaging Point/Group column, choose the desired point or group for which intensity will be recorded.

2.    Set the desired Initial Delay in ms. This is the time to wait from the end of the previous row's recording (or the beginning of the experiment) to the time the intensity recording for 

this row should begin.

3.    Set the Duration to the length of time for which the intensity is to be recorded at each point, in ms.

4.    Set the Inter Point Delay to the amount of time that should elapse between the end of recording the previous point and the beginning of recording the next point.  Multiple points 

can be present in a row by including a group of points and/or specifying a number of repetitions greater than one.  Alternatively, the Interval can be set to the amount of time that 

should elapse between the beginning of one point and the beginning of the next point..

5.    Set the Dwell Time to the time desired between recording samples, in us.

6.    Set the Binning Mode to either averaging or summing, depending on which behavior is desired. This control toggles between averaging and summing the samples acquired at one 

point throughout the dwell time.

7.    Choose the Label which corresponds to the imaging settings desired for recording intensity at the point/group.

8.    Set the # Reps to the number of times that the row should run before moving onto the next row.

9.    If desired, set the Wait for Trigger option accordingly to wait for a stimulus prior to starting the row.

10.  If uncaging is desired, choose the desired point or group at which uncaging should occur using the Uncaging Point/Group column. If uncaging is not desired, choose “None” and 

skip to step 15.

11.  Set the desired Initial Delay in ms. This is the time to wait from when the experiment is started to when uncaging should begin.

12.  Set the Duration to the length of time for which the uncaging laser is powered, in ms.

13.  Set the Inter Point Delay to the amount of time that should elapse between the end of uncaging the previous point and the beginning of uncaging the next point. Alternatively, the 

Interval can be set to the amount of time that should elapse between the beginning of one point and the beginning of the next point.

14.  Set the Uncaging Laser to the laser that will be used for uncaging.

15.  Set the Uncaging Laser Power to the desired value representing the power of the laser used for uncaging.

16. If it is desired to run a voltage output and/or recording simultaneously with this experiment, choose either First Repetition or Every Repetition in the Synchronize with column, 

depending on whether the voltage output or recording is desired to run once at the start of the experiment, or with every repetition of the point scan. Additionally, choose the 

voltage output and/or recording experiment which is to be run simultaneously using the Voltage Recording Experiment and Voltage Output Experiment. More information about 

these features can be found in the Voltage Output and Voltage Recording sections of this manual.

17.  Repeat the above steps for every row in the table.

18.  Choose the number of times the experiment should run by changing the value in the Repetitions control found beneath the series table, slightly to the right of the center of the 

window.

19.  If desired, enter a value into the Pause Between Reps field to set a time to wait from when one repetition of the table is finished to when the next repetition should begin.

20.  Choose the Save Path using the control at the bottom left of the point scan window.

21.  Press the Start Point Series button to begin the experiment.

If, when populating the series table, it is found that one of the rows is unnecessary, click on any value in that row to make it the active row. This is indicated by a black triangle appearing to 

the left of the row. Then, click the Remove Row button to eliminate this row from the series. Additionally, if it is desired to run a similar point scan as a previously defined row, select the 

row, again causing the black triangle to appear next to the row, and click on the Copy Row button to create an exact copy of the row in the series table. Finally, if all rows in the table are 

Page 40 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm



unwanted, press the Clear All button to remove all rows from the table.

Visualization	of	Point	Scan	Results

Graph	Overview
When a point scan is run, the intensity recorded at each point is plotted in the graph in the upper left hand corner of the point scan window for visualization of the result. This graph plots 

the recorded intensity on the y axis versus time elapsed on the x axis. The number of primary plots in the graph corresponds to the number of channels active in the Image window, and 

each is color coded according to the legend displayed at the bottom left hand corner of the graph panel in the Point Scan window.

Zooming	and	Panning
At the top of the graph panel are the graph controls used in all Prairie View graphing applications. The farthest left button, the reset button, is used to restore the axes to their original 

position. Next is the panning hand, which is used to drag the graph in any direction, which translates the graph in the desired direction. The next two controls are similar, except that they 

are limited to horizontal and vertical translation, respectively. The fifth control is the zoom function. To use this tool, draw a box on the graph by clicking and dragging the mouse around 

the area to be zoomed to. The last two controls are also zooming tools, but are limited to horizontal and vertical zoom, respectively. On the far right of this row is the graph tooltip, which 

explains all of the controls mentioned herein.

Axis	Scaling
In the upper right hand corner of the point scan window are several controls to change the display of the graph to the left. The first panel controls the Horizontal Scale of the graph, and 

has two options. Choosing Best Fit sets the x axis limits to show all of the recently acquired data. Conversely, choosing Fixed and entering values into the Maximum and Minimum boxes 

allows for custom defined limits on the x axis. The panel immediately to the right, the Vertical Scale panel, functions in exactly the same way as the Horizontal Scale, except it affects the y 

axis instead of the x axis. On the far right, the displayed data can be filtered using an averaging filter with the number of samples equal to any value entered into the Samples textbox. Note 

that for the real time display, the acquired data is downsampled to 1 kSamples/second, and thus choosing a number of samples to average of less than 2500 will not change the displayed 

time between samples, although the filtering is still being applied. When a previously run experiment is opened in playback mode, this number will autoadjust to the smallest value which 

will still allow the entirety of the experiment to be displayed in the graph. Below this box are two checkboxes. The first, Update Display, toggles whether to update the graph with the data 

acquired from the next experiment. If this checkbox is left empty, the experiment will run, saving the intensity recordings into their appropriate files, but the graph will not show any of the 

data. On the other hand, if it is desired to visualize the data acquired in real time, ensure that this checkbox is enabled. The second, Enter Playback Mode After Scan, causes Prairie View to 

automatically load the acquired point scan data, whether from a “Scan at Crosshairs” or point series experiment, into playback mode. The last control in this panel, the Save Graph button, 

exports an image of the current graph as a tiff file for later review.

Quantitative	Analysis
The final panel in the point scan window is the “Cursor Information” panel, which displays information about the acquired data. After a point scan experiment, two cursors are shown on 

the graph which can be moved to correspond with any time value on the graph. When the cursors are positioned, their corresponding time points can be seen in the Left Time and Right 

Time textboxes. Furthermore, the difference between these two time points can be seen in the ��������Time textbox and the corresponding frequency can be seen in the Frequency textbox. In 

addition to the time information related to the cursors, the information related to the data can be found in the table immediately below. This table consists of four columns. The first 

column lists the Data Source of the row, which is either one of the acquisition channels or a user defined function. The second column, Left Intensity, shows the intensity of the data 

corresponding to that row's Data Source at the time point corresponding to the left cursor. Similarly, the Right Intensity shows the intensity of the data at the time point corresponding to 

the right cursor. Finally, the last column, ���� Intensity, shows the difference between the Left Intensity and the Right Intensity.

Data	Evaluation
When the green button next to the “Cursor Information” panel is pressed, the “User Defined Functions” panel is displayed. Here, the user may enter custom mathematical functions to 

perform on the data. By clicking Create Function, a new window opens which allows for entry of a new function. Additionally, the dialog contains a link to help the user enter a function in 

the proper format. When the function has been defined, pressing <Enter> or clicking Accept will store the function in the table and add it to the plotted data for the next graph. If a slight 

change should be made to the function, the function can be highlighted, and the Edit Selected button pressed to reopen the function entry dialog with the previously defined function, so 

that a change can be made. On the other hand, if it is decided that a function is no longer wanted, the Remove Selected button will delete the active function from the list. Finally, if none 

of the defined functions are wanted, the Clear All button will delete all functions from the list. Once a function has been defined, it will be added as a Data Source in the “Cursor 

Information” panel, and its value will be plotted on the next point scan.

Files	Saved	by	the	Point	Scan	Experiment

A Point Scan experiment saves files that define the experiment as well as contain its results in the directory chosen as the filepath in the Point Scan window. Firstly, a configuration file is 

saved which contains the state of all microscope settings at the beginning of the Point Scan experiment. This file has a name ending in Configuration.cfg. Furthermore, the Point Scan 

experiment has an associated XML file which contains its definition. In this file, you can find the imaging and uncaging settings corresponding to the Point Scan experiment, as well as the 

timestamps of each point. Additionally, two sets of images are saved with the experiment. In the main directory, the raw image from the beginning of the experiment is saved for each 

channel. In the “References” subdirectory, a snapshot of each image window is stored with the current overlays. This image shows the locations of the points used in the experiment. 

Finally, each point imaged is associated with a commaseparatedvalue file which contains a relative timestamp as well as the intensity in each channel of that point at the corresponding 

time. If Voltage Recording, Mark Points, or Voltage Output was synchronized with the Point Scan experiment, their associated files will be present here as well. See the appropriate 

subsections for more information on these files.

The Photoactivation  tool allows the user to define masks in the scan area to determine where laser power will be applied.  These masks can be applied to a single focal plane, specific slices 

of a ZSeries, or all slices of a ZSeries.  Laser power will be applied only to those areas included in the mask, and power will be modulated as specified by the mask's definition.

The photoactivation button  opens the photoactivation mask editor dialog.  On point scanning systems, PA masks are carried out using the imaging galvanometers.  In order to use 

this feature on an SFC or Camera system, the system must be configured with a Photoactivation/FRAP module or Ultima scanner.

Photoactivation (PA)
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When using a Photoactivation Mask, the galvos scan a square or rectangular region, but laser power is applied only in the areas defined by the mask.  In some cases, the scanned region is 

the entire field of view.  In other cases, the scanned region is the smallest rectangular region needed to encompass the entire mask.

In the Preferences menu, the option to Save Images Generated With Photoactivation determines whether TIFF files are made when a PA mask is being scanned.  In most cases, these files 

do not contain useful images of the sample.  However, enabling the option provides the user with a quick reference image to see the position of the mask on the image.

Photoactivation	Editor	Controls

Palettes

The right side of the editor dialog consists of 8 Laser Palettes.  Each palette definition is a power setting for one or more lasers on the system, and draws with a particular pattern on the 

image. The pattern allows the user to distinguish between regions drawn with different palettes, but does not reflect a pattern or texture to the scan itself.

To set the laser power(s) that define a particular palette, click the associated Edit button to open the Edit Selected Lasers dialog.

The power setting for each laser in the palette definition appears in the box on the right side of the window.  To change the power setting for one of these lasers, choose that laser from 

the dropdown on the right side of the dialog.  Move the Power slider to the desired setting, or check the Current box to use the power setting made on the Laser, PMT, DAQ tab of the 

Main Control window.  Click the  button to add that new setting to the definition in the box on the right side of the dialog.  To add another laser to the definition, choose the new 

laser from the dropdown, set the power, and click the  button.  To use all configured lasers at their current power settings, click the Use Current Settings button below the list of 

defined laser powers.

To remove a laser from the definition, select in from the box on the right and click the button.  To clear the entire definition, click the Remove All button.

Palette definitions can be exported to a permanent file with the Export to File button, and later recalled with the Import from File button.

Click Accept to save the changes and close the dialog, or click Cancel to exit without saving changes.

To select a palette, click the pattern icon next to the palette definition; the selected palette’s pattern icon will appear with a green background.

Note:  Palettes are only present for systems with certain laser configurations.  If no such lasers are configured, this section of the dialog will not appear.  Drawing tools are still available, 

and masks will use the laser power(s) defined on the Laser, PMT, DAQ tab of the Main Control window.

Drawing	Options

Choose a drawing tool to being drawing a mask on the image.
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Invert Mask will swap the masked and unmasked areas of the mask.  This option is not available if the current mask uses more than one palette.

The Add Ellipse, Add Rect., and Add Polygon buttons allow the user to add these ellipses, rectangles, or polygons by clicking and dragging within the Image window.  With the ellipse tool, 

click the desired center position for an ellipse and drag outward to expand.  With the rectangle tool, click one corner of the desired rectangle and drag outward to expand.  With the 

polygon tool, click to add corners to the shape, and right click to close the region after making the last corner.

The Brush tool allows the user to paint areas of the image.  A small arrow next to the tool allows the user to choose from three brush sizes (Small = 2% of the display area, Medium = 4%, 

Large = 8%) or an Erase option to remove part of a previously drawn mask.

Generate allows the user to call previously saved Actions to autodraw regions.  Actions are described elsewhere in this manual.

The Selection Tool can be used to select a rectangular region of an existing mask.  Left click inside the selected region to drag it to a new location.  Right click inside the selected region to 

copy the selection and drag the copy to a new location.  Left click and drag one of the handles on the selection box to resize the selected area.  Click the Invert button to swap the masked 

and unmasked areas of the selection.  Click the Clear button to delete the mask inside the selected area.

When drawing a 3D mask in Playback of a ZSeries, clicking Copy Back (or Copy Ahead) adds the mask elements on the current slice to all slices between the current slice and the start (or 

end) of the ZSeries.  Clicking Copy to Previous or Copy to Next adds the mask elements on the current slice to one adjacent slice in the ZSeries.  The Show Prev/Next button displays 

masks on adjacent slices in a different overlay color, allowing the user to scroll through a ZSeries and see masks for the previous, current, and next slice on the same image.

The scroll bar allows the user to define the transparency of the mask overlay on the Image window.  This can be helpful when visualizing the structures covered by the mask.  This scroll bar 

applies only to PA masks on the Image window.  The Overlay scroll bar on the Image window itself will dim PA masks as well as all other overlays on the window.  Note that the Hide/Show 

option on the Image window will hide all PA masks as well; if the PA overlay is missing, check to be sure the Hide option is not enabled.

The color of the current, previous, and next mask overlays can be chosen by the user.  Click the rectangle below the transparency slider to choose the color for the current slice; click the 

squares above the slider to choose the color for the previous and next slices.

The Clear button will clear the mask elements inside a selected region.  If no selection has been made, a message box will appear to ask the user whether to clear all mask elements.  The 

Clear All button will clear all mask elements in the Image window.

For systems configured to use Laser Palettes, the Background Power section allows the user to choose the laser power(s) to be used in any area of the image not covered by a mask.  Radio 

buttons provide options for all lasers off, all lasers at current power, or a custom definition which can be set up with the Edit button like any other palette.

Click the Save Mask button and name the current mask.  This will save the mask in a temporary file, allowing it to be reloaded (with the Load Mask button) later in the same session.  To 

keep a mask to use in later Prairie View sessions, use the Export button to save it to a permanent file, from which it can be Imported later.

Creating	a	Photoactivation	Mask

A mask must be created on images of the same dimension on which it will be used.  For example, a mask to be used in an ROI must be created in that ROI.  A mask to be used on a 512x512 

image must be made on a 512x512 image.

� To apply a mask to a single image, create the mask on an image of the same X,Y dimensions

� To apply a mask to every slice of a ZSeries, create the mask on a single image of the same X,Y dimensions that will be used in the ZSeries

� To make a 3D mask with different areas on different Zlevels, make the mask while in Playback of that ZSeries, using the same X, Y and Z  dimensions as will be used when applying 

the mask (e.g. a mask to be used on a 10slice ZSeries must be created on a 10slice ZSeries).

For	a	single	image:

1.    Collect a single image using the same scan dimensions that will be used when applying the photoactivation mask (i.e. if planning to use an ROI during the experiment, use it here as 

well)

2.    While the single image is in the Image window, click the  button on the left side of the Image window; this will bring up the photoactivation mask editor dialog.

3.    Choose a laser palette from the list on the right side of the photoactivation mask editor dialog.  The default palette is often set to “All lasers using current setting”, which will scan 

the drawn mask using the photoactivation laser at whatever power is set at the time the mask is used.  Using the Edit button for each palette, the user can preset the laser power 

to be used for each mask; these settings will override the position of the laser power slider when the mask is used.  Multiple palettes may be used in the same mask.

4.    Click the Brush, Add Ellipse, Add Rect., and Add Polygon buttons and draw masks in the image window.  Additional buttons allow the user to select areas of the mask to clear, 

clear all parts of the mask, and invert the scanned and unscanned areas of the image.  A slider bar allows the user to change the opacity of the drawn mask, enabling the image 

underneath to be seen more clearly; the opacity slider does not affect the photoactivation itself.

5.    If multiple masks will be created during this Prairie View session, click the Save Mask button and name the current mask.  This will save the mask in a temporary file, allowing it to 

be reloaded (with the Load Mask button) later in the same session.  To keep a mask to use in later Prairie View sessions, use the Export button to save it to a permanent file, from 

which it can be Imported later.

6.    Close the photoactivation mask editor dialog

For	3D	mask	on	a	Z-Series:

Creating photoactivation masks for use in a ZSeries is similar to doing so for a single image, but with the added dimension of depth.  Refer to the instructions above for creating masks for 

a single image; aspects unique to photoactivation in a ZSeries are described below.

1.    Collect a ZSeries using the same scan dimensions that will be used when applying the photoactivation mask.  Use the same number of slices that will be used when applying the 

mask.  If an ROI will be used during the experiment, use it here as well.  It is recommended that the user save the ZSeries definition.

2.    Open the photoactivation mask editor dialog, choose palettes, and draw masks as described for single images.  Each component of the mask will apply only to the slice on which it 

is drawn; the user can draw different masks on different slices.  Use the copy buttons to propagate elements of the mask to other slices; Copy to Previous and Copy to Next add 

the mask element to an adjacent slice, while Copy to Back and Copy Ahead add the mask elements to all slices between the current slice and the start or end of the ZSeries.

3.    The Show Prev/Next button allows the user to view the masks defined for the adjacent slices, in a different overlay color than that used for the mask defined on the current slice.

4.    Save and/or export the mask as described for single image masks

5.    Close the photoactivation mask editor dialog

6.    Exit playback mode from the ZSeries on which the mask was being created
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Using	a	Photoactivation	Mask	– Galvo	Mode	Acquisitions

Photoactivation Masks can be applied in a number of ways.

For	a	Single	Image:

For a mask defined on a single image, the user can choose a mask from the Photoactivation Mask dropdown menu on the Misc tab of the Main Control Window.  Only masks valid for the 

current scan settings (image size and dimensions) will appear in the list of saved masks.  This mask will be applied to all subsequent Live Scans, Single Scans, ZSeries, and WSeries (but not 

TSeries).  To stop using the mask, change the dropdown menu selection to None.  The selection will automatically change to None if the use changes the image size to differ from that 

used to define the selected mask.  The selection does not apply in SFC, Resonant, or AOD mode.

To apply a singleplane mask within a TSeries, add a Photoactivation or Image cycle to the TSeries and select the desired mask from the Photoactivation column dropdown menu.  Only 

masks valid for the selected scan settings (image size and dimensions) will appear in the list of saved masks.  Enter the number of reps and period desired, as well as any synchronization 

with other software modules.

For	a	Z-Series:

To apply a mask in a ZSeries, add a ZSeries cycle and select the desired mask from the Photoactivation column dropdown menu.  Only masks valid for the current scan settings will 

appear in the list of saved masks.  This includes masks defined on a ZSeries of the same X, Y and Z dimensions, as well as masks defined on a single image of the same X,Y dimensions 

(which would then be applied to all slices of the ZSeries).  Enter the number of reps and period desired, as well as any synchronization with other software modules.

Using	a	Photoactivation	Mask	– SFC	and	Camera	Mode	Acquisitions

Photoactivation masks on SFC and Camera systems are used only within a TSeries. Implementation differs for single images and ZSeries.  As mentioned previously, a mask must be 

created on images of the same dimension (number of slices, size of ROI) on which it will be used. Navigate to the TSeries tab to perform the photoactivation experiment.  The TSeries 

containing the photoactivation can also contain other elements; for clarity, the examples below contain only the photoactivation cycles.

For	a	single	image:

This use of a photoactivation mask is designed around the concept of a FRAP experiment.  Two lines of the Tseries constitute a photoactivation cycle.  The first line calls the 

photoactivation mask and is essentially a modifier of the second line, in which the images are collected.  

1.    Drag the Photoactivation Time Per Pixel slider to the desired dwell time for the photoactivation laser

2.    Click Clear All to remove all cycles from previous TSeries

3.    Click Photoactivation to add two lines to the TSeries

4.    Configure the first line to call the photoactivation mask

a)    # Reps is the number of times the mask will be rastered across the image

b)    Period is the offset time between the start of the mask and the start of the imaging cycle called in the second line of the TSeries; positive numbers start the photoactivation 

before the imaging, while negative numbers delay the start of the photoactivation until after imaging has begun

c)    Choose the desired photoactivation mask from the dropdown menu in the Photoactivation column

5.    Configure the second line to collect images; at least one image must be collected for the photoactivation mask to be used

a)    # Reps is the number of images that will be collected

b)    Period is the time between the start of consecutive image repetitions; check the box under Max Speed to scan continuously

c)    Duration is the total imaging time

6.    Click the Start TSeries button to begin the photoactivation and acquisition

An example TSeries is shown below.  Imaging will begin when the Start TSeries button is clicked, and will continue for 2 seconds.  After 1 second of the imaging time has elapsed, the 

“Current” mask will be photoactivated one time. 

For	a	Z-Series:

Photoactivation within a ZSeries takes place independent of imaging.  Therefore, the TSeries need only have one line.  No images are collected during the photoactivation.  Images can be 

collected by adding additional lines to the TSeries or by collecting single images and/or ZSeries outside of the TSeries tab.  Only the slices on which masks were defined will be scanned 

during the photoactivation; if masks are drawn on slices 4 and 6 of a 10slice ZSeries, only those two slices will be scanned.

1.    Drag the Photoactivation Time Per Pixel slider to the desired dwell time for the photoactivation laser

2.    Click Clear All to remove all cycles from previous TSeries

3.    Click ZSeries once to add one cycle to the TSeries

4.    Configure the photoactivation ZSeries
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a)    # Reps is the number of times the photoactivation stack will be scanned

b)    Period is the time between the start of consecutive repetitions

c)    Duration is the total imaging time; move time between slices of the ZSeries is not included

d)    Select your ZSeries definition from the dropdown menu in the ZSeries column

e)    Select your photoactivation mask from the dropdown menu in the Photoactivation column

5.    If desired, the user can collect images of the sample as part of the photoactivation TSeries by adding an additional ZSeries cycle and setting the number of repetitions, period, 

etc.  This imaging cycle need not use the same ZSeries definition used to create and perform the photoactivation.

6.    Click the Start TSeries button to begin the photoactivation

Additional	Notes	on	Photoactivation

Photoactivation cycles can be embedded in TSeries with many other cycles.  Thus, Labels, ROIs, Scripts, and other modifiers may change scan parameters before or after a photoactivation 

cycle.  As always, scan dimensions (ROI, number of slices in a ZSeries) in place when a photoactivation mask is used must match those in place when the mask was originally created.

In some cases, the laser power applied during a photoactivation mask can result in the PMT signal becoming saturated.  This is especially a problem with GaAsP detectors, which are more 

readily damaged than multialkali PMTs when exposed to bright light.  Therefore, the user may opt to lower the PMT power while a mask is being applied.  This can be done within a T

Series by including Script cycles before and after the mask is applied.

Mark Points is an application module designed to allow users to define point photoactivation protocols (uncaging, optogenetic stimulation).  Mark Points can also be used to set up 

protocols for other types of photoactivation as well as photodamage/photoablation experiments.

Mark Points allows the user to define specific point locations that will be illuminated by a specific laser for a specific duration and intensity.  The user also defines the time interval between 

individual points as well as groups of points.

The protocols defined by Mark Points can be synchronized with image acquisition (full frame, ROIs and line scans) as well as Voltage Output signals that are used to control 

electrophysiology data as well as any other devices that can be controlled by analog voltage outputs and TTLs, and Voltage Recording of analog signals from electrophysiology amplifiers or 

an device generating an appropriate analog signal.

Mark	Points	Interface

Mark Points
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Left click on the Mark Points on the Image window or select Mark Points from the Application menu to launch the Mark Points interface.

The Mark Points interface is divided into following sections:

� Image window options:  Sets display of graphic overlays as well as control of the mouse pointer when defining and editing point setup

� Point Groups: Lists points and groups defined on the image window.  Allows user create groups of points as well as delete points, lines and groups.  Point density of lines and grids 

can be defined.  Custom point order can be defined.  Sets of points, groups, grids and lines can be saved and loaded.

� Mark Points at Crosshair:  Allows configuration of parameters for protocols using the interactive cross hair.  These parameters are the same as those used in a Mark Point Series; 

see below for descriptions.  The settings in this section also define the default values for parameters when points, groups, lines and grids are added to the Point Series table.

� Point Series Table:  Defines the protocol to be run.  Points, lines of points, groups of points and grids are added to the table and selected laser, laser intensity, pulse duration, 

intervals, triggering and synchronization are defined.

Defining	points

After acquiring a reference image, the user selects Mark Points from the Image window or Application menu to launch the Mark Points interface.  

Individual points (which can later be grouped), lines of points or grids of points can be defined. Select the type of points to be defined in the Left Click Action of the Image Windows 

Options.  

To select individual points, right click in the desired locations on the image in the image window. Note: the image window can be zoomed when creating points or sets of points.  To move a 

point, left click in the point and drag to a new location.  Points can be moved after a Mark Points experiment is run.  This feature is useful in evaluating location based on response.

To add a line of points, select Add Line of Points.  To add a free hand line, point the mouse cursor to the beginning location, hold down the left mouse button, draw the desired line, and 

release the mouse button.  The point density can then be set using the X point density controls to the top right of Points/Groups.  To draw a straight line, hold down the shift key while 

drawing the line.   To move a line, point at a point on the line, and while holding down the left mouse button move the line.  To rotate the line, place the mouse cursor over an endpoint of 

the line, and while holding down the left mouse button rotate the line.

To add a grid of points select Add Grid of Points.  Place the mouse cursor over the desired location of the upper left hand corner if the grid, hold down the left mouse button, then drag 

down to the desired lower right hand corner of the grid and release the mouse button.  To move or resize the grid, place the mouse cursor on a point on the interior of the grid, hold down 

the left mouse button, and move the grid.  To resize, place the mouse cursor on a point on the edge of the grid and drag.  Placing the mouse cursor on the upper right corner allows the 

grid to be rotated.  X and Y density are set with the controls to the upper right of Points/Groups.

There are two ways to create groups of existing points.  One way is to set Left Click Action to Select/Move Points and while holding the left mouse button drag the cursor over the area 

containing the desired groups.  The other way to create a group is to select the points in the Points/Group list by using control+click or shift+click.  Then click the Create Group button on 

the right side of Points/Groups.

Defining	protocols
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Protocols are defined in the Point Series table.  To add points, groups, lines or grids to the Point Series table, click on the desired entries in the Points/Group list and click the Add to Point 

Series button.  The selected items will now appear in the Point Series table.

Note:  If the parameters for selected laser, laser intensity, pulse width, etc. will be the same for all entries in the Point Series table, it is convenient to set those values in the Mark Point at 

Crosshair section as they will then be the defaults when entering items to the Point Series table.

The Mark Points variables to be set for any experiment are:

� Initial Delay is the time until the first point in a group, line or grid is illuminated with the selected laser.   Note:  The shortest possible initial delay is the move time set for the 

galvanometers in the scan settings defined for the system; this parameter is set by Bruker Fluorescence Microscopy personnel during installation of the system.

� Inter Point Delay is the time between points in the group, line or gird.  In the case of individual points this variable is used only if there are repetitions of that point.

� Duration is the length of time the laser is on at each point.

� # Reps is the number of times the group, line or point is repeated.

� Uncaging Laser is the laser to be used for that line in the Point series table.  Note that different lasers can be selected for different lines.  The lasers available for selection depend 

on system configuration.

� Uncaging Laser Power is the power of the laser when turned on as defined by the scaling set in the system configuration.  This power setting uses the same scale as the laser power 

slider in the main control window.

At the bottom of the Point Series table is a graph showing the timing of the protocol.  This graph can be hidden or displayed by clicking the green bar at the bottom of the Point Series 

table.

Running	Mark	Points

Mark Points protocols can be run in a number of ways, typically synchronized with imaging, in conjunction with electrophysiology recording, or both.

Stand-Alone	Mark	Points	Experiment

Mark Points can be run alone, which is typically done to verify that protocols are operating properly by using a marker slide or a slide with caged fluorescein.  Simply click the Run Mark 

Points button at the bottom right corner of the Mark Points interface.

If more than one line is present in the Mark Points table, and no triggers are set, the entire table will run to completion.

To run a single point as a standalone experiment, use the Mark Point at Crosshair controls.

Triggering	Mark	Points	with	Imaging	or	Line	Scans

Mark Points is often run with imaging, either full frame or ROI images or line scans. Simultaneous execution of Mark Points with imaging requires that the system have separate light paths 

(galvanometers and lasers) for the two operations.  On systems with only one set of galvanometers, imaging and Mark Points must take place sequentially, rather than simultaneously.

When running Mark Points as part of a TSeries of images, the user can select on the TSeries line on which frame the Mark Points protocol should run.  Scrolling to the right in the TSeries 

Cycles table will show a field for Synchronize with Mark Points.  Selecting this field will open a drop down with the options to use the current Mark Points settings or a saved Mark Points 

protocol.   This selection is only available on systems configured with the hardware needed for simultaneous Mark Points with imaging.  To the left of the Mark Points synchronization field 

is the Triggers Before Starting column, in which the user enters the frame on which they want the Mark Points protocols to run.  Frame triggers are discussed here.

A Mark Points experiment can also be added to a TSeries as a separate cycle, by clicking the Mark Points button to add that type of cycle.
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More information about TSeries setup is available here.

In the Linescan Control window, Mark points is synchronized by selecting a Synchronize With option and then selecting Mark Points, with options to run the current configuration or a 

saved protocol.  Note that with Line Scan the Synchronize with option gives two choices, Once at Start or Each Repetition.  Once at Start will run the Mark Points protocol once when the 

Start Linescan(s) button is clicked, even if Line Scan is configured to run multiple repetitions.  If Each Repetition is selected, Mark Points will run once for each repetition.

More information about line scan acquisition is available here.

Triggering	and	Synchronization	in	Mark	Points

Mark Points has internal trigger variable that can be set to run Mark Points when an external trigger is received, or for more complex experiments involving multiple internal image 

triggers.

Scrolling to the right in the Point Series table will show the triggering section.   Mark points can be triggered in two ways in conjunction with internal image triggers as well as being 

triggered by external triggers such as those that can be generated by an electrophysiology recording system.

Image triggers are PFI 0 (start of next scan) and PFI 8 (a specific frame).  Frame triggers are discussed in more detail here.  These triggers are not available if the system is configured to use 

the same galvanometers for both imaging and Mark Points functions.  If PFI 0 is selected for a line, that line will start when the next scan is started, a scan being defined as a T Series line, 

Live Scan, Single Scan, or a line scan.  PFI 0 would be used when individual Point Series lines are to be matched up with individual T Series lines or line scan repetitions.  

As an example, a user wants to do an experiment where they want to evaluate the effect of three different sets of points on eliciting a rise in calcium as measured by a calcium indicator. 

They define 3 groups of points, put each group on a line in the Mark Points Point Series table, and define the laser and timing variables.  They set Wait for Trigger in Mark Points for each 

line to First Repetition and select the PFI 0 trigger.
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In T series they set up three T Series lines, in this each with the same number of frames and frame interval.   They DO NOT select triggering or synchronization in the T Series line, as the 

triggering is being set in Mark Points.

To start the experiment, they first click on Run Mark Points in the Mark Points window.  Mark Points is now waiting to be triggered.  They then click Start T Series, and the T Series starts to 

run.  The start of each T Series line triggers Mark Points to run the next line.

In another variant of the above experiment, the user wants to have a single T Series, and have three different groups of points run after a certain number of frames.  They again set up 3 

groups in Mark Points in the Points Series table.  In this case they select as a trigger PFI 8, and select the number of frames to wait until the line in Points Series table runs.  In this case they 

are going to run a T Series of 100 frames.  They want to wait 25 frames before triggering the first line of the Point Series, and every 25 frames thereafter.   They put 25 in as the number of 

frames for each line in the Point Series table.  They click Run Mark Points so that it is waiting to be triggered, and then start the T Series.

Using Mark Points triggering with line scans is usually done with repetitions of line scans where a different line in the Point Series table is to be run with each repetition.  For example, three 

groups of points, each to be run with a repetition of line scan.  PFI 0 is used for the trigger for each line, and in line scan synchronization with Mark Point is not selected.  Line scan would be 

set to run 3 repetitions.  Mark Points would be started, then line scan started.  At the beginning of each line scan a line from the Mark Points Point series would run.

Triggering by an external device can also be done from within Mark Points.  Again, Wait for Trigger is selected, and the trigger source is selected.  The trigger source can be PFI 1, which is 

the PFI 1 connector on the front of the GPIO box, or Trigger In, which is one of the 8 Trigger In connections on the front of the GPIO box.  Again, Run Mark Points is clicked to put Mark 

Points in a state where it is waiting to run.  

If there are multiple lines in the Mark Points Point Series, but only the first has a trigger set, the entire Points Series will run when the trigger is received.    It is possible to set up protocols 

where there are multiple lines with triggers and lines without triggers.   For example, a user wants to create 9 groups and run them 3 at a time with a line scan.   They would create the 9 

groups and enter them in the Point Series such that lines 13 were the groups for the first line scan, 46 were for the second line scan and 79 were for the 3rd line scan.  On lines 1, 4 and 7 
they would set the trigger to PFI 0.  They would set line scan to 3 repetitions, click Start Mark Points and then start line scan.  The first three lines would run with the first line scan, line 4 

would wait for the next start of scan trigger from line scan, etc.

Synchronizing	with	Voltage	Output	and	Voltage	Recording
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Lines in the Point Series can be set up to synchronize with defined Voltage Output and Voltage Recording.  This type of synchronization can provide full control and recording of data for 

experiments where optical stimulation is being used in conjunction with electrophysiology recording.   Voltage outputs can also be used as triggers for external devices, and Voltage 

Recording can record any type of 10 to +10 V signal.

In order to use Voltage Output or Voltage Recording, Voltage Output and/or Voltage Recording must be configured, or have saved experiments present (see Voltage Output, Voltage 

Recording).

To use Voltage Output or Voltage Recording, select First Repetition, Each Repetition or Each Point from the Synchronization dropdown.  Then select Current or Choose Experiment from the 

Voltage Output and/or Voltage Recording experiment.

When using Voltage Output through Mark Points synchronization, the waveforms being generated are displayed in the graph below the Point Series.  Voltage Recording time is displayed in 

the graph as a red overlay.

More information about Voltage Output and Voltage Recording experiments can be found in other sections of this manual.

This feature is fully implemented, but the Help file description has not been completed.  Please contact Bruker Fluorescence Microscopy support personnel with questions about this 

feature.

This section of the Help file is under construction and has not been updated recently.  The information below is from a previous version of the manual and may be somewhat outdated. 

Please contact Bruker Fluorescence Microscopy support personnel with questions about these features.

While in Playback Mode (discussed in the Playback Mode section of this manual), the active dataset can be shown as a Maximum Intensity Projection (MIP).  The projection is a single 

image where each pixel value is the highest intensity pixel for that XY coordinate in all the planes of the ZSeries.  To use MIP, a Zseries must first be acquired.  While in Playback mode, 

click the MIP button on the Image window.  This places a cross hair cursor on the image and opens up a sidebar window to the right of and below the Image window, displaying the yz and 

xz projections, respectively.  By moving the cursor to the xy coordinate of interest, the user can observe changes in intensity in z.  As the cursor is moved along the xaxis, intensity 

changes in the yz plane are observed, while as the cursor is moved along the yaxis, intensity changes in the xz plane are observed.

The user can see which Zlevel each pixel in the XY projection came from by hovering the mouse cursor over that pixel and looking at the Z information at the bottom of the Image 

window.  The intensity of that pixel in the MIP is shown for each of the four acquisition channels, and the slice number in which that pixel is the brightest is given in the “Z={…” section.

Spiral Activation

Maximum Intensity Projection (MIP)
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MIP	Menu

Options for display can be found by selecting the dropdown arrow to the right of MIP.

The user can choose to Display XZ and YZ projections as 1:1, which scales the projections based on the distance between consecutive slices of the ZSeries, or to Display XZ and YZ as 

actual pixels, which displays one pixel per slice of the ZSeries.  The projections can be manually resized by clicking the edge of the window and dragging it to the desired size.

The Thickness option allows the user to choose a number of neighboring slices to be averaged in the XZ and YZ displays.

Color Depth applies a pseudocolor based on the slice in the projections.

The user can choose to display an Average Projection to show the dataset at the average for each pixel instead of a Maximum Projection.  Cancel allows the user to exit the MIP menu 

without making a selection.

The Mark Stage button allows the user to dynamically move the stage and save stage locations while imaging.  Click the Mark Stage button to activate it; the button will change from grey 

to green when it is active.  While Mark Stage is active, the user can click in the Image window to move the sample and mark stage locations.

Clicking with the right mouse button will add the coordinate of the cursor to the list of saved locations in the XYStage tab.

Clicking with the left mouse button will move the stage to put the clicked position in the center of the scan.  This movement is dependent on selection of a properly calibrated objective, so 

that pixel size in the image can be accurately translated into the distance the stage moves in the x and y axes.  If the stage moves in the wrong direction for one or both axes, change the 

checked/unchecked status of the Invert X for ‘Mark Stage’ and/or Invert Y for ‘Mark Stage’ options in the XYStage tab of the Prairie View main control window.

This section of the Help file is under construction.  Please contact Bruker Fluorescence Microscopy support personnel with questions about this feature.

The XZ/YZ Scanning feature enables the user to acquire a vertical plane of data through the sample.

Note that use of this feature is supported by a subset of Z devices and requires additional connections to be made between the Z device(s) and the GPIO box.  Supported Z devices include 

MAMCdriven Z motors and Prairie Piezos.  Contact Bruker Fluorescence Microscopy support personnel with questions about this feature. 

Mark Stage

Plane Scanning

XZ/YZ Scanning
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There are three general steps to defining an XZ/YZ Scan:

1.    Collect a frame scan in Galvo mode

2.    Define the line in XY along which the scan will occur

3.    Define the Z range and step size at which each XY scan will be performed

Defining	an	XZ/YZ	Scan

Collect a frame scan using the controls on the Prairie View main control window. 

Click the XZ/YZ button on the Image window to open the XZ/YZ Scan Definition dialog. 

Choose the type of line to be drawn in the XY plane

� XZ defines a straight horizontal line, the position of which can be adjusted in the Image window by clicking and dragging the box in the middle of the line

� YZ defines a straight vertical line, the position of which can be adjusted in the Image window by clicking and dragging the box in the middle of the line

� Angle defines a diagonal line, the position and angle of which can be adjusted in the Image window by clicking and dragging the boxes at the endpoints of the line

� Freehand defines a userdefined arbitrary line, which can be drawn on the Image window; click and drag the boxes at the endpoints of an existing line to extend the line

Device allows the user to select the Z device to use for the scan, if multiple Z devices are configured.  

The Z range of the acquisition can be defined in one of three ways, using the dropdown menu at the top of the XZ/YZ Scan Definition window

� Auto Z Range sets the Z parameters to approximately fill the height of the Image window. After selecting Auto Z Range, the user can choose the Nyquist sampling option from the Tools 

menu to calculate the theoretical step size needed for Nyquist sampling.

� Manual Z Range enables the user to manually define the Thickness, Center Position, and Step Size of the scan.

� Use ZSeries Range imports the Thickness, Center Position, and Step Size from the current settings in the ZSeries tab in the main control window.

Based on the method selected for calculating the Z range, additional parameters may be defined by the user

� Thickness is the height or depth of the scan in the Z direction (in microns)

� Center Position is the absolute position at which the scan is centered, for the selected Z device

o       Use Current Z changes the Center Position to be the current position for the active Z device

o        Goto moves the Z device to the position displayed in the Center Position field

� Step Size defines the Z distance between each line (in microns); the sign of this value determines the direction of the scan (top to bottom or bottom to top)

� Flip changes the sign of the Step Size to scan in the opposite Z direction, inverting the image

Fastest Acquisition induces a Prairie Piezo Z device to operate in its calibrated mode.  The acquisition itself is much faster than an acquisition that is not Fastest Acquisition, though time is 

required for a new calibration to be performed whenever scan settings change.

Bidirectional collects consecutive scans in alternating Z directions, eliminating the need for the Z device to return to the start location between scans.

Saving	an	XZ/YZ	Scan	Definition
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Multiple XZ/YZ definitions can be set up and saved for use during a Prairie View session; definitions are not preserved when Prairie View is closed.  To save the current XZ/YZ definition, 

click the  button.  Give a custom name to the definition by clicking once on the name of the definition and typing a new name.  To delete a definition from the list, select it and click the 

 button.  Saved definitions can be recalled to run as individual scans in this window by doubleclicking the name of the definition.  Saved definitions can also be referenced within a T

Series.

Running	an	XY/YZ	Scan

Three different acquisition types can be performed from inside the XZ/YZ Scan Definition window.

� Single Scan performs the defined XZ/YZ scan one time.  The acquisition is saved in the folder defined by the Save Path on the main form.  The directory name is follows the following 

format:

XZYZ[date][time Prairie View session started][iteration].

� Live Scan performs the current XZ/YZ scan continuously, until the user stops the acquisition with the Abort button.  The last frame of the acquisition is saved in the folder defined by 

the Save Path on the main form.  The directory name is follows the following format:

XZYZ[date][time Prairie View session started][iteration].

� Brightness Over Time can be performed if BOT regions have been defined on the previous XZ/YZ scan.  Acquisition continues until the user clicks the Abort button.  The acquisition is 

saved in the folder defined by the Save Path on the main form.  The directory name is follows the following format:

XZYZ[date][time Prairie View session started][iteration].

Alternatively, the XZ/YZ scan can be embedded in a TSeries.  Use the XZ/YZ Image button to add the cycle, and select the current or saved scan definition from the Resource Selection 

column.

A Look Up Table ( LUT) is the function that is used to color the display of the data to be displayed on the computer screen.  Clicking the LUT button brings up the Lookup Tables window.  If 

only 2 channels are visible in this window, click the vertical green bar on the right edge of the window to reveal the other two channels.

Images are digitized to the bit depth of the acquisition hardware.  Images acquired on most systems are digitized as 12bit data (0 for no signal up to 4095 for saturated signal).  Systems 

with a Resonant Scanner acquire images as 13bit data (0 to 8191).  On a system with a Resonant Scanner, the user may choose to digitize data on a 12bit scale to match that of systems 

without a Resonant Scanner; this option is found in the Preferences menu.  For an SFC or Camera image, this is based on the bit depth of the camera; for example, data from a 16bit 

camera will result in intensity values from 0 (no signal) to 65535 (saturated signal).

In a grayscale (black and white) LUT, values of 0 are usually represented as pure black and saturated values are usually represented as pure white.  Since the display has only 256 grey 

levels, a function or LUT is used to define the display intensity scale.  If these 256 display grey levels are used to display the full range of a 12bit image with 4096 intensity levels, then each 

display grey level is equal to 16 image data intensity levels.

In the LUT graphs, the pixel intensities are displayed as a histogram, where the horizontal axis is the intensity level and the vertical axis is the number of pixels.  Buttons above the graph 

allow the user to zoom in on sections of the histogram and pan around once zoomed in.  Controls below the graph allow the user to manually set the scale of the vertical axis or Auto Scale

the axis.  Log Scale allows meaningful information about the intensity scale to be viewed for images with a large dynamic range.

The pink vertical lines on the graph show the position of the minimum and maximum values of the Look Up Table; the L Cursor and R Cursor fields below the graph display the positions of 

these lines.  The yellow line shows the shape of the function.  

Since fluorescent images very often contain a large number of dark pixels, it is sometimes desirable to adjust the range of the LUT to exclude some of the dark pixels, thereby allowing the 

LUT to display smaller changes in the data intensity scale.

The user can drag the pink lines to adjust the high and low ranges of the LUT.  The shape of the function (yellow line) can be adjusted with the sliders to the right of the graph, which 

control gamma, contrast, and brightness.  The  button below each slider will reset that slider to the default value.  These adjustments are specific to the channel for which they are 

Look Up Tables
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made.

The Reset  button moves the LUT cutoffs back their minimum and maximum values.

The Auto  button adjusts the LUT to maximize the contrast of the current image in the display.  This is not a continuous adjustment, but rather an instantaneous one using the current 

frame’s channel data.

Rightclicking on the LUT button itself brings up a menu from which the user can select to reset or automatically adjust the Look Up Table without opening the LUT window.

Adjustments to the LUT only affect the display of the image; the actual intensity values collected by the acquisition hardware do not change.  Therefore, the LUT values in place during 

acquisition will not be saved as part of the data set or applied when opening the image again later.

LUT settings are automatically reset by default between sessions of Prairie View.  However, the user can enable the Save/Recall LUT settings option in the Preferences menu.  With this 

option enabled, the software will retain the LookUp Table settings in place when Prairie View is exited, to be recalled the next time Prairie View is started.

It is often useful to scan only a selected region of the field of view to optimize image speed. Using the Region of Interest (ROI) tool, it is possible to define a small portion of the sample to 

be imaged, which increases the scan rate.  When this button is pressed, the cursor is used to define a rectangular area in which to limit scanning.

To exit out of the ROI and begin scanning the entire frame, click ROI again.

On point scanning systems, limiting the scan area increases the frame rate of the acquisition and limits laser exposure to the area of the sample within the ROI.  

In SFC mode, limiting the scan area provides two advantages.  First, it allows more sweeps of the selected area during the exposure time of the camera, which may allow the user to collect 

adequate signal intensity at lower exposure times.  Second, by collecting data from fewer pixels of the camera, the camera can transfer and read out the frames more quickly.  Due to 

camera transfer and readout geometry, this latter advantage often has more effect for ROIs near the top of the image than the bottom.

To define an ROI, select ROI and place the cursor at one corner of the area of interest.  Click and drag the mouse, creating a rectangular ROI.  The Image Window will automatically resize 

itself. Press Live Scan or Single Scan to refresh the display to reflect the ROI. The scan will be restricted to the area defined by the ROI.

For point scanning systems, the pixel size used within the ROI will be the same as that of the image on which the ROI was drawn.  To change the pixel size within the ROI, use the 

Increase/Decrease Pixel Size buttons in the Image Size section of the Main Control Window: 

By rightclicking the ROI button or clicking on the dropdown button to the right of the ROI button, the user can bring up a context menu.  The contents of this menu vary based on 

whether the ROI button is currently active.

� Enter/Exit ROI functions the same as clicking the ROI button – it allows a new ROI to be defined or closes the current ROI

� When ROI is not active, Edit New ROIs allows the user to draw a new ROI and edit it before accepting the new ROI

� When ROI is not active, Edit Existing ROIs allows the user to view and resize existing ROIs and draw new ROIs which can also be edited

� Load displays a list of saved ROIs which can be loaded by clicking on the desired region

� Selecting Save saves the current ROI as a new ROI or overwrites an existing saved ROI. Saved ROIs are not retained after Prairie View is closed.  By default, ROI names include the 

pixel location of the upper left corner of the ROI and the dimension (in pixels) of the ROI.  These values will change if the user changes the Image Size.  To save a custom name for 

the ROI, enter the ROI and choose Save>New from the ROI menu; then type a name for the ROI and press Enter or click the green check mark.

� Delete displays a list of saved ROIs which can be deleted by clicking on the desired region

Regions of Interest (ROIs)
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� Delete All deletes all saved ROIs

� Import from File imports a set of saved ROIs from a file

� Export to File exports the current saved ROIs to a file to be imported and reused at a later time.  This allows the user to keep ROI definitions for a later Prairie View session

� Save Reference Image saves the Image window contents with an overlay of the saved ROIs marked on it

� Clicking to enable Auto Save places a check mark next to the menu option and causes all subsequently defined ROIs to be saved to the ROI list, to be loaded later in the same 

Prairie View session; click again to disable the option

� Clicking to enable Auto Edit places a check mark next to the menu option and causes the ROI editor to open whenever a new ROI is drawn; click again to disable the option.

� When Auto Edit is disabled, the system will immediately enter the newly drawn ROI.

� When Auto Edit is enabled, the ROI editor allows the user to adjust ROIs before their definitions are finalized.  Multiple ROIs can be drawn on the same image while the 

editor is open.  Click the Accept button in the upper right corner of the image to accept the definition(s), or the Cancel button to exit the ROI editor without saving the 

defined ROI(s).

� Click inside an ROI and drag to move it to a new location.

� Click and drag square handles on the sides and corners of an ROI to change its size.

� Rotate the ROI by dragging the circle indicator on the corner of the ROI. Delete the ROI by clicking the X near the corner of the definition.

� To create multiple ROIs of the same size, click the right mouse button inside an ROI to clone the ROI, then click the left mouse button and drag the clone to a new 

location.

� Clicking to enable Show Advanced Settings places a check mark next to the menu option.  When an ROI is drawn, the Advanced ROI Settings dialog will open next to the image 

window.  This option does not apply to SFC mode.

� From this dialog, the user can choose from two options for scanning within the ROI

� Scan Region will scan the ROI as defined

� Scan Line will scan only one horizontal line across the center of the ROI. This single line will be scanned multiple times; the number of times is defined by the 

number of lines in the original ROI definition.

� The Manual Frame Rate option is no longer used.  In the past, it was used as a way to improve the accuracy of interimage timing when scanning an ROI in a TSeries at a 

period other than the fastest possible frame rate.  This is no longer necessary, as interimage timing accuracy in the TSeries has been optimized.

� Use Z(focus) Values saves the positions of all Z devices along with the ROI, so that different ROIs can be collected at different Zlevels.  When loading the ROI, the Z device(s) will 

move to the position(s) stored with the ROI definition.  In addition, ROIs can be drawn on various slices of a ZSeries while in Playback mode; the Z position of the slice will be saved 

as part of the ROI definition.  

Note that this feature should NOT be used when a ZSeries will be performed within the ROI.  The Z device positions defined in the ZSeries will override the Z device position 

associated with the ROI.  In these cases, rely on the top and bottom positions for the ZSeries to move the Z device(s) when entering or switching ROIs.

� Cancel closes the ROI context menu without loading or defining an ROI

On point scanning systems, an ROI must be at least 8x8 pixels, and the X dimension must be a number of pixels divisible by 4.  These limits are automatically imposed by the software while 

drawing an ROI.  Additional limits may exist for camerabased systems.

Saved ROIs can be called from within a TSeries by adding an ROI cycle and selecting the desired ROI from the Resource Selection dropdown menu.  The ROI will be applied to all 

subsequent cycles of the TSeries, until another ROI (or “No ROI”) is selected in another ROI cycle.

The snap button  is used to save the current image displayed in an Image Window. The image will be saved to the filename and path specified in the Prairie View main form, and the 

incremental image counter on this tab will be increased by one to prevent overwriting data.

The displayed image will be saved as if it were a single image acquisition (a metadata file).  If any overlays are present on the image, the exact displayed view (including display zoom) and 

overlays will be saved as an 8bit TIFF.

The line profile tool displays a plot of intensity along a userdefined line on each of the active channels.  When the button is clicked, a line appears on the image window and the 

Line Profile dialog opens.  By dragging the ends of the line in the image window, it can be positioned across the area of interest.  Two additional markers along the line correspond to the 

white and blue vertical cursor marks on the line profile graph.

Snap Tool

Line Profile
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Spatial and intensity information for the two vertical cursors in the Line Profile dialog (corresponding to the inner markers on the line in the Image window) is displayed in a table below the 

intensity plot.  For images acquired on multiple channels, the user can determine which channel to use for intensity information by choosing that channel from the Selected Channel drop

down menu.

By moving the white and blue lines in the Line Profile dialog or the corresponding marks in the Image window, the area of interest can be more sharply defined for FWHM calculations. To 

calculate the FWHM of the area between these cursors, choose the desired channel under Selected Channel and click Calculate.

When the Image window is displaying a Maximum Intensity Projection of a ZSeries (discussed in the Maximum Intensity Projection section of this manual), the MIP Mode checkbox in the 

Line Profile window allows the user to display a line profile from the projection image.  The Z Mode checkbox on the Line Profile window can be used to acquire a profile or calculate 

FWHM along the zaxis at a point in XY (as defined in the MIP).

The vertical scale of the profile graph can be adjusted in the Line Profile dialog.

The user can adjust the Line Width to average the intensity profile of neighboring pixels.

Intensity profile information can be saved as a comma separated data set by clicking Export.

By clicking the green bar above the line profile graph, the user can access buttons for zooming and panning within the graph display.

The dropdown button next to the line profile tool button allows the user to choose whether or not the Line Profile dialog will pop up when the line profile button is activated.

The ratio image window behaves much like any other image window, but instead of being used to visualize the intensities of a combination of channels, it instead is used to visualize the 

ratio of intensities between a pair of channels.

Ratio
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The controls on the right side of the window are used to change what is displayed in the ratio image window.  These controls include:

� Channel Selection combo boxes which specify which two channels will be divided to calculate a ratio at each pixel.

� Lookup Table (LUT) Channel selections to pick which channel, or an average of both, to use when determining the brightness of each pixel.  A pixel with no visible intensity will appear 

black, a saturated pixel will display at full brightness, and intensities in between will use a linear brightness gradient.

� Minimum Ratio and Maximum Ratio sliders which map a range of ratios to a colored legend.  The minimum ratio will display as red, the maximum ratio will display as magenta, and 

ratios in between will display with a color chosen from a smooth RGB gradient.  Pixels with a ratio less than the minimum will appear black, and pixels with a ratio greater than the 

maximum will appear white; white displayed at different brightness levels will appear as greyscale.

� Legend Overlay Position selections specify which corner of the image to display the ratio/color legend in, or hide it from view.

To free up more space on the screen, these controls can be hidden by pressing the tall green button that runs top to bottom between the image and the controls.

Information about an individual pixel can be viewed by hovering the cursor over the pixel and looking below the image.  Text there displays the X and Y pixel position of the cursor, and the 

ratio value for that pixel.

After a multiframe acquisition completes or a set of images is loaded from the file menu, Prairie View enters Playback mode indicated by the playback controls visible below the first image 

window.

An option in the Preferences menu allows the user to decide whether Playback will automatically open after an acquisition.  In order for the images to display, the raw acquisition data 

must have been converted to image files.  This can be done automatically after acquisition via an option in the Preferences menu, or manually via the ImageBlock Ripping Utility in the 

Tools menu.  If the images files have not been created when Playback opens, a message box will give the user the option to convert the files at that time. 

When in Playback mode, many controls associated with scanning become disabled until the playback mode is disabled by clicking Exit.

Playback	Controls

Depending on the data sequence selected, one or both of two scroll bars may be available: one vertical for Z stack data and one horizontal for time lapse data.

Each sequence or dataset represents a cycle of a TSeries, a simple ZSeries, or a single image.  It is possible to navigate datasets by selecting one from the dropdown menu to the right of 

the horizontal scroll bar, or by using the arrow buttons next to the dropdown menu.

If the number of frames is the same for all sequences in the open data set, then both scrolls bars become active.  The vertical scroll bar controls the selected frame while the horizontal 

scroll bar controls the selected sequence.

Arrows at the ends of the scroll bar allow the user to navigate in singleframe increments.

Next to each scroll bar is a set of five navigation buttons.    The doublearrow buttons jump to the first or last frame/sequence.  Singlearrow buttons play through the images 

in the indicated direction.  The square button stops any playback currently in progress.

The Loop checkbox will continue playback in the reverse direction when the last/first image is reached.  The Wrap checkbox will jump from the first to the last image or vice versa rather 

than reversing direction when the last/first frame is reached.

Playback Mode
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When playing through a set of images, the speed at which the images change is determined by the Delay text box (in milliseconds).  Enter a new number in this box to change the speed of 

playback.

When in Playback mode, information about the absolute and relative time of each frame's acquisition is displayed in the title bar of the Image window.

A text box in the lower right portion of the Playback window displays the file path for the acquisition.  The user can open the directory containing the acquisition by clicking the  button 

on the right side of the window.

The user may choose a previously defined After Scan Complete/Playback action from the Action dropdown menu and execute it by clicking the Perform button.  If the Perform Action box 

is checked, the action displayed in the dropdown menu will be executed every time the image in the Image window changes; that is, when changing slices in a ZSeries playback or 

changing time points or datasets in a TSeries playback.  Actions are described here.

The text box in the lower right corner of the playback controls will display an error message if the data set is corrupt due to missing samples at the time of the acquisition.  A red warning 

icon  will also appear in the lower right corner of the window.  Due to hardware constraints while acquiring multiple channels with heavy processing, it is not always possible to keep up 

with the data throughput.  Saving any heavy processing until after the data is acquired is a good practice in such cases.

While in Playback mode for a ZSeries dataset, the user can display projections of the images. This is discussed in the Maximum Intensity Projection section of this manual.

Metadata	Window

The Metadata window displays a tree view of information about system settings such as laser power, motor positions, and scan timing for each frame.  The Metadata window can be 

brought up at any time in playback mode by clicking Info.  A check box in the lower right corner of the Metadata window allows the user to specify that the Metadata window open 

automatically each time Playback is open.

Channel	Mapping	in	Playback	Mode

 The Metadata window provides controls for mapping data associated with a certain label and acquisition channel to a specific display channel.  The playback mapping is important when 

looking at an image set that was acquired using Labels; the channels active when acquiring images within a Label can be mapped to different display channels during playback.  

The default choice for channel mapping is "Original Source", which is the most intuitive choice and maps each channel of data to the channel in which it was acquired.  However, in some 

cases it can be useful to change this mapping when viewing the data.

Consider an example where a TSeries has been acquired using two different Labels (see further discussion in the Labels Tab section of this manual).  The Labels used in this experiment 

were named “Bright” and “Dim”, and each Label contained two active channels, 1 and 2.  The user may wish to map these four acquisition channels (Bright channel 1, Bright channel 2, 

Dim, channel 1, and Dim channel 2) to four different display channels to see them during playback.

While in Playback Mode for this TSeries, click the Info button on the right side of the Playback window.  This will open the Metadata window.  Across the top of this window are four drop

down menus which correspond to display channels 1 through 4.  In this example, the data acquired on channel 1 with Label Bright, called “Bright:1”, is mapped to appear in display channel 

1 for playback.
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Sometimes for a given sequence of frames there is no data for certain label:channel combinations so the image for that channel will remain unchanged.

The SFC settings are controlled in the SFC Settings window.  There are several different tabs for the components of the system and controlling the imaging parameters; these are described 

in the subsequent sections of this manual.

At the bottom of the window, an information bar provides status information about the system. From left to right, the information boxes report

� Temperature of the camera’s internal sensor, if supported by the camera

� Readout Mode of the camera, as defined in the Camera Settings of the SFC General tab

� Stopped or Moving status of the Aperture plate

� Stopped or Moving status of the Emission Filter wheel

� Galvo periods (cycles) per frame of the image; one period means two sweeps across the sample

The General tab includes the basic settings for creating an SFC scan, including apertures, filters, and camera settings.

The upper portion of this tab contains scan settings for the SFC.  The user can choose from 7 options in the Aperture dropdown menu.  There are 3 pinhole diameters and 4 slit widths 

available.  Each pinhole option is a linear array of 32 pinholes, which operate in parallel to perform a classic high resolution scan more quickly than a single point laser scanning 

microscope.  Each slit option is a single slit that can be used to scan the sample at much higher speed than the pinhole arrays, with slightly reduced confocality.  While the aperture plate is 

moving, the first motor indicator at the bottom of the window will change from “Stopped” to “Moving”. 

The Optimal Aperture field displays an aperture suggestion based on the current scan settings. This suggestion is calculated based on the excitation wavelengths in active channels and the 

magnification and numerical aperture of the selected objective lens.  The suggested aperture is the one whose size (diameter or width) is nearest to the Airy disc diameter calculated with 

this information.  No preference is given to the type of aperture (slit vs. pinhole).

The Emission Filter menu allows the user to select the filter positioned in front of the camera. When the emission filter wheel is moving, the second motor indicator at the bottom of the 

window will change from “Stopped” to “Moving”.

Galvo Mode describes the movement of the galvanometer in relation to image acquisition. Normal (Linear) mode is the standard operating mode, creating an image with uniform 

illumination using a linear galvanometer scan pattern.  Sinusoidal (Faster) mode increases the number of galvanometer sweeps per image during short exposure times, but can result in an 

image where the edges are brighter than the center.  Harmonic (Fastest) mode is useful with slit apertures to capture one image for every galvanometer sweep.  In this mode, frame rate is 

often limited by the transfer speed of the camera.  The minimum exposure time allowed by Prairie View is currently 1ms.  The number of galvanometer cycles per image is displayed in the 

bottom right corner of the window.

The Tweak Piezo P2PV field allows the user to make small changes in the peaktopeak voltage of the camera piezo.  Adjustment may be necessary if bright or dark stripes appear in the 

image.

The Synchronization Method describes the communication between the SFC and the camera. In Timed mode, the camera generates the scan trigger for the SFC, and the SFC attempts to 

match its scan frequency to the frequency of the trigger signal.  In Bulb mode, each of the camera’s exposures is controlled by a signal from the SFC Scan Control Box.  In general, Timed

mode is the preferred mode of operation, but some camera models may require the use of Bulb mode for certain acquisitions. 

Many cameras supported by Prairie View have two types of gain control, which amplify signal after it is acquired by the camera.  Options in the first Gain slider or menu determine the way 

signal is digitized – they describe the number of photoelectrons that make up one unit of digital signal.  The second gain control slider or menu allows the user to set the multiplication gain 

that is applied on the camera’s chip; this is called EM Gain.

SFC Settings Overview

General Tab
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The Port or Readout Mode menu offers choices for the speed at which the camera transmits data to the computer, with or without multiplication gain, denoted by “(M)”.  Faster readout 

rates allow faster frame rates, but may affect the dynamic range and read noise of the signal. The chosen readout mode is also displayed in the bottom of the window.

Exposure time is the amount of time the camera will collect photons from the sample for each active channel.  Due to galvanometer and piezo movements and blanking of the laser, the 

sample is illuminated for 7080% of the exposure time; the duty cycle depends on scan settings and galvo mode.  The Frame Period reported by Prairie View equals the exposure time 

multiplied by the number of active channels.  The minimum exposure time allowed is 1ms.

Use Splitter is an option available on systems configured with splitting optics for simultaneous collection of multiple channels of data using a single CCD or CMOS image sensor.  When the 

box is checked to enable this option, the software will separate a single camera image into multiple channels of data (either 2 or 4, depending on the splitting hardware).  More information 

is available in the Image Splitting Optics section of this manual.

The Binning menu allows the user to combine charge from adjacent camera pixels.  Increasing the binning factor will increase speed and signaltonose, but will decrease spatial resolution.

Preset Scan Configurations offer a quick pick for some common combinations of scan settings.

The SpectralSFC tab provides controls for imaging. 

Spectral	Imaging

The spectral imaging module is designed to allow for image collection with 15 channels of spectral resolution.  In spectral mode, each frame consists of 15 discrete images with each image 

representing a wavelength range of approximately 15 nm.  To enable this mode the user selects a pinhole aperture under the General tab of the SFC Settings window and checks the 

Enable Spectral Mode checkbox of the spectral tab.  The Amici prism must also be inserted into the light path of the Opterra scan head.

Calibration

The calibration procedure results in two files:  bands.txt and wavelengths.txt.  The user selects the desired calibration files by using the Load Bands and Load Wavelengths buttons.

The calibration shift allows the user to change the range of wavelengths assigned to the 15 channel range by shifting the range up or down by the specified number of bins.  A user may 

want to do this if the entire wavelength range of the fluorescence emission is not covered in the calibrated range.  

An example of this is as follows:

The calibration range is for the 15 channels is from 500nm to 725 nm.

The sample contains fluorophore A with emission peak at 475 nm.

The sample also contains fluorophore B with emission peak at 600 nm.  

Without shifting the calibration, fluorophore A would appear incorrectly in wavelength bin 14 because of spectral wraparound (475 nm is 2 spectral bins away from 500 nm, in a non

existent channel 2).  Fluorophore B would appear in spectral channel 7 (590 nm  605 nm)

To correct for this, the calibration should be shifted down at least 2 (shift should read 2) so that 475 nm is within the 15 channel range of wavelengths for the sample.  With a shift of 2, 

fluorophore A emission should be generated in spectral channel 1 (470nm  485 nm) and fluorophore B emission should be generated in spectral channel 9 (590  605 nm).  As a result of 

the shift, both fluorophores can be visualized simultaneously with in the 15 channel spectral range.

Note that if the shift is changed to an extreme where none of the fluorophores are contained within the range (for instance, a shift of 8 so that the range becomes 620 nm to 845 nm), the 

emission data would still appear for fluorophores A and B, but they would be in the wrappedaround positions as described with the fluorophore A case and the unshifted calibration.

Spectral	Interface

The spectral interface consists of 4 image window channels for visualization of the spectral data. C1 corresponds to the first image window channel, C2 the second image window channel, 

C3, the third image window channel and C4 the fourth image window channel.  

SpectralSFC Tab
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C1 through C4 contain the same realtime spectral histogram representing the amount of intensity data found in each spectral bin.  The graph is plotted as a difference from the mean 

intensity of all the spectral bins.  

To enable display of a range of spectral wavelengths, the user can the desired wavelength bins and left mouse click the bar of the plot.  Enabled spectral channels turn black while non

enabled channels remain transparent.  To deselect a bin, the user clicks the enabled spectral bin.

If multiple spectral bins are selected for an image window channel, the spectral bins are combined by either averaging or summing the pixel values together.  The mode can be selected by 

the drop down menu in the interface

Each image window channel consists of three buttons that control behavior for that channel.

Clear will clear all the bin selections so that no spectral bins are selected.

Auto will autoscale the lookup table for that image window channel.  This behaves the same as if the user clicks “Automatically Adjust Lookup Table Levels” on the Image window LUT 

context menu.

Reset will reset the lookup table for that image window channel.  This behaves the same as if the user clicks “Reset Lookup Table Levels” on the Image window LUT context menu.

Note:  All 15 channels of the spectral data are saved regardless of which channels are enabled for visualization.   

The Triggers tab allows the user to enable StartofFrame and/or EndofFrame triggers from the numbered Aux lines on the front of the SFC Scan Control electronics box.  For each line, the 

user can choose the type of trigger and the imaging channel(s) with which the trigger is associated. In the screen shot shown below, triggers will be sent out on Aux lines 1 and 2 at the end 

of every image on channel 1. 

If the system is configured with a piezo device controlled by Prairie View, one of the Aux lines may be used to trigger the piezo.  This line is chosen in the SFC/Camera/Filters tab of the 

Prairie Configuration Utility and then becomes unavailable for use in the Triggers tab.

The user may also designate one Aux line to receive triggers from other equipment.  This line is chosen in the SFC/Camera/Filters tab of the Prairie Configuration Utility and then becomes 

unavailable for use in the Triggers tab.  For systems configured with a GPIO box, it is often better to use the numbered Trig In lines on the GPIO box for input triggers; the switching 

hardware on these GPIO lines allows faster triggering than is possible on the SFC Aux lines.  If an SFC Aux line is configured for an input trigger, that is the only input trigger signal the 

software will monitor. If one is not configured, then the Trigger In connections on the GPIO box would be used as the input trigger.  That is, in order to use Trig In lines on the GPIO box, the 

SFC Aux lines must not be configured to accept input triggers.

The Scan Settings tab allows much finer control over the movements of the galvanometer and the piezos in the system.  These values are set by the installation technician and should only 

be adjusted under instructions from support personnel at Bruker Fluorescence Microscopy.

System administrators at some sites have been instructed on altering scan settings when putting a different camera on the SFC.  Adjustments can be made while following the procedures 

in the dialog activated by clicking the Alignment Instructions button.  Consult Bruker Fluorescence Microscopy support personnel before attempting this procedure for the first time.

After changes have been made, the user must select Update Scan Settings for the changes to take effect.

Triggers Tab

Scan Settings Tab

Page 61 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm



The Terminal tab can be used to send line commands to the SFC control box directly.  This can be useful for technicians and support personnel during installation or when troubleshooting 

problems with hardware and software.  Please contact Bruker Fluorescence Microscopy support personnel with questions about these commands.

Prairie View has support for software control of the automated features of certain Zeiss and Nikon microscopes.  If microscope is supported and Prairie View is configured to interface with 

it, a window will appear which contains software controls for the automated features.   If the window has been closed, the user can reopen it from the Tools menu.

Terminal Tab

Microscope Control Overview

Zeiss MTB Controls
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This window contains check boxes that allow the user to Lock the controls for individual motorized accessories on the microscope.  When a motorized accessory is locked, all of the 

controls for the motor are disabled (software controls, manual knobs, touchscreen interface) and the user will be unable to change the state of the accessory.

The Motors On/Off button toggles the motorized functionality of the entire microscope

Reflector Changer displays the current reflected light filter set in the motorized turret and allows the user to rotate the turret to a different filter set

Optovar displays whether the optovar is used and allows the user to change its state

Coded Nosepiece:  If an automated nosepiece turret is not present, this displays the objective lens name for the current nosepiece position.  If there is a matching objective lens name in 

Prairie View, the current objective will be changed to this value whenever the user manually changes the nosepiece position.

Motorized Nosepiece displays the current objective lens in the motorized nosepiece and allows the user to change the nosepiece position to a different objective lens.  If there is a 

matching objective lens name in Prairie View, the current objective in the Prairie View main control window will be changed to match this displayed value after the nosepiece position is 

changed.

TL Shutter opens/closes the transmitted light shutter

RL Shutter opens/closes the reflected light shutter

The TL Halogen Lamp slider allows the user to set the intensity of the transmitted light halogen lamp.  The On/Off button toggles its light output on and off.

The RL Halogen Lamp slider allows the user to set the intensity of the transmitted light halogen lamp.  The On/Off button toggles its light output on and off.

Sideport Turret displays the current light path in the microscope and allows the user to select a different light path

The Done button closes the window.  The user may display the window again by selecting Tools > Zeiss MTB Controls from the Tools menu on the main Prairie View window.

Nikon Eclipse Ti Controls

Page 63 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm



The Motorized Nosepiece dropdown menu allows the user to rotate the motorized nosepiece to put different objective lenses into the light path.  If the names of objective lenses in 

Prairie View match the names in this control, Prairie View will automatically change the current objective in the Prairie View main control window when the user changes the objective with 

Motorized Nosepiece control.   Objective names must be an exact match for this to occur.

Escape retracts the nosepiece away from the specimen to allow the nosepiece to rotate without risk of running the objective lens into the sample or XY stage

‘Escape’ before moving automatically performs an Escape when the user selects a different nosepiece position, and refocuses after the movement is complete

Refocus returns the nosepiece to the previous focal plane prior to using the Escape feature

If the system is configured with a Perfect Focus system, the Perfect Focus System slider allows the user to define the offset of the desired focal plane relative to the interface between the 

slide and the coverslip.  Memory records the current position of the slider, to which the user can return by clicking Recall.  The On/Off button allows the user to enable/disable the feature. 

Filter Block Cassette 1 displays the current motorized filter cassette turret position for the first cassette and allows the user to rotate the cassette to a new position

Filter Block Cassette 2 displays the current motorized filter cassette turret position for the second cassette and allows the user to rotate the cassette to a new position

Condenser Cassette displays the current condenser cassette position and allows the user to rotate the cassette to a new position

Light Path Drive displays the current light path configuration and allows the user to change the light path between the available options (e.g. 100% left port, 100% eyepiece observation, 

50% left port/50% eyepiece observation, etc.)

Transmitted Light allows the user to control the intensity of the light produced by the transmitted light lamp house.  The On/Off button controls the powered state of the lamp. Software 

Control puts the transmitted light under control of the software rather than the manual controls on the microscope. 

The Done button closes the window.  The user may display the window again by selecting Tools > Nikon Ti Controls in the Prairie View main control window.

The Prairie View main control window contains several menus containing additional software options and settings.  Menu items ending in “…” will open new dialogs when selected.  Menu 

items for features that can be enabled/disabled via the menu will have a check mark next to the item when the feature is enabled.  Menu options listed and/or available for selection may 

vary somewhat based on system configuration.

Load Image(s):  Allows the user to navigate to and load a saved acquisition

Load Recent Image(s):  Displays a list of recent acquisitions for loading, without the need to navigate to the directory in which the acquisition was saved

Load Configuration: Loads a system configuration file, recalling control settings of the laser(s), PMTs or camera, etc.

Save Configuration:  Saves a system configuration file using the current settings of the laser(s), PMTs or camera, etc.

Current Calibration File:  Displays the name of the current Uncaging Calibration file, with details of the calibration displayed in the submenu.

Load Uncaging Calibration:  Allows the user to navigate to and load a calibration file for the uncaging galvos, for use with Mark Points and Spiral Activation

Load Recent Uncaging Calibration:  Displays a list of recent uncaging galvo calibrations for loading, without the need to navigate to the directory in which the calibration file was saved

Load T-Series Settings:  Loads previously saved Tseries settings

Save T-Series Settings:  Saves the current Tseries settings to a file for recalling at a later time

Menus Overview

File Menu
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Load XY Stage Locations:  Loads a previously saved list of XY stage locations; this option is the same as clicking the Import Locations button on the XYStage tab.

Save XY Stage Locations:  Saves the current list of XY stage locations this option is the same as clicking the Export Locations button on the XYStage tab.

Exit:  Stops Prairie View and closes the program

Adjust MAMC Stage Controller vs Optical Zoom: This feature changes the responsiveness of the remote knobs controlling stage movements when an optical zoom is applied. When Fine 

is selected, then as the optical zoom is increased from 1.0, the number of motor steps generated when the X or Y axis wheels are turned will be decreased to better match the stage 

movement with the current field of view.  When Coarse is selected, a similar affect as with the ‘Fine’ option will occur, but to a lesser degree.  When No Adjustment is selected, then the 

number of motor steps generated by the X or Y axis wheels will not be modified as the optical zoom is changed.

Automatically Start Playback After Acquisition: When enabled, this option will open the last acquisition in Playback mode once it has completed.

Automatically Convert Raw Files:  Allows the user to choose whether or not data is automatically written to TIFF, CSV, and/or SDT files after an acquisition.  

Fluorescence Lifetime Imaging (FLIM):  Options in this submenu allow the user to determine aspects of file handling during acquisitions made in FLIM mode.

Leave Soft Shutter Open:  When available, this option holds the Pockels output at the value determined in the Laser, PMT, DAQ tab at all times, rather than "blanking" the laser power 

between scans or between lines in within a scan.  This option is only supported for particular configurations.  Please contact Bruker Fluorescence Microscopy support personnel with 

questions about this feature.

Preserve User-Modified File Names:  Causes Prairie View to retain the file names entered in the fields for saving ZSeries, TSeries, and Single Scan, Voltage Recording, and other types of 

acquisition files.  This option prevents these names from reverting to the default values the next time Prairie View is started.

Use 12-bit Sampling:  On a system with a Resonant Scanner, the user may choose to digitize data on a 12bit scale to match that of systems without a Resonant Scanner.  When this option 

is not enabled, Resonant Scanner system acquire images with 13bit sampling (in Galvo, Spiral, and Resonant modes).

Nyquist Sampling:  Opens a dialog in which users determine preferences for the calculations used in the Nyquist Sampling feature found in the Tools menu.

Output Trigger Type:  Allows the user to determine which frame triggers are generated by the system during acquisition.

Save/Recall LUT settings:  Retains the LookUp Table settings when Prairie View is exited, to be recalled the next time Prairie View is started 

Save Images Generated With Photoactivation:  When enabled, TIFF files are created for scans that used Photoactivation Masks.

T-Series:  Opens the TSeries Preferences dialog.

Z-Series:  Opens the ZSeries Preferences dialog.

Adjust Focus with Mouse Wheel:  This option allows the user to move the Z device by scrolling with the mouse wheel.  To use this feature, first enable the option in the Preferences menu. 

Then left click in an Image window to bring software focus to that window; the title bar of that window will change color to reflect its active status.  The size of the movement per 

increment of the mouse wheel is determined by the Z step defined in the Stage Control section of the Main Control window.

Use Smaller XML File Format:   The XML file contains all the metadata describing an acquisition. The smaller version of this file contains all scan information while minimizing duplication; 

this format allows very large data sets to be reloaded into Prairie View software.  The legacy version of the XML file is much larger and contains many duplications, leading to file sizes that 

are difficult to load for viewing later.  The option to use the older, larger file format exists to preserve compatibility with certain thirdparty analysis programs.

During acquisition, data is streamed to one or more raw files.  This allows the system to devote resources to preserving the integrity of the data stream, while delaying most of the 

processing until acquisition is complete.

Options in this submenu allow the user to choose when the raw files are converted to their final formats (TIFF, CSV, or SDT files, depending on the type of acquisition).

Never (Use Image-Block Ripping Utility):  Files will not be converted automatically.  The images and other files must be converted later using the standalone ImageBlock Ripping Utility.  

This option minimizes the processing overhead at the end of an acquisition, and therefore minimizes the time before the next acquisition can begin.

After Acquisition:  This is the most commonly chosen conversion option.  All images and other data are kept as raw files until the acquisition (TSeries, ZSeries, other), and then converted 

at the end of the acquisition.  Note that long acquisitions may require several minutes to convert; during this time the user cannot start another acquisition.

During Acquisition (May Affect Data Integrity!):  Raw files will be converted as the acquisition progresses.  This means that users can access newly acquired images while an acquisition is 

still in progress.  TSeries images acquired with the Max Speed option enabled will be converted at the end of the Max Speed cycle.  Note that this option diverts some resources from data 

acquisition to processing, so there is a possibility that incoming data could be lost.  Watch for warning messages during the acquisition or in Playback Mode that alert the user to lost data.

Users of systems with solid state drives (SSDs) are advised to have their Save Path set to the drive letter of the solid state drive (typically the E: drive) and to have the automatic conversion 

turned off.  The data should be moved onto the system (C:) drive and then converted to TIFF images there using the ImageBlock Ripping Utility.  This reduces the amount of data being 

written to the SSD, prolonging its useful lifetime.

The SDT file format is used by SPCImage (Becker & Hickl’s FLIM analysis software) to analyze FLIM data.  If the Preferences menu option to Automatically Convert Raw Files enabled, FLIM 

data is converted to SDT files immediately after the FLIM acquisition is finished.  If this option is not checked, then PrairieView creates a batch file in the same folder as the one containing 

the FLIM raw data.  Running the batch file would convert the raw data into SDT file.

Additional options in the Preferences > FLIM submenu provide additional controls for file handling.

Compress SDT files:

SDT files contain multidimensional FLIM data which leads to large file sizes.  However, this data can be compressed to save disk space without any loss.  If this option is checked, SDT files 

are compressed as they are created.

Keep Raw Data Files:

When this option is checked, the raw FLIM data is not deleted after SDT file creation. This can be used in cases where the user wants to analyze the FLIM data in different software (from 

SPCImage).

Preferences Menu

Automatically Convert Raw Files

Fluorescence Lifetime Imaging (FLIM)
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Photon Counting Only:

When this option is checked, the system operates in the Photon Counting Mode.  In this mode, no SDT file is created and the system does not record the fluorescence lifetime data.  

Instead, the system generates TIFF images, where the intensity of each pixel corresponds to the number of photons detected at that location.

Prairie View can automatically generate frame triggers during an acquisition.  These triggers can be used internally to synchronize imaging with other Prairie View modules such as Voltage 

Output, Mark Points, Voltage Recording, etc.  The triggers can also be used externally by hardware from Bruker Fluorescence Microscopy or other companies.

In some system configurations, external frame triggers are required to run particular pieces of hardware.  Do not disconnect frame trigger signals that run between electronics boxes on 

the Prairie system.  If the frame trigger port is already in use, add a Tconnector to split the signal rather than severing the connection between existing Prairie control boxes.

Galvo, Spiral, and AOD modes

The frame trigger is a 5 Volt signal.  The rising edge of the signal marks the time of the trigger. The signal will remain high until being pulled back to 0 Volts briefly before the next rising 

edge.

The user can choose what triggers are generated via the Preferences menu.

The hardware present for generating and counting frame triggers allows any two of three functions to happen simultaneously.  The three possible functions are:

� Generate Start of Frame triggers

� Generate End of Frame triggers

� Count frame triggers internally (for Voltage Output, Mark Points, Voltage Recording, etc.)

To generate Start of Frame triggers and count frames internally, enable the following:

� Preferences > Output Trigger Type > Trigger Mode > Generate Start of Frame OR End of Frame Trigger OR Neither (the middle option in the submenu)

� Preferences > Output Trigger Type > Start of Frame Trigger

Trigger signals are used internally and also sent out via PCI6713 FTO on the front of the GPIO box.

To generate End of Frame triggers and count frames internally, enable the following:

� Preferences > Output Trigger Type > Trigger Mode > Generate Start of Frame OR End of Frame Trigger OR Neither (the middle option in the submenu)

� Preferences > Output Trigger Type > End of Frame Trigger

Trigger signals are used internally and also sent out via PCI6713 FTO on the front of the GPIO box.

To generate both Start of Frame and End of Frame triggers and disable internal frame counting, enable the following (note that this means that modules within Prairie View cannot be 

started on particular frame counts):

� Preferences > Output Trigger Type > Trigger Mode > Generate Start of Frame AND/OR End of Frame Trigger OR Neither (the last option in the submenu)

� Preferences > Output Trigger Type > Start of Frame Trigger

� Preferences > Output Trigger Type > End of Frame Trigger

Start of Frame triggers are sent out via PCI6052 FTO on the front of the GPIO box.

End of Frame triggers are sent out via PCI6713 FTO on the front of the GPIO box.

To generate no frame triggers, the user can disable both the Start of Frame and the End of Frame triggers, or choose Generate No Trigger from the Trigger Mode submenu.

Resonant mode

When imaging in Resonant mode, frame triggers are generated by the Resonant Scanner control box rather than the GPIO box.

The signals are held at 0 Volts, and the rising edge of a short pulse of 5 Volt pulse marks the frame trigger.

Both Start of Frame and End of Frame triggers are always generated by this box.  The signals are routed out of Start of Frame Out and End of Frame Out on the back of the Resonant 

Scanner control box.

The End of Frame signal is routed back to the GPIO box (via a BNC cable) for internal counting of frames by Voltage Output, Mark Points, Voltage Recording, and other software modules.

SFC mode

Frame triggers can be generated by the SFC control box and accessed from one or more AUX ports on the front of that box.  This is described in the SFC Settings  Triggers Tab section of 

this manual.

Some cameras generate trigger signals, which can be accessed via ports on the camera itself.

Camera mode

In this mode, no frame triggers are generated by Prairie View software.  Some cameras generate trigger signals, which can be accessed via ports on the camera itself.

Output Trigger Type

Nyquist Sampling Preferences
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The Nyquist Sampling tool will automatically adjust the scan settings so that the XY pixel size and z step size will satisfy the Nyquist sampling theorem.  A dialog in the Preferences menu 

allows the user to configure parameters used by the Nyquist Sampling feature.

Parameter Adjustment Selection allows the operator to choose what changes are made to satisfy the Nyquist sampling theorem.  There are two methods for getting the desired pixel size. 

One is to adjust the number of pixels in the XY image; the other is to adjust the optical zoom. The option specified determines the first parameter to be adjusted when setting the Nyquist 

sampling values.  Depending on the current system configuration, both the number of pixels and the optical zoom may need to be adjusted.   For example, if optical zoom was specified, 

but the computed optical zoom would be less than 1.0 (the system minimum), then the number of image pixels would also be changed to achieve the desired pixel size. 

Laser Type specifies the laser source to be used for the Nyquist calculations. There is a difference in the equations used if the imaging is done with 2P (two photon) versus a 1P (single 

photon) excitation. 

Over Sample Constant specifies the factor by which the pixel density will exceed the theoretical limit of resolution.  The Nyquist sampling theorem requires sampling a minimum of two 

pixels for the smallest resolvable feature.  The user can choose an Over Sample Constant from 2.0 to 4.0. 

Always Prompt for Laser Type and Wavelength? specifies whether or not a dialog should appear to collect the desired wavelength value and laser type (1P or 2P) when the Nyquist 

option is invoked. This option is particularly useful with system configurations that include both 1P and 2P lasers, as the software won’t know in advance what wavelength to use.   This 

selection will also be used as the default for the Laser Type in the Tools menu dialog for Nyquist Sampling.

If More Than One 2P Laser is Present use the Wavelength of Laser is only active if the system has more than one 2P laser being controlled by Prairie View.  If more than one laser is being 

controlled by Prairie View, then this will specify which laser to use for determining the wavelength for the Nyquist sampling calculation.

The TSeries Preferences dialog (Preferences > TSeries) contains options that affect the display update and file saving during acquisitions.  

T-Series	Execution	Order

In cases where the number of TSeries Iterations is greater than 1 AND the Run at all XYZ stage locations box is checked, the order of operations in a TSeries can be chosen by the user.  

The dialog contains graphical representations of the TSeries Execution Order.  The Iteration Period designation in the execution order options indicates at which layer of operations the 

Period for iterations is applied.

Consider as an example a TSeries which contains 5 cycles totaling 3 minutes, 2 iterations, the Run at all XYZ stage locations box is checked, 4 stage locations are saved, and the Period is 

set to 3600 seconds.  The option selected in the screen shot above is “For each Iteration, At Each Stage Location, Run TSeries Cycles”, with “Wait for Iteration Period” at the Iteration 

level.  This means that the 5 cycles would be performed at the first stage location, then the second stage location, etc, and then the system would drive back to the first stage location.  The 

3600 second period would be applied at the iteration level, so after a total of 3600 seconds (including acquisition time), the whole cycles/stage locations acquisition would be repeated as 

the second iteration.The top portion of the TSeries Preferences window contains options for the TSeries Execution Order, described elsewhere in this manual.

Additional	Options

The Execute TSeries Sequentially (only queue one cycle at a time) option, when enabled, forces the software to prepare each cycle as it is run.  Note that enabling this option can result in 

increased delay time between TSeries cycles.  Most experiments are best run with this option disabled, so the software can prepare the list of cycles before beginning acquisition, and 

minimize the intercycle delay time.  This option needs only be checked if very specific types of Tseries are being executed.  This would primarily pertain to Tseries where some aspect of a 

given cycle is affected by a preceding cycle, such as Script commands for dynamic changes to an existing ZSeries definition.  Contact Bruker Fluorescence Microscopy personnel for 

assistance with complex scripting within a TSeries, and the use of this option.  

The Update display during max speed acquisitions option determines whether the Image window is updated during an imaging sequence with the Max Speed option is checked.  It can be 

useful to disable the update on older computers to save resources for acquisition, but the option can safely be left enabled on most systems.

Additional selections in the Preferences menu pertain to TSeries acquisitions.

The user can choose whether or not data is automatically written to TIFFs after a TSeries with the Preferences menu options to Automatically Convert Raw Files.  If images are not 

automatically converted, there is less processing overhead at the end of the TSeries before another image can be acquired.  The images can be converted later using the standalone 

T-Series Preferences
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ImageBlock Ripping Utility.  Users of systems with solid state drives (SSDs) are advised to have their Save Path set to the drive letter of the solid state drive (typically the E: drive) and to 

have the automatic conversion turned off.  The data should be moved onto the system (C:) drive and then converted to TIFF images there using the ImageBlock Ripping Utility.  This 

reduces the amount of data being written to the SSD, prolonging its useful lifetime.

When files are automatically converted after a TSeries, the user can also choose whether to review TSeries data immediately after conversion.  This is accomplished using the 

Automatically Start Playback After Acquisition option in the Preferences menu.

The Z-Series Preferences dialog is accessed through the Preferences menu in the Prairie View main control window (Preferences > Z-Series).

The Z Motor Position After Z-Series drop-down menu provides options for the position of the Z device after the Z-Series is completed.  This setting will also determine the Z device position 

after executing a Z-Series from within a T-Series.  Note that these settings can be useful to users performing Z-Series acquisitions while holding a patch pipette in place – a delicate patch 

could be severed when a motor makes a large movement, and by choosing to leave the Z device at the Stop position after a Z-Series, the user can prevent the motor from making a large 

movement at the end of the acquisition.

A second drop-down menu allows the user to link the Z Device controls on systems configured with multiple Z devices; this is described in the Using Multiple Z Devices section of this 

manual.

The Align Z-Series center to stage location and Align Z-Series start to stage location checkboxes allow the user to choose whether saved coordinates are used as the center or start of 

a Z-Series (when performing a Z-Series at multiple X,Y stage locations).

The Disable resonant phase offset correction option determines whether resonant scanning systems automatically adjust phase offset during a Z-Series.  When collecting slices above 
and below the main slices of interest, there may not be enough clearly-defined features in the sample for the automatic offset to function.  This can result in image artifacts from automatic 
correction. See additional information in the Resonant Phase Offset section of this manual.

Notes:  Opens an empty window for users to enter notes. These notes will be saved with each subsequent saved image, and will be displayed in the Metadata window during Playback.

Nyquist Sampling: Adjusts the scan settings to minimize oversampling and optimize spatial acquisition parameters.

Fluorescence Unmixing: Opens a control panel for adjustment of signal data between the channels.

Zeiss MTB Controls:  Opens a dialog for controlling motorized components of a Zeiss microscope stand.

Nikon Ti Controls:  Opens a dialog for controlling motorized components of a Nikon Ti microscope stand.

Fluorescence Lifetime Imaging (FLIM):  Opens a dialog of controls and parameters relevant to acquisition in FLIM mode.

Scripts:  Scripts are commands that allow the user to customize an operation to perform during an experiment.  The items in this submenu allow the user to create, run, and abort Scripts.

Actions: Brings up access to creating sets of external commands to use within Prairie View for the controlling of data import and export.

Calibration/Alignment:  Options in this submenu allow users to set up and modify softwarecontrolled calibrations.  Individual options are described elsewhere in this manual.

Reset:  Options in this submenu allow the user to reset the connection to listed components in the event of a failure.  Components may include a Dodt Controller, MAMC, and 

Preamplifier.  

Scan Settings: Brings up a panel of settings for the scan parameters of the system.  These settings should only be changed by Prairie personnel.  These settings are not intended for 

operator use. 

Maintenance:  Opens a dialog allowing independent control of shutters and galvanometers, for use during installation, alignment, and troubleshooting.

Nyquist Sampling will automatically adjust the scan settings so that the pixel size will satisfy the Nyquist sampling theorem as well as the z step size for ZSeries acquisitions. The reasoning 

behind this is to set up the spatial acquisition parameters (x, y, and z) for optimal image data collection. These system settings will help to eliminate unnecessary over sampling of the data 

and protect against under sampling of the data.

Preferences associated with the Nyquist Sampling tool can be accessed by the user via the Preferences menu (Preferences > Nyquist Sampling).

The Nyquist sampling algorithm is invoked by selecting Tools > Nyquist Sampling or by pressing <F9>.

After invoking Nyquist sampling, if the currently selected objective lens has not been calibrated, a message box will display the necessary corrective action. 

If the currently selected objective lens is calibrated and one or more of the following are true, then a dialog will appear to collect the wavelength to use for the Nyquist sampling 

calculation:

���� The laser source is 1P, or

� The laser source is 2P and not being controlled by Prairie View, or

� Always Prompt for Laser Type and Wavelength? is checked in the Nyquist Sampling Preferences dialog

The dialog will also allow the laser type (1P or 2P) to be specified.

If Cancel is pressed then no changes will be made.

Once OK is pressed, the system settings will change as necessary. 

Z-Series Preferences

Tools Menu

Nyquist Sampling
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If the currently selected objective lens is calibrated and the laser source is 2P and the laser is being controlled by Prairie View, then the system settings will change as necessary without 

any further interaction. 

In addition to adjusting the number of pixels in the x and y dimensions and/or the optical zoom, the Nyquist sampling logic will also set the proper Zseries step size.   This adjustment will 

happen only if the radio box next to the ‘Step Size’ IS NOT set to ‘Calculate’ on the ZSeries tab.

Equations

The equations for determining the desired pixel size or z step size are as follows: 

For a 1P laser:

Desired x and y pixel size (in nanometers) = ((0.61 * λ) / NA) / OS 

Desired z step size (in nanometers) = (((0.61 * λ) / NA) / OS) * (π / NA) 

For a 2P laser:

Desired x and y pixel size (in nanometers) = ((0.61 * (λ / sqrt(2))) / NA) / OS 

Desired z step size (in nanometers) = (((0.61 * (λ / sqrt(2))) / NA) / OS) * (π / NA) 

Where λ is the specified laser wavelength in nanometers, NA is the numerical aperture of the current objective lens, OS is the Over Sample Constant specified by the user, and sqrt(2) is the 

square root of two. 

When Fluorescence Unmixing is selected, a userdefined percentage of the intensity of one channel is subtracted from that channel and added to another original channel.  This enables 

the user to correct for bleedthrough of signals from one channel to another.

By checking Enable, the fluorescence unmixing for that line will be applied.

The Source Channel is the channel to which the subtracted signal will be added, while the Channel to Subtract From will be the channel the signal is removed from.

The Percentage slider allows the operator to control the amount of the Source Channel signal to be subtracted from the Channel to Subtract From.

These controls will work either on a static image (acquired with Single Scan) or while in Live Scan mode. This altered image cannot be saved.

Consider the following example.  There is bleedthrough of Channel 1 into Channel 2.  The goal is to subtract out the Channel 1 signal from Channel 2 and add it back to Channel 1:

1.    Place a check in the box in the Enable column for one line of unmixing controls

2.    Set the Source Channel to Channel 1

3.    Set the Channel to Subtract From to Channel 2

4.    While acquiring a Live Scan or after having acquired the images on Channels 1 and 2 with a Single Scan, slowly move the Percentage control up.  The signal from Channel 1 that is 

present in Channel 2 should diminish.  At the same time, the signal in Channel 1 should increase by the same amount as this data is recovered into Channel 1.

One idea on how to do this visually so that not too much signal is subtracted from Channel 2 is to place Channel 2 into Range Check color mode, and then as the Percentage slider is 

increased, some blue (zero intensity) pixels will show in the area where Channel 1 was bleeding into Channel 2.  This shows that the right amount of Channel 1 has been subtracted from 

Channel 2.

All images acquired while Fluorescence Unmixing is enabled will have the unmixing applied.  

Fluorescence Unmixing

Fluorescence Lifetime Imaging (FLIM)
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TAC (Time to Amplitude Converter) Settings:  This section is used to change different TAC parameters. The default values for Range and Gain are 50 and 10 respectively. The Offset is set 

to position the TAC range on the TAC characteristics. TAC contains a window discriminator to suppress values outside the range defined by Limit Low and Limit High. 

CFD (Constant Fraction Discriminator) settings:   This section is used to set the CFD parameters. The signal into CFD comes from the detector. Any pulses below the Limit Low are ignored.  

ZC Level is set to avoid spurious triggering because of noise; its ideal value is 0 but a practical value is around 10mV.

SYNC (Synchronous) settings:  This section is used to set the SYNC parameters. This signal comes from the excitation source.  Any pulses below the ‘Threshold’ are ignored.  ZC Level is set 

to avoid spurious triggering because of noise; its ideal value is 0 but a practical value is around 10mV.

ADC (Analog to Digital Converter) Resolution:  This defines the number of time bins per laser pulse period.  The higher the ADC resolution, the greater is the number of time bins but the 

lower is the number of counts per time bin.  A default value of 8 bits (256 time bins) is used.

Dither Range:  This is used in error correction during the ADC operation.  It is set to a default value of 1/16.

Latch Delay:  For dual channel FLIM systems, a router is used to indicate the channel generating the data. The router adds a delay to the electronics.  This parameter is set to 0nsec for 

single channel FLIM and 20nsec for dual channel FLIM systems.

Photon Intensity:  This is used for live display of fluorescence data during a FLIM acquisition. Intensity at each pixel is given by Photon intensity multiplied by the number of photons at that 

pixel.

Additional information about FLIM can be found in the in the discussion of FLIM preferences.

Scripts are commands that allow the user to customize an operation to perform during an experiment.  They are essentially a programming language embedded in Prairie View to expand 

functionality without cluttering up the interface.  A Script could change laser power, find a particular slice of a ZSeries, or do any number of other things.

Script controls are accessed from the Tools menu.  The Scripts submenu will expand as scripts are defined, to allow the user to run and abort Scripts through the menu options.

Defining	a	Script

Scripts are defined in the dialog opened by the Edit Scripts menu option (Tools > Scripts > Edit Scripts).  

Script definitions are divided into Categories, which are listed on the left side of the window.  A Category could be a particular experiment in which the script would be used, the name of 

the user who defined the Script, or the type of command used in the Script (PMT, Stage, Laser, etc.). Categories can be added or deleted via buttons below the list of existing Categories.

When a Category has been selected, the Scripts within that category will be displayed in a list in the middle of the window.  Scripts can be added or deleted via the buttons below the list of 

Scripts.

The command(s) within the selected Script are defined in the Select a Script box on the right side of the window.  Clicking the Edit Script button allows the user to type in the box to add or 

change commands.  Detailed information about scripting commands can be accessed from within this window by clicking Need help with scripting commands? at the bottom of the 

window.

To test a Script, select it from the list and click the Run Script button.  Status messages in the box below the editor report the time and status of each Script run from the editor.

After defining or editing Scripts, click the Accept button to close the Edit Scripts window. Clicking Cancel will close the window without saving the additions and changes made during that 

session.

Running	a	Script

A Script can be run directly from the Edit Scripts window by clicking the Run Script button.  This can be useful when testing a newly defined script.

A Script can be run from the Tools menu by selecting it from a submenu defined by the Category.

A Script can be run during a TSeries by adding a Script cycle to that TSeries and then selecting the previouslydefined Script from the dropdown menu for the cycle.

The Quick Execute option in the Scripts menu opens a dialog in which the user can assign up to 10 Scripts to individual Run Script buttons.  This dialog can be left open for easy access to 

the chosen Scripts.  The Abort button at the bottom of the dialog allows the user to stop the Script.

Scripts
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Stopping	a	Script

If a Script was started from the Tools menu, it can be stopped using the Abort option in the Script submenu (Tools > Scripts > Abort).  When using the Quick Script Execute dialog to run a 

Script, use the Abort button at the bottom of the dialog.

This section of the Help file is under construction and has not been updated recently.  The information below is from a previous version of the manual and may be somewhat outdated. 

Please contact Bruker Fluorescence Microscopy support personnel with questions about these features.

Actions are external programs or scripts used to automate repetitive tasks. There are two types of actions: actions and rules.  Actions perform a task; rules determine another action to 

perform based on some criterion.

An Action consists of a Name, a Filename, and set of Arguments.  The Name is used to identify the action from others and give some indication of its behavior.  Actions will be referenced 

by their names throughout the application.  The Filename is the path to the program or script which will be executed.  For example "notepad" would launch a text editor.  Arguments make 

up a list of arguments passed to the program or script specified.  The arguments can contain tokens specified to the left of the text box; for example in the argument “<image:ch#> = .TIF 

File”,  “<image:ch1>” would be replaced by the path and filename for the image containing the data for channel one.

A Rule consists of a list of criteria with corresponding actions to perform if the criterion for a given line is met.  For example, a rule may define that a particular action be performed each 

time a Single Scan is executed.  A rule can point to another rule, but if a rule references itself directly or indirectly it will terminate rather than continue in an infinite loop.  When 

generating a rule, buttons to the right of the grid allow lines in the rule to be moved up or down or removed.

Types of Actions

There are a number of different types of actions available in different places throughout the application.  Some of these types are described below:

After Frame Complete actions are run automatically after a frame is acquired with the exception of max speed acquisitions.  In order for an After Frame Complete action to be performed it 

must first be specified on the Misc tab of the Prairie View main control window. The only token available for use in the arguments field is '<image:ch#>' where '#' is replaced by a channel 

number 14.  This token will be replaced by the path and filename of the image containing the channel data for the frame that just completed.

After Scan Complete/Playback actions are run automatically after a scan has completed.  In order for an After Scan Complete action to be performed it must first be specified on the Misc 

tab of the Prairie View main control window.  After scan complete actions are also available to be performed manually in playback mode from the image window.  Rule type actions are 

disallowed in this context.  The only token available for use in the arguments field is “<metadata>”.  This token will be replaced by the path and filename of the metadata file associated 

with the scan which has just completed (or the scan which is currently open in playback mode).  The metadata file is in an XML format and contains all information about the scan.  The 

program or script specified must be able to parse the metadata file in order to retrieve scan data.

Actions
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Freehand Linescan Path Generation actions are run manually from the Linescan Control dialog and are used to automatically generate freehand line scan paths based on the current image 

data.

There are two tokens available for use in the arguments field:

'<image:ch#>' where '#' is replaced by a channel number 14. This token will be replaced by the path and filename of the image containing the current image data for the channel specified.

'<outfile>' which replaced by the path and filename of a temporary file created to pass line scan path data from the program or script specified into Prairie View.

The format of the output file is a comma delimited list of points that make up the path to line scan.  Each point is made up of an X and Y coordinate again separated by a comma that range 

from 0.0,0.0 (upper left corner) to 1.0,1.0 (lower right corner).

Brightness Over Time Region Generation actions are run manually from the Brightness Over Time dialog and are used to automatically generate brightness over time regions based on the 

current image data. There are two tokens available for use in the arguments field:

'<image:ch#>' where '#' is replaced by a channel number 14. This token will be replaced by the path and filename of the image containing the current image data for the channel specified.

'<outfile>' which replaced by the path and filename of a temporary file created to pass region data from the program or script specified into Prairie View.

The format of the output file is a comma delimited list of vertices that make up polygon based regions.  Each vertex is made up of an X and Y coordinate again separated by a comma that 

range from 0.0,0.0 (upper left corner) to 1.0,1.0 (lower right corner).  Each polygon is terminated by the channel number the region should be created for prefixed by a '' (minus sign).

For example an output file which would create a square region in the center for channel two and a triangle above it for channel one would look something like .3,.5,.7,.5,.7,.8,.3,.8,

2,.2,.5,.5,.2,.8,.5,1 and will look something like the following when loaded:

Mark Points Point Generation actions are run manually from the Mark Points dialog and are used to automatically generate a set of points to mark based on the current image data. There 

are two tokens available for use in the arguments field:

'<image:ch#>' where '#' is replaced by a channel number 14. This token will be replaced by the path and filename of the image containing the current image data for the channel specified.

'<outfile>' which replaced by the path and filename of a temporary file created to pass point data from the program or script specified into Prairie View.

The format of the output file is a comma delimited list of points that make up the path to line scan.  Each point is made up of an X and Y coordinate again separated by a comma that range 

from 0.0,0.0 (upper left corner) to 1.0,1.0 (lower right corner).

Photoactivation Mask Generation actions are run manually from the image window when the Photoactivation mask editor is enabled and are used to automatically generate photo 

activation masks based on the current image data. There are two tokens available for use in the arguments field:

'<image:ch#>' where '#' is replaced by a channel number 14. This token will be replaced by the path and filename of the image containing the current image data for the channel specified.

'<outfile>' which replaced by the path and filename of a temporary file created to pass mask data from the program or script specified into Prairie View.

The format of the output file is a comma delimited list of vertices that make up polygon based regions.  Each vertex is made up of an X and Y coordinate again separated by a comma that 

range from 0.0,0.0 (upper left corner) to 1.0,1.0 (lower right corner).  Each polygon is terminated by the palette number the polygon should use when added to the current mask prefixed 

by a '' (minus sign).

For example an output file which would create a square region in the center using palette two and a triangle above it using palette one would look something like .3,.5,.7,.5,.7,.8,.3,.8,

2,.2,.5,.5,.2,.8,.5,1 and will look something like the following when loaded:
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Application Menu Extensions actions are run manually from the Applications menu on the Prairie View main control window. Actions defined here will added to the menu and add the 

ability to launch other applications directly from Prairie View.

Actions Using MATLAB

Actions can make use of any number of third party tools one of which is MATLAB. Unfortunately, MATLAB does not provide command line support so an intermediary program has been 

provided, PrairieMLL.exe (Prairie MATLAB Link).  To use this program in an action, select PrairieMLL.exe as the Filename (should be found in the same directory as Prairie View.exe) and 

add any number of MATLAB commands in double quotation marks in the Arguments field.

For example, to display channel one in MATLAB after each frame, the arguments would be something like: "image = imread('<image:ch1>')" "imagesc(image)" "colormap(gray)" "axis

('square')" "axis('off')"  It is also possible to reference M files by changing to the directory where the M file is found.  For example, if the command in the previous example were found in 

"C:\ShowImage.m" then the arguments would be something like: "cd c:\\" "ShowImage('<image:ch1>')"

Once run, PrairieMLL.exe continues to run until explicitly terminated.  This allows it to continue to use the same MATLAB command window, saving the time required to load a new 

command window each time as well as preserving the state in the command window allowing variables to be saved and referenced again between actions.  To terminate PrairieMLL.exe, 

pass \x as an argument. Once the \x argument is reached PrairieMLL.exe will stop running any other commands passed after the \x and will close the MATLAB command window it was 

using. Calling PrairieMLL.exe again afterwards will create a new MATLAB command window and execute commands normally.

Uncaging Galvo Calibration:  Opens a dialog with stepbystep instructions for calibrating photostimulation galvo positions to locations in the image.  Note that all beam alignment must be 

done before performing this software calibration.

Objective Lens/FOV Calibration:  Opens a dialog for calibrating the field of view for objectives.

1P Pinhole: If a 1P Confocal pinhole detector is present on the system, this option opens a control dialog for the pinhole motors. 

2P Laser Power Calibration: Opens a dialog box for calibrating the power output from the Pockels cell to the power output from the laser cavity for mW control of laser power at the 

sample.

Photoactivation Alignment:  If the system is configured with a Camera or SFC and a photoactivation module, this option opens a dialog to adjust the scan rotation of the photoactivation 

scan relative to the imaging scan.

Manually Tune Piezo:  This option opens a dialog with stepbystep instructions for tuning a Zpiezo device manufactured by Prairie Technologies.  It is not frequently used after initial 

installation.

Autocalibrate Piezo Focus:  This option automatically maps the limits of the piezo for the current conditions.  Calibration should be performed when switching between objectives of 

significantly different mass, or when switching between samples of very low and very high viscosity.  Note that this calibration is different from that performed in the ZSeries tab, which 

uses a feedback algorithm to determine the drive signal needed to perform a specific ZSeries.

Center Galvos: When selected, Center Galvos will apply a zero voltage to the imaging and uncaging galvos for the purpose of checking alignment.  Clicking again to deactivate this option 

will return the galvos to their park positions. 

The uncaging calibration wizard provides a series of steps to calibrate the galvanometers used for uncaging to accurately point at specific locations in the imaging field of view. 

The result of the calibration process is a map that relates voltage values for the photostimulation galvanometers to pixel locations on the image.  This map is then used by the Mark Points

and Spiral Activation features for a fast method by which the user can specify a location on the image at which to direct the photostimulation.

 Note that all beam alignment must be done before performing this software calibration.

Step	One:	Select	the	Calibration	Method

Multiple methods of calibration are available in the software. The best method to use will depend on the system configuration.

The Burn Spots method involves burning visible spots onto a uniform sample. Any system with uncaging capabilities can use this method.  This method is also very robust in that it can be 

Calibration/Alignment

Uncaging Galvo Calibration
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performed on almost any sample that can be visibly affected by the uncaging beam.

The Spot Detector method involves looking at a reflection of the uncaging beam, which requires a specific light path and hardware be present on the system.  This method is only possible 

for Ultima systems with an IR laser on the uncaging path. The benefit of this method over other methods is that it does not require changing the sample, although it is a good idea to push 

the trinoc plunger in, as if to use the eyepieces, to block any uncaging light from getting to the sample.  The drawback of this method is that the calibration is only as good at the spot 

detector alignment. To account for any alignment offset, there is an optional step at the end to burn one spot and determine how much the calibration needs to be offset when compared 

to where the uncaging beam actually hits the sample.

The Fluorescence method involves imaging the uncaging beam on a uniform sample. This method is not available for 2P imaging; only Opterra (SFC), camera, and confocal imaging modes 

are supported.  This method works a lot like the Burn Spots method, but instead of physically marking the sample to image it afterwards, the emission caused by the uncaging beam is 

imaged in realtime.  This method should be used above all others when available.

The Quick Offset method isn't a true calibration, but rather a quick fix to an existing calibration. It is useful in cases where the uncaging beam alignment has shifted and only a fixed offset 

is needed to correct for the change.  This method attempts to burn one spot in the center of the image, and after the actual burn spot location is marked, will compute the difference 

between the predicted location and the actual location and apply that offset to the calibration file.

Step	Two:	Select	Which	File	to	Update,	or	Create	a	New	Calibration

Updating the Current calibration will update or extend the currently loaded calibration file.  If no calibration file is currently loaded, this option isn't available.  If this option is available, it is 

typically the best choice; one calibration file should be enough for most, systems as it can already account for any settings known to alter the calibration.

Updating a Existing calibration will update or extend any calibration file saved on the system. When selecting an existing calibration file, or the current calibration file, the details of which 

calibrations were performed and saved to that file, and when it was saved, will be displayed.

Creating a New calibration file will result in a new file containing one calibration.  This is the only option available if no calibration files were created previously.

Step	Three:	Calibrate	Center

The first actual calibration step in the calibration wizard is to get a sense of where the uncaging galvanometers point relative to the imaging field of view; this is the only step for a quick 

offset calibration.  Depending on the type of calibration, different instructions will be displayed on how to proceed. In general, there will be a crosshair overlay drawn on the Image window 

which will need to be dragged onto the spot indicating the location of the uncaging beam.

During this step there are instructions on how to get the uncaging beam spot to display in the image window by specifying which laser to use, at what power, and for burn spots how long 

to leave the laser on.  Once these settings are determined they will be used throughout the calibration process.

Step	Four:	Calibrate	X

The second actual calibration step is to get a rough idea of how the X uncaging galvanometer moves relative to the imaging field of view.  This step, combined with the step before, allows 

the software to point the X uncaging galvo with some degree of accuracy.  Much like the step before, an uncaging beam location will be marked by dragging crosshair over it.

Step	Five:	Calibrate	Y

The third actual calibration step is to get a rough idea of how the Y uncaging galvanometer moves relative to the imaging field of view.  This step, combined with the two before, allows the 

software to point both uncaging galvos with some degree of accuracy, which will be useful for the next step.  Just like the step before, an uncaging beam location will be marked by 

dragging crosshair over it.

Step	Six:	Calibrate	Grid

The final actual calibration step is to mark a grid of uncaging beam locations by dragging a set or series of crosshairs over them.  The number of points in the grid help will determine how 

accurate the calibration can be.  At lower optical zooms, having more points leads to higher accuracy.  At higher zooms, a smaller calibration grid is sufficient.

When using the burn spots or fluorescence calibration methods there may be an area of the sample in which it is difficult to tell where the uncaging beam is pointed.  In these cases, it is 

possible to move the stage and/or sample during the calibration process without negatively impacting the calibration.  Specifically with grids it is possible to mark the positions of a subset 

of grid points and then move the sample to mark the remaining points.

Additional	Steps

Some calibration methods will have additional steps between or after the steps mentioned described here.  These steps are explained in the onscreen instructions within the wizard.  For 

example, when performing a quick offset calibration it is important to pick which portions of the calibration file should be updated.  If only one laser was realigned it makes sense to only 

update offsets using that laser.

To correctly use the measurement tools and have accurate field of view calculations in the metadata, the objective lenses used need to be calibrated.  Objectives delivered with the system 

Objective Lens/FOV Calibration
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are calibrated upon installation.  Any other objectives purchased later will have to have their own calibration performed.  A marked calibration slide is necessary to complete this 

calibration. The calibration steps are as follows:

1.    Move the objective lens to be calibrated into position on the microscope

2.    Focus on a slide containing an object of known width (a calibration slide is recommended for this purpose)

3.    Select Tools > Calibration/Alignment > Objective Lens/FOV Calibration to open the Objective Calibration dialog

4.    Click Add New Objective

5.    Highlight the new objective in the table and fill in the objective name, power, and NA

6.    In the Enter calibration distance here field, enter the width in microns of the object being used for calibration.  Generally, longer calibration distances result in more accurate 

calibrations.

7.    Click Calibrate Selected Objective.

8.    In the Image window, move the endpoints of the line to the edges of the object used for calibration (the distance specified in step 6).  Expanding the Image window may allow for 

more accurate calibration.

9.    To accept the calibration, click the Accept button in the Image window.  To abort the calibration, click the Cancel button in the Image window.

10.  The FOV Width and Height field will now contain values and the Calibrated field will say ‘True’.

11.  If the objective will be used for 3D line scans (described here), enter its calculated Piezo Lag Time.  If this feature will not be used, leave the parameter set to 0.

12.  Close this window.  The newly calibrated objective lens will appear in the Objective Lens pulldown list in the Scanning Controls section on the main control window.

During calibration, the Calibrate Selected Objective button becomes the Abort Calibration button, which can be used to end the calibration process.

Additional buttons in this dialog allow the user to change the order of objectives in the list and to add/remove objectives from the list.

An objective must be calibrated in each Acquisition Mode in which it will be used.  For example, the 40x objective will need to be calibrated in both Galvo mode and SFC mode, if both 

scanners are present on the system.  If the objective is calibrated only in Galvo mode, the field of view and pixel size information may be incorrect for SFC mode.  Also, the Calibrated field 

will display 'False' for that objective in SFC mode.

Note that objectives calibrated in earlier versions of Prairie View software may have a Calibrated field that displays 'False'.  This occurs because earlier versions of software did not keep 

track of the Acquisition Mode in use when the objective was calibrated.  However, the calibration will continue to work as it did before the software was updated.

This section of the Help file is under construction and has not been updated recently.  The information below is from a previous version of the manual and may be somewhat outdated. 

Please contact Bruker Fluorescence Microscopy support personnel with questions about these features.

If a 1P Confocal pinhole detector is present on the system, this option opens a control dialog for the pinhole motors. 

The Prairie 3channel confocal system has a pinhole plate with 9 differently sized apertures.  The user selects an aperture in the software, and motors drive the pinhole plate to put the 

selected aperture in the light path.  Older versions of this scanner save a total of 9 positions  one for each pinhole.  Newer versions of this scanner save the matrix of 9 positions for each 

objective calibrated on the system, up to 8 objectives.

The Prairie 2channel confocal system has a pinhole plate with one aperture.  To change to a different aperture size, the user manually replaces the pinhole plate.

Choose a pinhole from the Pinhole Selection dropdown menu to move the pinhole plate to the saved position of that pinhole.

The Current Position fields display the positions of the motors driving the pinhole plate.

The user can make adjustments to the pinhole position by defining a number of Motor Steps and using the arrow buttons to move the motor(s) by that number of steps.

Update Location updates the selected pinhole position to the current motor positions.  When clicked, the currently selected pinhole definition will be modified to have its coordinates 

match the current position of the pinhole plate.  To save a new location for the currently selected pinhole, move to the desired position and click the Update Location button.

Update All Locations updates the selected pinhole position based on current stage location, as described above.  In addition, it updates all other pinhole positions by the difference 

between the old and new position for the current pinhole.

The  button drives the pinhole plate motors to their home positions.  This can be used for troubleshooting/diagnostic purposes when working with Bruker Fluorescence Microscopy 

support personnel.  Note that there is unlikely to be a pinhole at the home position.

The Auto. Alignment algorithm works for systems with pinholes on separate plates, such as most 2channel confocal systems.  It is not designed to work for systems with an 8position 

pinhole plate, such as most 3channel confocal systems.  The algorithm can be used during a Live Scan to find the pinhole position that results in the brightest signal.  Select the channel to 

use during autoalignment, based on the sample and detection glass in the system.  Define the number of Alignment Iterations to use when optimizing the position.  The Elapsed Time and 

Alignment Phase fields display information about the progress of the alignment algorithm.  The algorithm is useful for finding the pinhole in a newlyinstalled plate.  After the auto

1-P Pinhole
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alignment is complete, the user can use the arrow buttons to finetune the position for best signal.

Click Close to exit the dialog.

This section of the Help file is under construction and has not been updated recently.  The information below is from a previous version of the manual and may be somewhat outdated. 

Please contact Bruker Fluorescence Microscopy support personnel with questions about these features.

Laser Power Calibration applies only to 2P lasers using a Pockels cell for power modulation.  The formulas used in this software feature will not apply properly to visible lasers controlled 

directly or with an AOTF.

Detailed information about laser calibration can be accessed from within Prairie View by clicking the Need help with Laser Power Calibration? link at the bottom of the Laser Power 

Calibration dialog.

Operating Modes of the Laser Power Slider
In addition to the Default mode of laser power control, two levels of calibration are possible  Attenuation and Calibrated modes.  Available modes can be selected from a dropdown menu 

below each laser power slider in the Laser, PMT, DAQ tab of the Main Control window.

Default Mode
In Default mode, laser slider values are arbitrary numbers (usually from 0 to 100 or 0 to 1000). Increasing the slider value increases the voltage signal to the Pockels cell.  However, higher 

voltage does not necessarily mean higher laser power.  At some point a maximum laser output is reached, after which increases in slider value (voltage) result in lower laser power.  This 

maximum point is different for each laser wavelength.  A typical response curve is shown below, with laser slider value on the x axis and normalized laser power throughput on the y axis.  

Note that due to differences in power produced by the laser, the absolute maximum power at each wavelength will also differ; this effect is not shown in the graph below.

Attenuation Mode

2-P Laser Power Calibration
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In Attenuation mode, laser slider values become percentages of maximum power at the given wavelength.  This prevents the user from going past the voltage providing the maximum laser 

power for the defined wavelength.  If the laser is configured in Prairie View software, the wavelength will be detected automatically.  If the laser is not configured in Prairie View, the user 

will need to select the wavelength from a slider below the power slider.

By filling in the values listed in the Constants section of the Laser Power Calibration dialog, the user enables Attenuation mode.  These measurements are all relative values and can be 

taken with a power meter anywhere in the light path downstream of the Pockels cell.

The Pockels cell should be allowed to warm up for at least 20 minutes after the laser cavity shutter has been opened before taking these measurements.

The bias knob on the Pockels controller should be left at the value determined by Bruker Fluorescence Microscopy personnel during installation.  This value is usually determined by tuning 

the laser to an intermediate wavelength such as 820nm, setting the laser power slider to 0, opening the shutter, and adjusting the knob to get the lowest possible power output (based on 

a power meter reading or image intensity).  Changes to the bias require repeating the measurements described below.

Extinction Ratio (measure at an intermediate wavelength, such as 830nm)

� Minimum power:  Set the laser power slider to 0 and open the shutter(s) needed to get light to the power meter.

� Maximum power:  Increase the laser power slider in the Laser, PMT, DAQ tab to get the maximum laser power at the meter.  Note that this will likely happen before reaching the 

maximum slider value.

� Extinction Ratio = Maximum power / Minimum power; enter this value in the Extinction Ratio field in the Laser Power Calibration dialog

Maximum drive voltage across the range of wavelengths (used to map a linear approximation of the maximum drive voltage at any wavelength)

1.    Choose two different wavelengths, such as 780nm and 1020nm

2.    Enter these two wavelengths in the Wavelength #1 and Wavelength #2 fields

3.    Tune the laser to one of the desired wavelengths

� If Prairie View has the 2P Laser control integrated into its controls, then pressing the GoTo button will tune the laser

� If Prairie View does not have integrated 2P Laser control, then the user must tune the laser manually

4.    Adjust the laser power slider in the Laser, PMT, DAQ tab to find the value that results in the highest laser power reading on a power meter in the light path

5.    Click the Set button next the the Maximum Power Setting field for that wavelength in the Laser Power Calibration dialog

6.    Repeat steps 35 for the other wavelength selected

7.    Click the Save button at the top of the Constants section of the Laser Power Calibration dialog

There will now be an additional control associated with the laser power slider in Prairie View for the laser(s) that were just configured in the previous steps.  This new control is labeled 

‘Mode’ and the associated combo box has two options Default and Attenuation.

When this control is set to Default the laser slider will operate like it always has.  This means that potentially the operator could adjust the drive voltage for the pockels cell past its 

maximum output and the actual laser power output from the pockels cell will not be necessarily higher as the laser slider is increased.

When the control is set to Attenuation the laser slider is internally rescaled such that based on the current operating wavelength for the associated 2P laser the drive voltage for the 

pockels cell will go between 0 volts and the calibrated voltage that will generate the maximum pockels cell output for the wavelength.  The laser control label will include the symbol ‘[%]’

after the laser line label when Attenuation mode is selected.  The laser slider value will go from 0.00% to 100.0% (regardless of the scale used when in ‘Default’ mode).  If the laser is 

configured in Prairie View software, the wavelength will be detected automatically.  If the laser is not configured in Prairie View, the user will need to select the wavelength from a slider 

below the power slider.

Calibrated Mode

When a full Calibration File has been created for a given set of operating parameters, the laser slider will reflect laser power in milliwatts.  This is a very useful mode of laser operation, but 

is also very sensitive to changes over time that can affect the accuracy of the power readings. Keep the following in mind when preparing to use Laser Power Calibration:

� All optical components in the light path between the Pockels cell and the light meter (placed to measure the light output at the objective lens) will have an impact on the power 

delivered to the sample.  Therefore it is necessary to perform a calibration for at least each objective lens used on the system to take proper advantage of this calibration process. 

Additional calibration files may be needed for systems with exchangeable dichroic mirrors, beam expander lenses, etc.

� Since the maximum sample power for a given calibration is limited to the ‘lowest' measured power through the calibration wavelength range, the operator might wish to make several 

calibrations for a given objective lens at various wavelength ranges. 

Laser Power Calibration extends the operating capabilities of the multiphoton imaging system. Once the proper system measurements have been made and the laser power calibration 

procedure completed, the operator will have the ability to specify the desired laser power to be delivered to the sample in mW units. In addition, once the laser power setting has been 

made, if the operator changes the wavelength of the 2P laser, the drive voltage to the Pockels cell will be automatically adjusted to maintain a constant laser power to be delivered to the 

sample.

Warning: The proper implementation of the Laser Power Calibration is dependent upon the initial Pockels cell installation as well as software during installation. Any adjustments to the 

light path after the setup and calibration(s) have been performed would most likely result in the necessity of having the calibrations performed again.

Power Calibration

The purpose of the Laser Power Calibration is to provide one or more calibration files that will allow the operator to set the desired laser power in mW at the sample via the laser slider 

control(s) in PrairieView. This option will be in addition to the two operating modes already available; Default and Attenuation.

The actual power calibration is performed by stepping through a range of wavelengths and setting the drive voltage to the proper V
π

at each wavelength and after the system has had a 

few seconds to settle at the new wavelength and drive voltage, the laser power at the objective lens is recorded. This creates a table like the following:

Using the information in the table, when in the ‘power’ mode, the laser power to the sample can be controlled between 0mW and 50mW from 700nm to 1050nm.

The actual calibration process is conducted with the Laser Power Calibration dialog within PrairieView.

1. Place a power meter below the objective lens, slightly above or below the focal plane. The meter will probably deliver better results if the laser light isn’t focused to such a fine spot size.

2. Fill in the various fields in the Constants section as outlined above.

3. Press New.

Wavelength(nm) Power(mW)

700 200

… …

800 400

… ...

1050 50
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4. Enter a name for the calibration file in the Name field of the Selected Calibration Field. The calibration name should reflect the objective lens being used as well as the range of 

wavelengths that will be used in the calibration.

5. Enter the Minimum Wavelength [nm], Maximum Wavelength [nm], and Step Size [nm] values to be used for the calibration.

6. Press Start. If 2P laser control is integrated for the selected laser, the software will automatically tune the laser to the Minimum Wavelength value for the calibration. If a 2P laser 

control is not integrated for the selected laser, the operator must manually tune the laser to the Minimum Wavelength value for the calibration.

7. After the laser has finished tuning, wait a couple of seconds for the reading on the power meter to stabilize and then enter the power meter reading (in milliwatts) in the Power field and 

hit Enter. The entered value will now appear in the calibration table across from the current 2P laser wavelength.

8. After hitting Enter, if 2P laser control is integrated for the selected laser, the software will automatically change the laser wavelength to the next value in the calibration table. If a 2P 

laser control is not integrated, then the operator will need to manually tune the laser to the appropriate wavelength.

9. Repeat last step until the calibration has been completed.

10. Press Accept to utilize the calibration file.

After at least one calibration file has been generated, then the ‘Mode’ control associated with the calibrated laser line will include the names of the calibration file(s) (in addition to 

‘Default’ and ‘Attenuation’ as outlined above).

When one of the calibration files is selected the laser control label will include the symbol ‘[mW]’ after the laser line label.

When one of the calibration files is selected then the laser slider is internally rescaled such that based on the current operating wavelength for the associated 2P laser the drive voltage for 

the Pockels cell will go between the minimum achievable output power (not necessarily 0mW) and the maximum output power that can be attained at all wavelengths within the 

calibration range. For example, if the calibration wavelength range was 780nm to 950nm and the lowest maximum power measured across that range was 50mW, then when this 

calibration file is used, the maximum output power at any of the calibrated wavelengths will be 50mW.

If the association between the 2P laser and the laser control was set in ‘PrairieConfigUtility.exe’, then when the operating wavelength is changed, the laser setting will be automatically 

adjusted to maintain the desired sample power.

Additional Information

The selected laser mode (Default, Attenuation, or Power Calibration file) and laser setting will be retained when a ‘label’ is created/used in Prairie View. The laser setting displayed in the 

‘Laser Power(s)’ column will include ‘mW’ or ‘%’ if the label was created when a calibration file or the Attenuation mode was in effect.

The selected laser mode and laser setting will be retained for the ‘Interlaced scan pattern’. The selected laser mode will also be reflected in the laser sliders for the setup dialog for the 

‘Interlaced scan pattern’.

The selected laser mode and laser setting will be retained for the Photo Activation masks and settings. The selected laser mode will be reflected in the laser sliders for the Photo Activation 

palette edit dialog.

As mentioned previously, all optical components in the light path between the Pockels cell and the light meter (placed to measure the light output at the objective lens) will have an impact 

on the power delivered to the sample. Therefore it is necessary to perform a calibration for at least each objective lens used on the system to take proper advantage of this calibration 

process.

Since the maximum sample power for a given calibration is limited to the ‘lowest' measured power through the calibration wavelength range, the operator might wish to make several 

calibrations for a given objective lens at various wavelength ranges.

If a laser control is configured to use a calibration file and there is a 2P laser integrated into Prairie View and associated with the particular laser control, if the operator attempts to tune 

the laser to a wavelength outside of the range of the calibration file, the operator will be warned that that is an illegal operation and the wavelength change will not take place.

If the system is equipped with the highspeed optics option (AOD), it might not be necessary to perform the Pockels cell calibration. This is due to the fact that the AOD system is set up and 

optimized for a single wavelength. It might be better to simply take a couple of power measurements at the objective lens in ‘Attenuation’ mode and then manually determine which 

setting in Attenuation mode will provide the desired sample power.

If the system is configured with a Camera or SFC and a photoactivation module, this option opens a dialog to adjust the scan rotation of the photoactivation scan relative to the imaging 

scan.  No adjustments should be made until the user is certain that the camera is properly aligned with the SFC. 

A good way to determine this rotation is to set up a Photoactivation mask to burn a large “+” symbol covering the entire image of a thin film sample (such as a dry erase marker slide).  

After using the mask to burn away the “+” pattern, compare the image of the burned sample to the mask overlay on the Image window.  If the pattern is rotated, adjust the value in the 

Rotation field and repeat the test on a fresh area of the sample.  The buttons in the Move Galvos section of this dialog are for use by Bruker Fluorescence Microscopy personnel during 

installation.

Controls in the Maintenance dialog are useful during installation, troubleshooting, and maintenance tasks.  This dialog gives the user the ability to override usual software control of each 

shutter and galvanometer set in the system.

Photoactivation Alignment

Maintenance
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Center	Galvos

In the Center Galvos section, the user can center the galvo mirrors for the imaging and/or uncaging light paths.  The galvo sets present in this section depend on system configuration.

Bringing the galvos to center is useful when checking alignment of the laser beam(s) through the scanning system, as galvos must be centered to use the fluorescent objective target as a 

reference point.  When aligning an uncaging path and/or uncaging spot detector, it can also be useful to center the uncaging galvos via this dialog while scanning with the imaging galvos 

via the Main Control window.  

These buttons will be disabled with the galvanometers are in use.  If the software needs to control the galvanometers for any reason (e.g. the user presses the Single Scan button on the 

Main Control window), the galvanometers position will be set to Automatic and the buttons will be disabled until the software returns the galvanometers to their park positions.

Click the Centered button for one set of galvanometers to bring the galvanometers to center.

Click the Automatic button to return the galvanometers to their park positions.

Click the Custom button to bring the galvanometers to a custom location.  The custom position can be changed by dragging the position overlay in an image window, or by clicking the 

directional buttons on the Maintenance dialog.  The amount moved by the directional buttons can be changed using the step size control to the left, which can be adjusted in discrete 

increments determined by the limitations of the electronics driving the galvanometers.

Manual	Shutter	Overrides

In this section, the user can close or open the hard and soft shutter controls associated with a specific light path.  This can be useful during alignment and troubleshooting.  Additionally, 

this is the only way for the user to open a hard shutter while the laser power sliders are set to 0; this is useful when setting the bias adjustment on the ConOptics controller for the Pockels 

cell.

The names and number of controls visible depend on system configuration and the shutters defined in the Prairie Configuration Utility.

Click the Open button to force the hard shutter to stay open (even if it would normally be closed).

Click the Closed button to force the hard shutter to stay closed (even if it would normally be open).

Click the Automatic button to return shutter control to the software.

When the user closes the Maintenance dialog, all shutter controls are returned to the Automatic state.

Show	crosshair	overlay	at	center

Enabling this option will display a crosshair on the Image window and hide all other overlays. The crosshair marks the center pixel of the image.  This is useful for some alignment 

procedures.

When the user closes the Maintenance dialog, the crosshair overlay will disappear and the previous overlays will be displayed on the image.

New Image Window:  Opens a new Image window.  It functions the same as the New button in the Image Size section of the Prairie View main control window.

Ghost Mode Options:  Expands to reveal the Ghost Mode option.  This option toggles Ghost mode on and off.  In Ghost mode, all Prairie View windows become appear translucent; images 

displayed in Image windows do not become translucent.  This can be useful in minimizing the noise from external light sources in a darkened room.  The user can choose the opacity of the 

windows during Ghost mode by selecting a value from the Opacity submenu.

Interpolation Mode:  Specifies a method to use to extrapolate/interpolate intensity values when stretching/shrinking the acquired image.  The selection made here is also displayed in the 

information bar at the bottom of the Image window.

Z-Position Display:  For systems configured with multiple Zdevices, this option allows the user to choose whether the Z position displayed at the bottom of the Prairie View main control 

window is the Sum of all positions, All positions (comma delimited), or Current device position.

Scale Bar Options:  Allows user to enable the Show Scale Bar option, to select the position of the scale bar in the Image window, and to choose the units of scale bar.

Frame Rate:  Adds an overlay to the Image window to display the actual average frame rate that occurred during the most recent scan.  This is often a more accurate representation of the 

frame rate than the value displayed at the bottom of the main window in Prairie View. However, this displayed value will always be zero during a scan or after a single image.  This feature 

applies to Camera and SFC imaging.

Use Classic Pseudocolor: Allows the user to choose between two color mapping schemes for any channels displayed in Pseudocolor.  The most noticeable difference between the two 

options is that Classic Pseudocolor displays its lowest values as black, which Visible Spectrum Pseudocoloring displays its lowest values as purple.

Parameter Display:  Opens a dialog in which the user can display any number of system parameters.  The Display tab shows the current values of the selected parameters.  The Setup tab 

contains buttons with which the user can edit the list of parameters and determine the order and background color of the Display tab.  For each parameter, the user can set up the Label 

(name for the parameter to display), Parameter, Format, Font, and Color for each line of the Display tab.  All parameter and color selections are automatically saved/recalled when Prairie 

View is exited/started.

Display Menu
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The Applications Menu contains a list of software modules that can be opened and run within Prairie View.  Clicking an option will open the dialog of controls for that application.  Each 

application is described in its own section of this manual.

� Voltage Output allows the user to define pulses, ramps, and other output waveforms for the analog output connections on the GPIO box

� Mark Points provides photostimulation at one or more individual points

� Voltage Recording provides recording of signals through the analog input connections on the GPIO box

� Seal Test allows the user to monitor and send signals to and from a patch amplifier

� Image Block Ripping Utility converts raw data files into usable formats (TIFF for image data, CSV for Voltage Recording data, etc.) if the raw files were not converted automatically after 

acquisition

� Spiral Activation provides photostimulation of regions using a spiral over the area of interest

� Functional Mapping generates an overlay on an image to denote the magnitude of an electrical response to photostimulation

� Atlas Imaging allows for easy visualization of large sections of tissue in an automated process

Additional programs can be added to the Applications menu by defining an Action to call that program's executable file.  This can be a convenient way to launch other programs such as the 

Windows Calculator, ImageJ, etc., from within Prairie View.  Additional information about Actions can be found elsewhere in this manual.

Photostimulation protocols can be carried out in a variety of ways with Prairie View software.

� Mark Points provides photostimulation at one or more individual points.

� On systems with only an one set of galvanometers (Ultima with one set, SGS, Arcturus), Mark Points can be performed with the imaging galvos between imaging sequences, in a 

sequential manner.

� On systems with a second set of galvanometers (Ultima with two galvo sets, Sagittarius, SFC with Photoactivation/FRAP module), Mark Points can be performed with the second 

set of galvos during or between imaging sequences, in either a simultaneous or a sequential manner.

� Photoactivation Masks allow the user to define arbitrary regions to raster scan with one or more lasers using the the imaging galvos.  The galvos scan across the sample as if acquiring 

an image, but laser power is applied only as defined by the mask.

Applications and Photo-Stimulation Overview
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� Spiral Activation allows the user to define regions to be photostimulated using the uncaging galvanometers by driving the galvos in a spiral pattern.  This type of activation cannot 

currently be embedded in a TSeries, but can be synchronized with Voltage Output and/or Voltage Recording.

Please refer to other sections of this manual for details about these software features.

The Voltage Output feature allows the user to define waveforms to be generated on analog output BNC connections.  These waveforms may be run independently of other tasks, or they 

can be synchronized with imaging, Voltage Recording, or photostimulation with Mark Points, Photoactivation masks, or Spiral Photoactivation.

To begin using Voltage Output, open the main interface window by selecting Voltage Output from the Applications menu.

Across the top of the Voltage Output window is a set of checkboxes to enable/disable waveforms along with buttons to configure them.  Some of the waveforms may be unavailable if their 

analog output lines are reserved for other purposes, such as galvanometer control or laser modulation.

At the bottom of the main interface is a graph that displays a summary of the current Voltage Output experiment.  An experiment is a set of one or more waveform definitions that will be 

generated simultaneously with common triggering.  The graph may be made visible or hidden by clicking on the green bar that separates the graph from the controls at the top of the 

Voltage Output window.  Buttons above the graph allow the user to zoom and pan in the horizontal, vertical, or both dimensions within the graph display.

Defining	a	Waveform

Every waveform has a Config Line button.  The button text contains a reference to the analog output line on which that waveform will be produced.  Clicking this button will open a new 

Waveform Setup window.  This window is where the user defines the waveform.

A waveform is composed of one or more waveform components.  Each waveform component has unique characteristics that are used to define the voltage level of the waveform at 

different time points in a structured manner.  To add a waveform component to the waveform, click the New Waveform Component button  on the left side of the Waveform 

Component list box.

The name of the waveform component can be changed by clicking the default name in the list box.  Individual components can be saved with the  button and loaded at a later time 

using the  button.  The order of individual waveform components in the list can be changed using the arrow buttons to the right of the list, and a components can be deleted using the 

 button.

Voltage Output
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Types	of	Waveform	Components

After the waveform component has been added to the list box, it is automatically selected. Below the list box is the waveform component settings panel.  There the user must choose the 

type of waveform component and set its properties.  There are five waveform component types: Pulse Train, Patch Clamp, Ramp, Fixed Voltage, and Custom.

� Pulse Train  A single pulse or set of pulses which share similar characteristics.  Every pulse within a pulse train has the same pulse width and interpulse delay.  The initial delay occurs 

before the first repetition of a pulse train, while the time between the last pulse of one repetition and the first pulse of the next is defined by the repetition delay.  Within one 

repetition, all pulses may have the same pulse potential or the potential may change (up or down) by a fixed voltage amount, referred to as the pulse potential delta.  The initial 

potential and the potential between pulses can be set as well, and may be nonzero

� Patch Clamp  This is almost identical to the Pulse Train type except that the pulse potentials are defined relative to the initial rest potential rather than relative to zero.  The definition 

also has an “amplitude multiplier” value that can be used to quickly scale the amplitude of the pulse up or down relative to the rest potential.  If the rest potential is 1 Volt, the pulse 

potential is 1 Volt, and the amplitude multiplier is 1, the potential of each pulse is 0 Volts.  If the amplitude multiplier is changed to 2, then the pulse potential is doubled but still 

relative to the rest potential.  This would produce a pulse voltage of 1 Volt

� Ramp  This type is also similar to a pulse train, except that instead of producing pulses of a fixed potential it instead produces a continuous ramp of voltage between two values.  The 

ramp does not have to start or stop at the same potential that it holds between ramps.

� Fixed Voltage  This simple component type allows you to define a period of time over which the output should be a constant (DC) voltage value.  In the special case where this 

component is the final component in the waveform there is the additional option to define it to either maintain the set voltage output value indefinitely or transition to a different 

potential at the end of its duration.

� Custom  This is the most flexible component type since it allows the user to import a file containing any waveform definition.  The file must be an ASCII text file with a file extension 

of .txt or .csv.  Each line of the file defines one voltage and one time duration (with units of milliseconds) to hold that voltage for.  The two values should be separated by a comma. 

Below is a simple example:

       2.5, 100

       0, 400

       5, 2000

       0, 1

Importing a file with these contents would produce a waveform at 2.5 V for 100 ms, then change to 0 V for 400 ms, then 5 V for 2 seconds, and finally go back to 0 V for 1 ms.  If this 

were the last component in the waveform, the output would remain at the last voltage defined (in this case, 0 V).

When a waveform is changed by adding, removing, or changing one of its components, the graph on the waveform setup window is updated accordingly.  If the waveform is enabled on 

the main interface (its checkbox state is checked) its graph will also be displayed on the summary graph, overlaid with the other enabled waveforms.  The user can change the plot color on 

the summary graph by hovering over the waveform name in the main interface and using the color wheel that pops up.

Units	and	Scaling	of	Waveforms

The units of the output can be specified by clicking the  button in the Waveform Setup dialog.  This will open the Waveform Options dialog where the user can choose the unit 

displayed and the value of that unit per volt of actual output from the Bruker electronics.  This feature is useful whenever a scale factor is applied by external equipment, such as a patch 

amplifier converting the voltage control signal to a current applied to a cell, or an auditory stimulator converting the voltage control signal to decibels of sound produced.

Update	Rate

The update rate for an experiment determines how often the samples for each waveform are generated.  The lower the update rate, the faster an experiment will prepare and the smaller 

its memory footprint will be.  However, a low update rate will also cause aliasing of higher frequency components of waveforms.  If all of the waveform components in an experiment 

contain simple fixed voltage levels or pulses whose component time values are multiples of one millisecond, an update rate of 1000 samples per second is sufficient.  However, when used 

with any waveform component whose time values are not whole milliseconds the output will be aliased and the signal may be too irregular for the intended application.  In these cases, a 

larger update rate is needed.

Both the summary graph on the main interface and the waveform preview graphs in the waveform setup windows will show the theoretical plots as the waveforms are designed, and will 

not illustrate any aliasing problems that may result due to an update rate which is too low.

Note that both Mark Points experiments and Spiral Photoactivation experiments use a fixed update rate of 100 KHz.  If a Voltage Output experiment is synchronized with either of these, 

the Voltage Output experiment will also run at 100 KHz, regardless of the update rate set in the Voltage Output window.

Saving	and	Loading	an	Experiment

The entire experiment definition, including all enabled waveforms and the defined update rate, can be saved by clicking the  button on the main Voltage Output window, next to the 

Start button.  A saved experiment can be recalled using the  button.

Frequentlyused experiments can be assigned to the Quick Load Experiments buttons. 

To assign a saved experiment to a button, click the down arrow next to a Quick Load button and choose the desired experiment.  The name of the chosen experiment will be displayed on 

the button, and the experiment can be loaded by clicking the button.

Note that triggering selections are not saved as part of an experiment, and must be defined each time an experiment is loaded.
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Running	an	Experiment

The current Voltage Output experiment can be run by clicking the Start button on the Voltage Output main interface.  Alternatively, the Voltage Output experiment can be embedded in a 

TSeries, Line Scan, Point Scan, Voltage Recording, Spiral Activation, or Mark Points experiment an run from those interfaces.

The Synchornize with Voltage Recording selection allows the user to start a Voltage Recording experiment along with the Voltage Output experiment.  This selection applies only to 

experiments started from the Voltage Output interface; experiments embedded in other interfaces (TSeries, Line Scan, etc.) will ignore this setting.

Starting	with	a	Trigger

The Trigger Mode selection allows the user to start the Voltage Output experiment upon receipt of one of several available triggers.

Trigger types include:

� Start with next scan (PFI0)  an internal signal generated at the start of an imaging event (Single Scan, TSeries, ZSeries, etc.)

� Start with external trigger (PFI1)  provide a 5V signal to the PFI1 connection on the front of the GPIO box

� Start after N frame triggers (PFI8)  define a number of frame triggers after which to start an experiment; frame triggers are generated internally and discussed in more detail here

� Start with external trigger (Trig In)  provide a 5V signal to any one of the Trig In connections on the front of the GPIO box

Select the desired trigger and then click the Voltage Output Start button.  The experiment will prepare, but will not begin to send out waveforms until the selected trigger is received.  This 

selection applies only to experiments started from the Voltage Output interface; experiments embedded in other interfaces (TSeries, Line Scan, etc.) will ignore this setting.

Mark Points is an application module designed to allow users to define point photoactivation protocols (uncaging, optogenetic stimulation).  Mark Points can also be used to set up 

protocols for other types of photoactivation as well as photodamage/photoablation experiments.

Mark Points allows the user to define specific point locations that will be illuminated by a specific laser for a specific duration and intensity.  The user also defines the time interval between 

individual points as well as groups of points.

The protocols defined by Mark Points can be synchronized with image acquisition (full frame, ROIs and line scans) as well as Voltage Output signals that are used to control 

electrophysiology data as well as any other devices that can be controlled by analog voltage outputs and TTLs, and Voltage Recording of analog signals from electrophysiology amplifiers or 

an device generating an appropriate analog signal.

Mark	Points	Interface

Mark Points
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Left click on the Mark Points on the Image window or select Mark Points from the Application menu to launch the Mark Points interface.

The Mark Points interface is divided into following sections:

� Image window options:  Sets display of graphic overlays as well as control of the mouse pointer when defining and editing point setup

� Point Groups: Lists points and groups defined on the image window.  Allows user create groups of points as well as delete points, lines and groups.  Point density of lines and grids 

can be defined.  Custom point order can be defined.  Sets of points, groups, grids and lines can be saved and loaded.

� Mark Points at Crosshair:  Allows configuration of parameters for protocols using the interactive cross hair.  These parameters are the same as those used in a Mark Point Series; 

see below for descriptions.  The settings in this section also define the default values for parameters when points, groups, lines and grids are added to the Point Series table.

� Point Series Table:  Defines the protocol to be run.  Points, lines of points, groups of points and grids are added to the table and selected laser, laser intensity, pulse duration, 

intervals, triggering and synchronization are defined.

Defining	points

After acquiring a reference image, the user selects Mark Points from the Image window or Application menu to launch the Mark Points interface.  

Individual points (which can later be grouped), lines of points or grids of points can be defined. Select the type of points to be defined in the Left Click Action of the Image Windows 

Options.  

To select individual points, right click in the desired locations on the image in the image window. Note: the image window can be zoomed when creating points or sets of points.  To move a 

point, left click in the point and drag to a new location.  Points can be moved after a Mark Points experiment is run.  This feature is useful in evaluating location based on response.

To add a line of points, select Add Line of Points.  To add a free hand line, point the mouse cursor to the beginning location, hold down the left mouse button, draw the desired line, and 

release the mouse button.  The point density can then be set using the X point density controls to the top right of Points/Groups.  To draw a straight line, hold down the shift key while 

drawing the line.   To move a line, point at a point on the line, and while holding down the left mouse button move the line.  To rotate the line, place the mouse cursor over an endpoint of 

the line, and while holding down the left mouse button rotate the line.

To add a grid of points select Add Grid of Points.  Place the mouse cursor over the desired location of the upper left hand corner if the grid, hold down the left mouse button, then drag 

down to the desired lower right hand corner of the grid and release the mouse button.  To move or resize the grid, place the mouse cursor on a point on the interior of the grid, hold down 

the left mouse button, and move the grid.  To resize, place the mouse cursor on a point on the edge of the grid and drag.  Placing the mouse cursor on the upper right corner allows the 

grid to be rotated.  X and Y density are set with the controls to the upper right of Points/Groups.

There are two ways to create groups of existing points.  One way is to set Left Click Action to Select/Move Points and while holding the left mouse button drag the cursor over the area 

containing the desired groups.  The other way to create a group is to select the points in the Points/Group list by using control+click or shift+click.  Then click the Create Group button on 

the right side of Points/Groups.

Defining	protocols

Protocols are defined in the Point Series table.  To add points, groups, lines or grids to the Point Series table, click on the desired entries in the Points/Group list and click the Add to Point 
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Series button.  The selected items will now appear in the Point Series table.

Note:  If the parameters for selected laser, laser intensity, pulse width, etc. will be the same for all entries in the Point Series table, it is convenient to set those values in the Mark Point at 

Crosshair section as they will then be the defaults when entering items to the Point Series table.

The Mark Points variables to be set for any experiment are:

� Initial Delay is the time until the first point in a group, line or grid is illuminated with the selected laser.   Note:  The shortest possible initial delay is the move time set for the 

galvanometers in the scan settings defined for the system; this parameter is set by Bruker Fluorescence Microscopy personnel during installation of the system.

� Inter Point Delay is the time between points in the group, line or gird.  In the case of individual points this variable is used only if there are repetitions of that point.

� Duration is the length of time the laser is on at each point.

� # Reps is the number of times the group, line or point is repeated.

� Uncaging Laser is the laser to be used for that line in the Point series table.  Note that different lasers can be selected for different lines.  The lasers available for selection depend 

on system configuration.

� Uncaging Laser Power is the power of the laser when turned on as defined by the scaling set in the system configuration.  This power setting uses the same scale as the laser power 

slider in the main control window.

At the bottom of the Point Series table is a graph showing the timing of the protocol.  This graph can be hidden or displayed by clicking the green bar at the bottom of the Point Series 

table.

Running	Mark	Points

Mark Points protocols can be run in a number of ways, typically synchronized with imaging, in conjunction with electrophysiology recording, or both.

Stand-Alone	Mark	Points	Experiment

Mark Points can be run alone, which is typically done to verify that protocols are operating properly by using a marker slide or a slide with caged fluorescein.  Simply click the Run Mark 

Points button at the bottom right corner of the Mark Points interface.

If more than one line is present in the Mark Points table, and no triggers are set, the entire table will run to completion.

To run a single point as a standalone experiment, use the Mark Point at Crosshair controls.

Triggering	Mark	Points	with	Imaging	or	Line	Scans

Mark Points is often run with imaging, either full frame or ROI images or line scans. Simultaneous execution of Mark Points with imaging requires that the system have separate light paths 

(galvanometers and lasers) for the two operations.  On systems with only one set of galvanometers, imaging and Mark Points must take place sequentially, rather than simultaneously.

When running Mark Points as part of a TSeries of images, the user can select on the TSeries line on which frame the Mark Points protocol should run.  Scrolling to the right in the TSeries 

Cycles table will show a field for Synchronize with Mark Points.  Selecting this field will open a drop down with the options to use the current Mark Points settings or a saved Mark Points 

protocol.   This selection is only available on systems configured with the hardware needed for simultaneous Mark Points with imaging.  To the left of the Mark Points synchronization field 

is the Triggers Before Starting column, in which the user enters the frame on which they want the Mark Points protocols to run.  Frame triggers are discussed here.

A Mark Points experiment can also be added to a TSeries as a separate cycle, by clicking the Mark Points button to add that type of cycle.

Page 85 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm



More information about TSeries setup is available here.

In the Linescan Control window, Mark points is synchronized by selecting a Synchronize With option and then selecting Mark Points, with options to run the current configuration or a 

saved protocol.  Note that with Line Scan the Synchronize with option gives two choices, Once at Start or Each Repetition.  Once at Start will run the Mark Points protocol once when the 

Start Linescan(s) button is clicked, even if Line Scan is configured to run multiple repetitions.  If Each Repetition is selected, Mark Points will run once for each repetition.

More information about line scan acquisition is available here.

Triggering	and	Synchronization	in	Mark	Points

Mark Points has internal trigger variable that can be set to run Mark Points when an external trigger is received, or for more complex experiments involving multiple internal image 

triggers.

Scrolling to the right in the Point Series table will show the triggering section.   Mark points can be triggered in two ways in conjunction with internal image triggers as well as being 

triggered by external triggers such as those that can be generated by an electrophysiology recording system.

Image triggers are PFI 0 (start of next scan) and PFI 8 (a specific frame).  Frame triggers are discussed in more detail here.  These triggers are not available if the system is configured to use 

the same galvanometers for both imaging and Mark Points functions.  If PFI 0 is selected for a line, that line will start when the next scan is started, a scan being defined as a T Series line, 

Live Scan, Single Scan, or a line scan.  PFI 0 would be used when individual Point Series lines are to be matched up with individual T Series lines or line scan repetitions.  

As an example, a user wants to do an experiment where they want to evaluate the effect of three different sets of points on eliciting a rise in calcium as measured by a calcium indicator. 

They define 3 groups of points, put each group on a line in the Mark Points Point Series table, and define the laser and timing variables.  They set Wait for Trigger in Mark Points for each 

line to First Repetition and select the PFI 0 trigger.
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In T series they set up three T Series lines, in this each with the same number of frames and frame interval.   They DO NOT select triggering or synchronization in the T Series line, as the 

triggering is being set in Mark Points.

To start the experiment, they first click on Run Mark Points in the Mark Points window.  Mark Points is now waiting to be triggered.  They then click Start T Series, and the T Series starts to 

run.  The start of each T Series line triggers Mark Points to run the next line.

In another variant of the above experiment, the user wants to have a single T Series, and have three different groups of points run after a certain number of frames.  They again set up 3 

groups in Mark Points in the Points Series table.  In this case they select as a trigger PFI 8, and select the number of frames to wait until the line in Points Series table runs.  In this case they 

are going to run a T Series of 100 frames.  They want to wait 25 frames before triggering the first line of the Point Series, and every 25 frames thereafter.   They put 25 in as the number of 

frames for each line in the Point Series table.  They click Run Mark Points so that it is waiting to be triggered, and then start the T Series.

Using Mark Points triggering with line scans is usually done with repetitions of line scans where a different line in the Point Series table is to be run with each repetition.  For example, three 

groups of points, each to be run with a repetition of line scan.  PFI 0 is used for the trigger for each line, and in line scan synchronization with Mark Point is not selected.  Line scan would be 

set to run 3 repetitions.  Mark Points would be started, then line scan started.  At the beginning of each line scan a line from the Mark Points Point series would run.

Triggering by an external device can also be done from within Mark Points.  Again, Wait for Trigger is selected, and the trigger source is selected.  The trigger source can be PFI 1, which is 

the PFI 1 connector on the front of the GPIO box, or Trigger In, which is one of the 8 Trigger In connections on the front of the GPIO box.  Again, Run Mark Points is clicked to put Mark 

Points in a state where it is waiting to run.  

If there are multiple lines in the Mark Points Point Series, but only the first has a trigger set, the entire Points Series will run when the trigger is received.    It is possible to set up protocols 

where there are multiple lines with triggers and lines without triggers.   For example, a user wants to create 9 groups and run them 3 at a time with a line scan.   They would create the 9 

groups and enter them in the Point Series such that lines 13 were the groups for the first line scan, 46 were for the second line scan and 79 were for the 3rd line scan.  On lines 1, 4 and 7 
they would set the trigger to PFI 0.  They would set line scan to 3 repetitions, click Start Mark Points and then start line scan.  The first three lines would run with the first line scan, line 4 

would wait for the next start of scan trigger from line scan, etc.

Synchronizing	with	Voltage	Output	and	Voltage	Recording
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Lines in the Point Series can be set up to synchronize with defined Voltage Output and Voltage Recording.  This type of synchronization can provide full control and recording of data for 

experiments where optical stimulation is being used in conjunction with electrophysiology recording.   Voltage Output waveforms can also be used as triggers for external devices, and 

Voltage Recording can record any type of 10 to +10 V signal.

In order to use Voltage Output or Voltage Recording, Voltage Output and/or Voltage Recording must be configured, or have saved experiments present (see Voltage Output, Voltage 

Recording).

To use Voltage Output or Voltage Recording, select First Repetition, Each Repetition or Each Point from the Synchronization dropdown.  Then select Current or Choose Experiment from the 

Voltage Output and/or Voltage Recording experiment.

When using Voltage Output through Mark Points synchronization, the waveforms being generated are displayed in the graph below the Point Series.  Voltage Recording time is displayed in 

the graph as a red overlay.

More information about Voltage Output and Voltage Recording experiments can be found in other sections of this manual.

The Voltage Recording interface allows the user to record electrical signals over time. Acquisitions may be run independently of other tasks, or they can be synchronized with imaging, 

Voltage Output waveforms, or photostimulation with Mark Points, Photoactivation masks, or Spiral Photoactivation.

Voltage Recording
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Save/Load	Experiment

The currently defined experiment can be saved by clicking Save.  A saved experiment can be recalled using the Load button.

Frequentlyused experiments can be assigned to the Quick Load Experiments buttons. To assign a saved experiment to a button, click the down arrow next to a Quick Load button and 

choose the desired experiment.  The name of the chosen experiment will be displayed on the button, and the experiment can be loaded by clicking the button.

Note that triggering selections are saved as part of an experiment, and will be updated when a saved experiment is loaded.

Current	Experiment	Properties

The name field at the top of this section displays the name of the currently defined experiment. This can be the name of a saved experiment, or "Current" if the current settings have not 

been saved.

Samples/Sec allows the user to define the number of samples to acquire per second. This is limited by the number of channels acquired.

Time is the number of milliseconds to acquire for a finite acquisition, or the number of milliseconds displayed at once for a live recording.

Synchronize with Voltage Output allows the user to start a Voltage Outputs experiment at the same time as the Voltage Recording experiment.  This selection applies only to experiments 

started from the Voltage Recording window start button; recordings embedded in other experiments (TSeries, Line Scan, etc.) will ignore this setting.
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Start With Trigger allows the user to start the Voltage Recording with one of several available triggers. Select the desired trigger, and then click the Voltage Recording Start Acquisition or 

Live button.  The Voltage Recording experiment will then prepare, but not begin acquisition until the selected trigger is received. This selection applies only to experiments started from the 

Voltage Recording window start button; recordings embedded in other experiments (TSeries, Line Scan, etc.) will ignore this setting.  Trigger types include:

� Start with next scan (PFI0)  an internal signal generated at the start of an imaging event (Single Scan, TSeries, ZSeries, etc.)

� Start with external trigger (PFI1)  provide a 5V signal to the PFI1 connection on the front of the GPIO box

� Start after N frame triggers (PFI8)  define a number of frame triggers after which to start an experiment; frame triggers are generated internally and discussed in more detail here

� Start with external trigger (Trig In)  provide a 5V signal to any one of the Trig In connections on the front of the GPIO box

Acquisition	Channel	Properties

Name defines a custom name for an acquisition channel

Range defines an input sensitivity for an acquisition channel.  Smaller ranges lead to better sensitivity and less noise but increase the risk of clipping.

Units define a scaling factor for data display.  Clicking in the Units column will bring up a dialog to define a unit conversion for the given channel.  This is for display purposes only and will 

not affect saved data.  Information about the applied unit conversions is stored in the voltage recording XML file so it can be manually applied to the raw data by the user if necessary. 

Reset All Units button resets unit conversions for all channels to the default of no conversion.

Units	Dialogs

The Units dialog allows the user to define a scale factor for the display of recorded voltages.  The appearance of the dialog varies based on system configuration.  Configuring a patch 

amplifier for use in Prairie View enables additional selections in the dialog.

When not reading units from a supported patch amplifier: Use the text boxes to define the number of custom units corresponding to a defined number of volts recorded by the acquisition 

card.  For example, 1.0 Amp = 1 Volt signifies that for each volt recorded, the display will be scaled to show 0.1 Amp.

When an Axopatch 200B amplifier is configured: Check the Read from checkbox to obtain unit scaling from the telegraphing output on the Axopatch 200B.  Select the analog input to which 

the telegraph signal is connected, and whether it signifies a scaling for current or potential.

When a Multiclamp 700B amplifier is configured: Check the Read from checkbox to obtain unit name and scaling from the Multiclamp Commander Software. Select whether scaling should 

be read from Multiclamp Ch1 or Ch2, corresponding to the two amplifiers contained in the Multiclamp device.  Then select the Channel corresponding to the primary or secondary output 

for that amplifier.

The Reset All Units  button at the bottom of the window will reset all channels to display 1 volt of signal per 1 volt recorded by the acquisition card.

Plots

A check box to Sub-Sample Graphs affects the display of large acquisitions. 

If the box is checked, the plots will display a subsampled signal.  This allows display of the full length signal for longer acquisitions at higher sample rates, but will hide signal features at 

shorter time scales.  This sub sampling does not affect the saved data.

Buttons above the plots allow the user to zoom and pan within the displayed data in the horizontal, vertical, or both dimensions.

The Plot Number Button  in the upper right corner of the window allows the user to select the number and layout of plots displayed in the window.

Buttons alongside each individual plot allow the user to adjust the data displayed in that plot.
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� Channel buttons enable/disable channels to be acquired and displayed in this plot; only those channels enabled in one or more plots will be acquired during an experiment

� Colored rectangles next to the channel buttons allow the user to change the display color of the trace acquired from that channel

� Number combo box (n) allows selection of the number of previous acquisitions used for the Previous, History, and Average features.  This selection applies only to acquisitions with 

identical settings taken in sequence during the current session.

� Clicking CLR (clear) will cause the software to “forget” and stop displaying previous acquisitions

� Previous displays the data recorded n acquisitions prior to the most recent acquisition (one trace displayed)

� History displays the last n previous acquisitions (n traces displayed)

� Average displays an average of the last n previous acquisitions (one trace displayed)

� YAxes opens the Y Axis properties dialog, described below

� 1 and 2 buttons allow the user to choose which Y axis is displayed, if more than one Y axis is available

Axes	Dialog

The Axes dialog allows the user to define two different Y axes for the plot display.

Choose an Axis for which to define the display properties.

Define a range for the axis using the radio buttons:

� Best Fit will autoscale the range such that all values in the recorded traces are visible in the plot

� Fixed allows the user to define a fixed minimum and maximum value for the selected axis

Assign the active input channels to one or the other Y axis using the arrow buttons to move selected channels in the Axis 1 and Axis 2 lists.

Click the Close button to return to the main Voltage Recording dialog.

Save	Path

Each Voltage Recording acquisition is saved in its own folder.  The location of the folder is determined by the Save Path, which can be viewed or changed by clicking the  button next to 

the Save Path box.  The name of the folder is the name displayed in the text box next to the  button, followed by the number displayed in the iteration counter text box.

The default folder name includes the type of acquisition and the date and time code for the last time the software was loaded.  The user can type a custom name in this field for the 

current session.  The folder name will revert back to the default typedatetimecounter format each time Prairie View is started.  To retain the custom folder between sessions, check the 

Preserve UserModified File Names option in the Preferences menu.  Note that using the same folder name in multiple tabs (ZSeries, TSeries, etc.) can cause data to be overwritten if 

counter values are the same on multiple tabs.

The counter is automatically increased by 1 after each acquisition.  The user can change the counter value by typing in the box or using the + and – buttons.  Note that decreasing the 

counter value can result in overwriting data.

Start	Buttons

Live starts a live voltage recording of indeterminate length, similar to the traces displayed by an oscilloscope.  The plots will display a segment of data of the duration defined in the Time

field of the Current Experiment Properties.  The display will continuously update until the user clicks Stop.  No data file is saved from this recording.
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Start Acquisition begins a single, finite length recording of the length specified in the Time field of the Current Experiment Properties.  This type of acquisition generates a data file that is 

saved in the directory specified by the user.

Alternatively, the Voltage Recording experiment can be embedded in a TSeries, Line Scan, Point Scan, Voltage Output, Spiral Activation, or Mark Points experiment an run from those 

interfaces.

The Seal Test module enables the user to perform a seal test using a patch amplifier, to determine whether electrical contact has been established with a cell by applying a pulsed potential 

and measuring the response.

The current response is shown in the top plot, while the applied potential is shown in the bottom plot.  Controls on the left side of the plots allow the user to define the inputs and outputs 

to be used, and circuit parameters are calculated and displayed in the lower left portion of the window.

Device	Properties

Prairie View can be used to send and receive signals from a variety of patch amplifier devices. Integrated support is provided for reading the scale factors of the MultiClamp 700B and the 

Axopatch 200B; other amplifiers can be used by manually entering the scale factors.  Other sections of this manual provide information on configuring a MultiClamp 700B or Axopatch 

200B amplifier for use with Prairie View software.

MultiClamp	700B

MultiClamp Commander software must be running before Prairie View can connect to the amplifier.

In the dropdown menu under Device, select the desired channel of the MultiClamp 700B amplifier.

Define the Channels to correspond to connections between the amplifier and the GPIO box.

� Current is the analog input channel connected to the current output of the amplifier.

� Potential is the analog input channel connected to the potential output of the amplifier.

� Output is the analog output channel connected to the commanding potential input of the amplifier.

� Commanding potential input must be set to 20mV/V in the MultiClamp Commander software.

Device Gains are automatically obtained from the MultiClamp Commander software.

Seal Test
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Axopatch	200B

Define the Channels to correspond to connections between the amplifier and the GPIO box.

� Current is the analog input channel connected to the current output of the amplifier.

� Potential is the analog input channel connected to the potential output of the amplifier.

� Output is the analog output channel connected to the 20mV/V commanding potential input of the amplifier.

� Telegraph is the analog input channel connected to the telegraphing output of the amplifier.

Device Gains must be read from the amplifier or entered by the user.

� Current (mV/pA) is automatically determined if a telegraph input was defined.  If no telegraph input was defined, then the user must enter the scaling.  To find the scaling manually, 

divide the Potential reading of the current channel (in mV) by the actual current (in pA).

� Pot. (mV/mV) is fixed at 10mV recorded voltage per 1mV displayed and actually applied.

� Cmd V (mv/V) is fixed at 20mV/V, corresponding to the 20mV/V command input on the amplifier; this is the only command input supported.  For every 1V applied to the command 

input, the amplifier will apply 20mV to the cell.  The Cmd scaling factor allows Prairie View software to calculate the command signal that must be generated to direct the amplifier to 

apply the correct voltage to the cell.

Generic	Patch	Clamp	Device

Define the Channels to correspond to connections between the amplifier and the GPIO box.

� Current is the analog input channel connected to the current output of the amplifier.

� Potential is the analog input channel connected to the potential output of the amplifier.

� Output is the analog output channel connected to the 20mV/V commanding potential input of the amplifier.

Device Gains must be entered by the user.

� Current (mV/pA) is determined by dividing the Potential reading of the Current channel (in mV) by the actual current (in pA).

� Pot. (mV/mV) is determined by dividing the Potential reading of the Potential channel (in mV) by the actual potential applied to the cell (in mV).

� Cmd V (mV/V) is the scale factor between the signal sent from the GPIO box to the amplifier and the signal sent from the amplifier to the cell.  For every 1V applied to the command 

input, the amplifier must apply the appropriate number of mV to the cell.  The Cmd scaling factor allows Prairie View software to calculate the command signal that must be generated 

to direct the amplifier to apply the correct voltage to the cell.

Stimulus	Properties

These controls enable the user to define the stimuli applied to the cell when the Seal Test is running.

� Holding is the average potential (in mV) seen by the cell over a long period of time while holding or pulsing.

� In Holding Voltage mode, this is the number of mV applied to the cell.

� In Pulse mode, this can be seen as the DC component of the pulse signal and corresponds to the average of the top and bottom voltages weighted by their respective durations.

� Pulse is the pulse height (in mV) applied in Pulse mode.

� Width is the length of each pulse (in milliseconds).

� Spacing is the time between pulses (in milliseconds).

To obtain a 50% duty cycle pulse, the Spacing and Width values should be equal.  A Holding potential value of 0mV and Pulse height of 100mV would result in a pulse jumping between 
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50mV and +50mV.

Plot	Axes	Properties

These controls enable the user to adjust the display of the recorded data.

� I Range (pA) is the number of pA to display on the Y axis in the Current plot.  Arrows allow for quick zooming of the display.

� V Range (mV) is the number of mV to display on the Y axis in the Potential plot.  Arrows allow for quick zooming of the display.

� T Length (ms) is the number of ms to display on the X axis in the two plots.  Arrow allow for quick zooming of the display.

� The Auto Time Axis check box adjusts the X axis to display one pulse.

� The Y axes can be adjusted based on signal level plotted at that time

� Center Plots adjusts the Y axis of each plot so that the average signal value is in the center of the displayed range.

� Auto Y adjusts the range of the Y axes to show the full range of signals plotted at that time.

Circuit	Parameters

Several parameters of the circuit are calculated during an acquisition.  These parameters are estimated by fitting the transient decay superimposed on the pulse response of the circuit. 

When not pulsing the amplifier, only Total R is calculated.

� Total R is the average total resistance.

� Access R is the access resistance.

� Membrane R is the membrane resistance.

� Membrane C is the membrane capacitance.

� The Avg slider enables the user to average multiple measurements of the circuit parameters.

Acquisition

The Acquire button initiates recording of the signals from the patch amplifier.  While acquisition is occurring, the button can be clicked again to Stop the acquisition.

Holding Voltage initiates application of the defined Holding signal to the amplifier.

Pulse initiates repeated application of the defined Pulse signal to the amplifier. 

This is a program which converts raw data into usable files (TIFF for image data and CSV for other data).  It can be run from within Prairie View, or executed independently when Prairie 

View is not running.

In many cases, raw data files are automatically converted after an acquisition is complete.  This allows for immediate viewing and use of the data.  During conversion, the user cannot run 

another acquisition.  In most cases, this is not a problem, because the time required to convert the raw files is negligible.  However, some experiments generate large amounts of data that 

can take a long time to convert.  This can happen with long TSeries experiments with a Resonant Scanner, long Brightness Over Time acquisitions, or large Voltage Recording experiments.  

In these cases, it can be useful to delay conversion of the raw files until a later time, so the user can start another acquisition immediately.

The user can choose whether or not raw data is automatically written to TIFF and/or CSV files after an acquisition using the Preferences menu options to Automatically Convert Raw Files.  

If images are not automatically converted, there is less processing overhead at the end of the acquisition before another image can be acquired.  The images can be converted later using 

the ImageBlock Ripping Utility.

Image-Block Ripping Utility

Page 94 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm



The user selects the location of the original file and the destination for the images, which need not be the same location.

Use the Browse button at the top of the window to navigate to the folder containing the raw data to be converted.

Enable the Include Subfolders option if selecting a parent directory that contains multiple acquisitions.

The Block File List(s) window lists the files waiting to be converted.  Use the Clear List button to start over making selections of files to convert.

At this time, the only Ripped Image(s) Format available is TIF, so the user does not need to make a selection.

Use the Browse button for the Ripped Image(s) Directory (Output) to choose a destination folder for the converted files.  Check the option to Rip Image(s) to input directory to put 

converted files back into the original directory; this will disable the controls to browse to a userdefined input directory.

The option to Create .raw files will write a raw data file of pixel intensities for each image in the acquisition (breaking up the combined raw data file from the original acquisition).  These 

file types may be used by some thirdparty analysis software packages.

Check the option to Delete original data after creating images to delete the original raw files after conversion.  This saves disk space.

When converting images acquired with a Resonant Scanner, the option to Perform Resonant Deinterlacing applies a postprocessing algorithm during conversion to clean up artifacts of 

the bidirectional scanning and variable dwell time.   These processed images will be saved in a subdirectory, alongside the images converted without postprocessing.

Click the Start Conversion button to run the ImageBlock Ripping Utility on the selected acquisitions.  An information bar at the bottom of the window informs the user whether the 

program is currently running or has finished all specified conversions.

This feature is fully implemented, but the Help file description has not been completed.  Please contact Bruker Fluorescence Microscopy support personnel with questions about this 

feature.

The Functional Mapping application is helpful for analyzing the data acquired from common ephysiological experiments performed using Mark Points.

Spiral Activation

Functional Mapping
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To generate a dataset that can be used in Functional Mapping, an acquisition must be run from Mark Points that includes activation at multiple points, with at least one of those points 

synchronized with a voltage recording. In this case, Functional Mapping will draw an overlay over the original reference image, with the overlay being pseudocolored to represent the 

strength of the reaction at that point.

Functional Mapping is launched from the Applications menu on the Main Form. When the application is first launched, a window like the one above will be opened, but without any image 

data. To open a dataset, click the  button next to the filepath at the top of the window and navigate to the top level *.xml file that corresponds to an experiment that satisfies the 

Functional Mapping criteria.

At this point, Functional Mapping will load in the data from the chosen experiment, which will then cause the reference image to be shown and the controls on either side of the window to 

become enabled. Additionally, an overlay will be placed on the reference image representing the change in the synchronized voltage recording immediately following the laser pulse at that 

point. To generate the most appealing and informative image, the controls on the left side may need to be changed.

The Display Method drop down allows for a choice between four types of representations of the overlay. The default method, "Boxes", simply places a square over each point that was 

synchronized with a voltage recording. If this method is chosen, the Box Size slider becomes enabled, which allows changes to the size of the square placed over each point. The "Grid" 

method creates an overlay in which every pixel throughout the image is pseudocolored to represent the response of the nearest activation point. The "Interpolation" method (shown 

above) creates a smooth overlay where every pixel within the bounds of a group of points is calculated based on its neighboring points. Finally, the "IMD" method is similar to 

interpolation, but merges the reference image and overlay into one image. In the resultant image, the intensity is taken from the reference image, whereas the hue of each pixel 

represents the response.

The Channel drop down automatically populates with the names of each active voltage recording channel from the experiment. This control can then be used to change the overlay to 

represent changes in the recording from the indicated channel.

If the Mark Points experiment has multiple repetitions, the Repetition control will automatically populate and become active. At this point, the drop down menu can be used to cycle 

between different repetitions and see the overlay of responses at each repetition.

The Zoom and Pan controls allow for magnifying and moving the image shown in the window. When one of these buttons is clicked, the application enters the appropriate mode. In zoom 

mode, any point that is clicked in the image window will be magnified. Additionally, a box can be drawn on the image window, and the resulting area will be magnified to fit the window. 

Doubleclicking or rightclicking will revert the zoom to its original value. When zoomed in, it may be desirable to shift the image around to see neighboring areas. In this case, the Pan 

button can be pressed to allow clicking and dragging of the image to see the rest of the image.

The Overlay Opacity slider allows for changing of the transparency of the overlay. If the slider is dragged all the way up (to the right), the underlying image will no longer be visible. On the 

other hand, if the slider is dragged all the way down (to the left), the overlay is no longer visible.

The Export Data button opens a save dialog that will save much of the calculated data. When a valid file name is entered into this window, three files are created. The first one is a copy of 

the original reference image. The second file is an image that contains the current overlay at its current transparency. Finally, a comma separated value file is created that contains useful 

information about the reaction at each point. This file contains, for each point, a name, index, repetition number, x coordinate in pixels, y coordinate in pixels, and scaled response in each 

channel.

On the right side of the image is a colorbar that can be used to scale the lookup table used to color the overlay. By dragging the bottom limit upward, the lookup table is compressed 

upward, and vice versa. Additionally, any response that is below the lower limit of the colorbar will be set to completely transparent, and any response that is above the upper limit of the 

colorbar will be saturated at a deep red color. The limit controls of the colorbar also display a textbox that maps the indicated color to the scaled measurement made in that channel.

If any point in the image window is clicked while not in zoom or pan mode, a new window will be opened that shows the voltage recording that was synchronized with the nearest point to 

the clicked location.
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In this window, the entire voltage recording can be seen, along with a title indicating which point was selected. Furthermore, an orange box indicates the window used to calculate the 

response (by default this window starts with the laser pulse and lasts for 50 ms). This box can be shifted left or right, or resized by clicking and dragging either endpoint. After resizing the 

window, the overlay can be recalculated by clicking the Recalculate Map button on the right side. Prior to recalcuating the map, the checkbox above the button, Apply This Search Range 

to All Points?, can be checked to use the new window for every point in the overlay. If left unchecked, the other points will continue to use their previous windows. This process can be 

repeated as many times as necessary until the desired results are obtained.

Atlas Imaging is a module that allows for easy visualization of large sections of tissue in an automated process. Furthermore, Atlas has tools that allow users to quickly and easily set up a 

2D or 3D volume acquisition.

Atlas Imaging allows the user to see a thumbnail preview of their current location placed into a map representing the surrounding tissue. As the stage location is changed, the map is 

updated in real time to show the relative position of the current field of view. Additionally, any stage locations at which a future acquisition should take place can be saved and viewed 

using Atlas Imaging.

Open Atlas Imaging by selecting it from the Applications menu on the main form. At this time, Atlas Imaging will open two windows, the Atlas Image window and the Atlas Overview 

window. 

Atlas	Image	Window

The Atlas Image window functions as a normal Image window, showing the current field of view at the resolution selected on the Main Control window. In addition, to the right of the 

image is a representation of the tissue as a slice of a z stack. In this window, the stage position can be changed by clicking and dragging on the image. With a properly calibrated objective 

and stage, any point clicked on in the Atlas Image window will remain under the mouse cursor as it is dragged around. Additionally, the focal plane can be changed by clicking and dragging 

on the Z slice to the right of the image window. In fact, any change to the current Z position, including those from hardware, the buttons on the main form, and the mouse scroll wheel, will 

be reflected by a change of the position of the z slice in this window. Furthermore, the Set Z Top, Set Z Bottom, and Z Step Size controls can be used to define the range for a ZSeries (at 

one or multiple XY locations). Use the Set Z Top button to set the start of a ZSeries, the Set Z Bottom button to set the stop of the ZSeries, and the Set Z Step Size to define the distance 

between consecutive slices.

Atlas	Overview	Window

Atlas Imaging
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The Atlas Overview window contains a map of the current position in relation to previous positions. In addition, it shows the location of previously saved positions to reference the relative 

placement of the current field of view. Clicking anywhere in the overview image will move the stage such that the current field of view lies underneath the mouse cursor, which can then be 

dragged around to view the surrounding sample in real time. If the size of the overview is not large enough, simply move the current field of view out of the range of the current overview 

window, and it will automatically rescale to include the new position. If desirable, the size of the overview window can also be set using the text boxes in the upper left corner of the 

window, which will set its size to fit the corresponding number of fields of view (shown as 2x2). In addition, the overview window has several useful features that are run using the buttons 

on the left side of the window.

Set as Center will take the current stage position and place it in the center of the Atlas Overview window. This button will preserve any previous information in the overview window by 

shifting it appropriately along with the new center. This feature should be used when a location other than that at the time Atlas was opened is determined to be the center of interest for 

upcoming acquisitions.

Add/Update Location can be used to save the current location as an area at which future acquisition should take place. When this button is pressed, the current image will be permanently 

placed in the overview window and outlined with a red rectangle, indicating that this position will be used for upcoming acquisitions. If this button is pressed when the current field is on 

top of an already existing field, the Z position of the existing location will be updated to the current Z position. Use this to set up an acquisition at any number of sparse locations, or to 

define the boundaries of a continuous volume.

Generate Montage will calculate and show the locations needed to continuously cover the area defined by the locations furthest away from the current center. Prior to pressing this 

button, the % Overlap should be entered in the text box in the upper left corner of the overview window. This overlap will then be used to lay out a grid that completely covers any 

previously defined locations. The grid will then be shown on the overview window for visualization.

Remove Fields provides an interactive way to remove a previously defined field from upcoming acquisitions. When this button is pressed, it will highlight green indicating that Atlas is now 

in removal mode. At this point, any field that is clicked in the overview window will be removed from the list of locations to be used for upcoming acquisitions. This change will be 

represented by erasing the red rectangle around the previous location. This feature is particularly useful when a square grid was defined to cover an irregular shape. After the montage is 
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generated, this feature can be used to remove fields that don't contain useful information, thus increasing the speed of acquisition.  Click the button again to exit removal mode.

Preview All XY will fill the entire overview window with image data. When this button is pressed, the stage will drive to a location corresponding to a corner of the overview window and 

take an image. It will then move to a neighboring location and take another image. This process is repeated until the stage reaches the opposite corner of the overview window (using a 

"snake" pattern). This allows for a quick preview of the area of tissue surrounding the centered field of view.

Take Snapshot will capture an image of the current data in the overview window and open a dialog to save it in tiff format. This feature is useful to have a reference of what the 

surrounding area of the sample looks like before acquisition.

Clear All will remove all currently saved stage locations, any image data in the overview window, and the currently defined Z range. This button should only be used to "start over" when 

using Atlas Imaging, as everything related to Atlas up to that point will be lost.

Procedures

Below is a typical workflow for using Atlas Imaging to acquire a 3D volume:

1. Obtain an image in Prairie View's normal image window roughly near the center of where you want to acquire

2. Launch Atlas Imaging from the Applications menu in the Main Control window

3. Estimate how large of an area (in number of fields) will be needed to cover the desired acquisition and enter this number into one of the text boxes in the upper left corner of the 

overview window

4. Acquire a preview of the current overview using the Preview All XY button on the overview window

5. Navigate to one corner of the grid of fields that will be acquired

6. Set the top, bottom, and step size of a ZSeries and navigate to the central Z for this corner

(Note: This instruction assumes that the ZSeries preferences are set to Align ZSeries center to stage location. If the ZSeries preferences are set to Align ZSeries start to stage location, 

then navigate to the top of the desired ZSeries instead of the central Z.) 

7. Click Add/Update Location to store this as one of the locations to be acquired

8. Navigate to the opposite corner of the grid to be acquired and to the central Z for this corner

(Note: This instruction assumes that the ZSeries preferences are set to Align ZSeries center to stage location. If the ZSeries preferences are set to Align ZSeries start to stage location, 

then navigate to the top of the desired ZSeries instead of the central Z.) 

9. Click Add/Update Location to store this as another location that needs to be covered

10. Enter the desired % Overlap into the text box in the upper left corner (common values are around 15%)

11. Click on the Generate Montage button to calculate and show the grid of locations that will be used. Additionally, the central Z slice for each location will be interpolated from the two 

corners

12. (Optional) Click the Remove Fields button to enter field removal mode and click on any locations that do not have any useful image data

13. Set up a TSeries to include a ZSeries and check the Run at all XYZ stage locations checkbox

14. Start the TSeries

Optional recommended postprocessing steps:

1. Open Fiji to stitch and render the data set

2. In Fiji's Plugins menu, choose Stitching > Grid/Collection Stitching

3. Choose "Type: Positions from file" and "Order: Defined by image metadata" and click OK

4. For the "MultiSeries File", navigate to the directory in which your TSeries is saved and choose the top level *.xml file

5. It may be necessary to check one or both of the "Invert X Coordinates" and "Invert Y coordinates" options. This is unique to each system, and it will be obvious if this is not set correctly 

when the results are generated

6. Click OK to stitch the Z planes together and create a 3D volume dataset

Keyboard Shortcuts:  Opens a dialog to display the list of keyboard shortcuts available on the system

Luigs & Neumann Technical Note:  Provides information specific to systems configured with a stage manufactured by Luigs & Neumann

User’s Manual:  Opens a compiled HTML file containing the user’s manual for Prairie View software

Remote Support:  Launches a window enabling Bruker Fluorescence Microscopy personnel to remotely access the computer for service and support; ensure an internet connection is 

established and contact Bruker Fluorescence Microscopy support personnel to set up a session

About:  Provides information about system device firmware and the Prairie View license agreement

Prairie View includes support for dual and quad image splitting optics in SFC and Camera modes. These image splitting optics enable simultaneous collection of two or four channels of data 

using a single CCD or CMOS image sensor.

Help Menu

Splitting Optics Overview
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When the Image Splitting Optics configuration is enabled, a check box will appear in the user interface.  In SFC mode, the checkbox is labeled “Use Splitter” and is located just below the 

Exposure Time text box.  In Camera mode, the checkbox is labeled “Use Splitting Optics” and is located at the bottom of the camera settings section on the main form.

The presence of dual image splitting optics enables simultaneous collection of two channels of data using a single CCD or CMOS image sensor.

When the check box is checked to use the splitting optics is checked, the software will separate a single camera image into two channels of data.  Channels are acquired in pairs, where 

channels 1 and 2 are taken from one exposure, and channels 3 and 4 are taken from a separate exposure.  Any softwarecontrolled light sources (lasers, LEDs, etc.) enabled for either 

channel in the pair will be active during the exposure for that pair.

In the metadata information for an image data set, the relativeTime and absoluteTime will be the same for both channels of each pair acquired in a single exposure.

The presence of quad image splitting optics enables simultaneous collection of four channels of data using a single CCD or CMOS image sensor.

When the check box is checked to use the splitting optics is checked, the software will separate a single camera image into four channels of data.  Any softwarecontrolled light sources 

(lasers, LEDs, etc.) enabled for any channel will be active during the exposure.

In the metadata information for an image data set, the relativeTime and absoluteTime will be the same for all channels, as they are acquired in a single exposure.

Prairie View can be used to send and receive signals from a variety of patch amplifier devices. Integrated support is provided for reading the scale factors of the MultiClamp 700B and the 

Axopatch 200B; other amplifiers can be used by manually entering the scale factors.

Cabling and configuration instructions for the MultiClamp 700B and Axopatch 200B are provided in this manual.  These instructions are guidelines for an initial setup.  Actual connections 

and usage may vary based on system configuration.

Dual Splitting Optics

Quad Splitting Optics

Patch Amplifiers Overview

MultiClamp 700B
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Cabling

USB	connections

MultiClamp 700B Back Panel, USB type B � Prairie computer Back Panel, USB type A

BNC	����	BNC	connections

Other input and output channels can be used; adjust the channel numbers in the instructions below to match actual system configuration.

Software

MultiClamp	Commander	700B

� Start MultiClamp Commander software before running Prairie View

� Make sure the MultiClamp Commander software finds the attached device

� Use the Options dialog (from the button that looks like a wrench) Gains tab to configure settings

� Voltage Clamp

� Select desired Feedback Resistor

� Set External Command Sensitivity to 20mV/V

� Current Clamp

� Select desired Feedback Resistor

� Set External Command Sensitivity to 400pA/V

� Choose the signals to be sent on the Primary and Secondary outputs by rightclicking on those outputs in the main MultiClamp Commander window

� In the examples below, the Primary output is assumed to be used for Current and the Secondary output is assumed to be used for Potential

Prairie	View	Configuration	Utility

Near the bottom of the Misc tab, check the box to enable Patch Clamp Device and select MultiClamp 700B from the dropdown list.

Prairie	View	Software

Use the Seal Test feature when patching the cell.  To incorporate electrical recording and analog output signals during an experiment, use the Voltage Recording and Voltage Output

modules.

� Seal Test

� Select input and output channels to match cabling

� When using Channel 1

� Device – MultiClamp 700B Ch1

� Current – 6052 Ch 0

� Potential – 6052 Ch 1

� Command – 6713 Ch 0

� When using Channel 2

� Device – MultiClamp 700B Ch2

� Current – 6052 Ch 2

� Potential – 6052 Ch 3

� Command – 6713 Ch 1

� Gains are read automatically from MultiClamp Commander software

� Pulse can be defined by the user

� Acquire begins reading and displaying signals

� Pulse begins sending the pulse defined by the user

� Holding Voltage begins sending the holding potential defined by the user

� Stop ends the acquisition and pulsing

� Voltage Recording

� The Name of each input can be set to reflect the connections to the amplifier.  Based on the cabling listed above, that would be:

� Input 0 = Ch1 Primary

� Input 1 = Ch1 Secondary

� Input 2 = Ch2 Primary

� Input 3 = Ch2 Secondary

� Range for each input can be set to ±10V, or narrower to get more resolution if signals are of smaller amplitudes

� Units can be read automatically from MultiClamp Commander software settings

� Input 0 – check the box to Read from Multiclamp 700B Ch 1 and choose Primary Output from the dropdown menu

� Input 1 – check the box to Read from Multiclamp 700B Ch 1 and choose Secondary Output from the dropdown menu

� Input 2 – check the box to Read from Multiclamp 700B Ch 2 and choose Primary Output from the dropdown menu

� Input 3 – check the box to Read from Multiclamp 700B Ch 2 and choose Secondary Output from the dropdown menu

� Define recording time and sampling rate needed for the desired experiment/protocol

� Voltage Output

MultiClamp 700B Front Panel GPIO Front Panel

Channel 1 Primary PCI6052E AI 0

Channel 1 Secondary PCI6052E AI 1

Channel 1 Command PCI6713 AO 0

Channel 2 Primary PCI6052E AI 2

Channel 2 Secondary PCI6052E AI 3

Channel 2 Command PCI6713 AO 1

Channel 1 and/or 2 Mode PCI6713 AO2 (Optional)

Page 101 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm



� Scaling must be defined manually by the user on channel AO 0 and AO 1

� Set up two separate experiments for Voltage Clamp and Current Clamp protocols

� Voltage Clamp

� Click Config Line 0 and Config Line 1 to define the outputs

� Click the  button to set units and scaling

� Set 1 V actual output = 20mV

� Define pulses in the Patch Amplifier waveform type

� Optional: If the Mode selection in MultiClamp is set to EXT, Configure Line 2 to be a fixed voltage of 5V, maintained indefinitely, to put the amplifier into Voltage 

Clamp mode

� From the Voltage Output window

� Set Update Rate 

� Save the entire output definition

� Current Clamp

� Click Config Line 0 and Config Line 1 to define the outputs

� Click the  button to set units and scaling

� Set 1 V actual output = 400pA

� Define pulses in the Patch Amplifier waveform type

� Optional: If the Mode selection in MultiClamp is set to EXT, Configure Line 2 to be a fixed voltage of 0V, maintained indefinitely, to put the amplifier into Voltage 

Clamp mode

� From the Voltage Output window

� Set Update Rate 

� Save the entire output definition

� Load the settings for the desired experiment (Voltage Clamp or Current Clamp)

� Define any other outputs needed for the protocol

Cabling
All are BNCtoBNC connections

Other input and output channels can be used; adjust the channel numbers in the instructions below to match actual system configuration.

Software

Prairie	View	Configuration	Utility

Near the bottom of the Misc tab, check the box to enable Patch Clamp Device and select Axopatch 200B from the dropdown list.

Prairie	View	Software

Use the Seal Test feature when patching the cell.  To incorporate electrical recording and analog output signals during an experiment, use the Voltage Recording and Voltage Output

modules.

� Seal Test

� Select input and output channels to match cabling

� Current – 6052 Ch 0

� Potential – 6052 Ch 1

� Output – 6713 Ch 0

� Telegraph – 6052 Ch 2

� Set Mode knob on 200B to VClamp

� Gains are read automatically from Telegraph connection

� Pulse can be defined by the user

� Acquire begins reading and displaying signals

� Pulse begins sending the pulse defined by the user

� Holding Voltage begins sending the holding potential defined by the user

� Stop ends the acquisition and pulsing

� Voltage Recording

� The Name of each input can be set to reflect the connections to the amplifier.  Based on the cabling listed above, that would be:

� Input 0 = Scaled Output

Axopatch 200B

Axopatch 200B Back Pannel GPIO Front Panel

Scaled Output PCI6052E AI 0

10Vm Output PCI6052E AI 1

Gain (Telegraph Outputs) PCI6052E AI 2

Ext Command Input Front Switched PCI6713 AO 0

Page 102 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm



� Input 1 = 10Vm Output

� Range for each input can be set to ±10V, or narrower to get more resolution if signals are of smaller amplitudes

� Unit scale factor for the Scaled Output connection can be read automatically from the Telegraph connection.  Otherwise, set the units using the conversion fields in the Units pop

up dialog.  Unit scaling for the 10Vm output connection must be entered by the user.

� Input 0  (Scaled Output from amplifier)

� Check the box to Read from Axopatch 200B

� During Voltage Clamp experiments, choose “Current 6052 Ch 2”

� During Current Clamp experiments, choose “Voltage 6052 Ch 2”

� The 6052 channel for units corresponds to the channel connected to the Telegraph Gain signal from the amplifier

� Alternatively, scaling can be set by the user

� Input 1  (10Vm Output from amplifier)

� Set scaling to 0.1 Volt = 1 Volt

� Define recording time and sampling rate needed for the desired experiment/protocol

� Voltage Output

� Scaling must be defined manually by the user on channel AO 0

� Set up two separate experiments for Voltage Clamp and Current Clamp protocols

� Voltage Clamp

� Click Config Line 0 to define the output

� Click the  button to set units and scaling

� Set 1 V actual output = 20mV

� Define pulses in the Patch Amplifier waveform type

� From the Voltage Output window

� Set Update Rate 

� Save the entire output definition

� Current Clamp

� Click Config Line 0 to define the output

� Click the  button to set units and scaling

� Set 1 V actual output = 2nA if using WC mode x1, or

Set 1 V actual output = 20nA if using WC mode x0.1

� Define pulses in the Patch Amplifier waveform type

� From the Voltage Output window

� Set Update Rate 

� Save the entire output definition

� Load the settings for the desired experiment (Voltage Clamp or Current Clamp)

� Define any other outputs needed for the protocol

By creating separate user profiles in Windows, Prairie View can keep track of usage and settings for multiple users.  By default, a number of settings a saved at the user level including 

labels. Other settings will retain the same values as the last time Prairie View was run.  It is possible to customize which settings are user specific and which are not in the 

‘CustomUserKeys.txt’ file found in the ‘Configuration’ folder.

The file ‘Prairie View.log’ keeps track of several functions and actions taken while a user is in Prairie View.  Lines are added to the log when certain events occur: starting and stopping 

Prairie View, execution of an acquisition, and editing of the Scan Settings dialog.  The date, time, user name and, in the case of an acquisition, file location, are shown for each line of action 

recorded in the log.

For support with software and hardware or for service issues:

Phone 6086620022, prompt 3

support@prairietechnologies.com

General contact information:

Shipping Address

Bruker Nano Surfaces Fluorescence Microscopy

3030 Laura Lane Suite 140 

Middleton, WI 535620677

Mailing Address 

Bruker Nano Surfaces Fluorescence Microscopy

USA PO Box 620677 

Middleton, WI 535620677 USA 

Phone  (608) 6620022

Fax  (608) 6620023

Multi-User Systems

Contact Us

Page 103 of 103Preface

6/20/2014file:///C:/Users/Kevin/AppData/Local/Temp/~hh9C7D.htm


